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3 1. Обзор

Конфигурация системы

Тюнер с поддержкой разнесенного 
приема в УВЧ-диапазоне 
URX-S03D
Цифровой приемник 
радиомикрофона 
DWR-S02DN

Комплект 
беспроводного 
микрофона 
UWP-D21 
UWP-D22 
UWP-D26 
(Приемник: 
URX-P40)

Приемник 
беспроводного 
микрофона 
URX-P03D

Адаптер 
многоцелевого 
разъема 
SMAD-P3D

Адаптер 
многоцелевого 
разъема 
SMAD-P5

Адаптер байонета 
A 
LA-EA3 
LA-EA4

Объектив с 
байонетом E

Микрофон 
ECM-VG1 
ECM-MS2

Блок 
дистанционного 
управления 
RM-30BP

Блок производства 
прямых многокамерных 
трансляций 
MCX-500

Пульт управления на рукоятке 
(входит в комплект поставки)

PXW-FX9V/PXW-FX9VK
PXW-FX9T/PXW-FX9TK

Наплечный 
адаптер 
VCT-FS7

Комплект 
адаптера XLR 
XLR-K2M 
XLR-K3M

Лампа для 
видеосъемки 
HVL-LBPC

Серия S/N/M/H/G 
Карта памяти XQD

Аккумуляторный 
блок  
BP-U35, BP-U60, 
BP-U70, BP-U90

Адаптер переменного 
тока (входит в 
комплект поставки)

Устройство 
расширения 
XDCA-FX9

Устройство чтения 
карт памяти XQD 
MRW-E80, MRW-E90

Зарядное устройство 
BC-U1A, BC-U2A
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Расположение и назначение компонентов

Левая сторона, передняя сторона и ручка

11
12

16

14
13

15

17
18
19

2120 22 23 24

1

4

6

5

3

2
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9
8
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1. Ручка (стр. 5)

2. Антенна Wi-Fi (стр. 57)

3. Выпускное вентиляционное отверстие

[Примечание]
Не закрывайте выпускное вентиляционное 
отверстие.

4. Разъем видоискателя (стр. 21)

5. Разъем REMOTE
Подключение к принадлежности общего 
назначения с разъемом LANC.

6. Разъем USB/многоцелевой разъем 
(стр. 25)

7. Переключатель INPUT1 (LINE/MIC/
MIC+48V) (стр. 45)

8. Плечевая накладка (стр. 26)

9. Переключатель INPUT2 (LINE/MIC/
MIC+48V) (стр. 45)

10. Присоединение рукоятки (стр. 24)

11. Крючок для измерения расстояния
Крючок для измерения расстояния 
находится на одной плоскости с 
датчиком изображения. Используйте это 
крючок в качестве опорной точки для 
точного измерения расстояния между 
видеокамерой и объектом съемки. При 
измерении расстояния до объекта съемки 
можно прикрепить один конец мерной 
рулетки к крючку.

12. Индикатор записи/съемки (передний) 
(стр. 33)

Мигает, когда заканчивается место на 
носителе или заряд аккумулятора.

13. Стопор кольца блокировки объектива 
(стр. 24)

14. Датчик изображения

15. Многофункциональный диск (стр. 47)
Нажмите при просмотре изображения 
в видоискателе для отображения и 
использования прямого меню.
Когда в видоискателе отображается меню, 
поворачивайте диск для перемещения 
курсора вверх и вниз с целью выбора 
элементов меню или настроек. Нажмите, 
чтобы активировать выбранный элемент.
Когда меню не отображается, диск 
также может использоваться как 
программируемый.

16. Контакты сигналов объектива
Установка объектива с байонетом E.

17. Кнопка WB SET (задание баланса 
белого) (стр. 44)

18. Штырь блокировки объектива 
(стр. 24)

19. Стопорное кольцо объектива 
(стр. 24)

20. Антенна модуля GPS
Антенна GPS и периферийные цепи 
встроены в камеру.

21. Разъем для крепления 
принадлежностей (стр. 4)

22. Кнопка START/STOP на рукоятке
Кнопка записи не работает, когда рычаг 
фиксации находится в положении 
фиксации.

23. Рычаг масштабирования на рукоятке 
(стр. 112)

24. Многоцелевой разъем

Список принадлежностей, которые можно 
присоединить к многоцелевому разъему, 
можно узнать у местного торгового 
представителя.

Установка разъема для крепления 
принадлежностей

1 Поднимите передний край пружины 
разъема и потяните за пружину в 
направлении, противоположном 
стрелке на пружине.

Пружина разъема

Разъем для крепления 
принадлежностей

1

2 Поместите разъем для крепления 
принадлежностей на месте установки, 
совместив выступы на разъеме с 
соответствующими точками на месте 
установки, и затяните четыре винта.
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3 Вставьте пружину разъема в 
направлении стрелки таким образом, 
чтобы фрагмент в форме U оказался на 
конце разъема для крепления 
принадлежностей.

3 22

Пружина 
разъема

Разъем для 
крепления 
принадлежностей

Снятие разъема для крепления 
принадлежностей

Снимите пружину разъема, как указано на 
шаге 1 в разделе “Установка разъема для 
крепления принадлежностей”, отверните 
четыре винта и снимите разъем для 
крепления принадлежностей.

Снятие ручки

Отвинтите четыре винта крепления ручки и 
снимите ручку с видеокамеры.

Установка защитного колпачка разъема 
на рукоятке (входит в комплект поставки)

При использовании видеокамеры со снятой 
рукояткой следует защищать разъем при 
помощи входящего в комплект поставки 
защитного колпачка.

Защита клемм разъемов

Наденьте крышку на разъемы, которые не 
используются, для защиты клемм разъемов.

Верхняя сторона

1

3

2

1. Отверстия для винтов расширения 
(3/8 дюйма)

Совместимы с винтами 3/8-16 UNC (длиной 
10,0 мм или менее).

2. Отверстия для винтов расширения 
(1/4 дюйма)

Совместимы с винтами 1/4-20 UNC (длиной 
7,0 мм или менее).

3. Разъем для рукоятки
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Правая сторона (перед/верх/низ)

1
2
3
4
5

7

9

11
13
15

18

6
8

10

12
14
16

17

19

2422
21

20 23 25

Правая сторона 
(сзади) (стр. 7)

1. Встроенный динамик (стр. 33)

2. Кнопки VOLUME (регулировка 
громкости монитора)

Регулировка громкости монитора и 
громкости аварийного сигнала.

3.  (метка N)
ˎˎ Приложите смартфон с функцией 
NFC к устройству, чтобы установить 
беспроводное соединение (стр. 57).  
Некоторые смартфоны, поддерживающие 
системы беспроводных платежей, могут 
не поддерживать NFC. Дополнительную 
информацию см. в инструкции по 
эксплуатации смартфона.
ˎˎ NFC (Near Field Communication, 
коммуникация ближнего поля) — это 
международный протокол связи для 
беспроводной связи между объектами, 
находящимися в непосредственной 
близости.

4. Переключатель HOLD (стр. 112)
Отключает работу устройства (состояние 
ожидания).

5. Кнопка/индикатор START/STOP (пуск/
остановка записи) (стр. 33)

6. Диск ND VARIABLE (стр. 42)

7. Переключатель ND PRESET/VARIABLE 
(стр. 42)

8. Кнопки вверх/вниз ND FILTER POSITION 
(стр. 42)

9. Индикатор ND CLEAR (стр. 42)

10. Кнопка ND VARIABLE AUTO (стр. 42)

11. Кнопка STATUS (стр. 14)
Отображает главные настройки устройства. 
Настройки некоторых пунктов можно 
изменить.

12. Индикатор FOCUS AUTO (стр. 35)

13. Переключатель FOCUS (стр. 35)

14. Кнопка PUSH AUTO FOCUS (стр. 37)

15. Кнопка функции IRIS (стр. 41)

16. Кнопка PUSH AUTO IRIS (стр. 41)

17. Кнопка функции ISO/GAIN (стр. 41)

18. Переключатель ISO/GAIN (выбор 
усиления) (стр. 41)

19. Кнопка ASSIGN (программируемая) 9 
(стр. 47)

20. Кнопка функции WHT BAL (баланс 
белого) (стр. 44)

21. Переключатель WHT BAL (выбор 
баланса белого из памяти) (стр. 44)

22. Кнопка функции SHUTTER (стр. 42)

23. Впускное вентиляционное отверстие

[Примечание]
Не закрывайте впускное вентиляционное отверстие.

24. Индикатор POWER (стр. 33)

25. Переключатель POWER (стр. 33)
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Правая сторона (сзади)

MENU

THUMBNAIL

EXT

MI SHOE MAN

INT AUTO

SLOT SELECT  

AUDIO LEVEL

CANCEL/
BACK

DISPLAY

S&Q

1

3

EXT

MI SHOE MAN

INT AUTO

7 8

CH-1

CH-2

CH-3

CH-42

1 2

1415 13

6

3
5

7
89

10

1112

4

1. Кнопки ASSIGN (программируемые) 1–3, 
7–8 (стр. 47)

2. Кнопка SLOT SELECT (выбор карты 
памяти XQD) (стр. 33)

3. Переключатель выбора CH1 INPUT 
(стр. 45)

4. Переключатель CH1 (AUTO/MAN) 
(стр. 45)

5. Диск AUDIO LEVEL (CH1) (стр. 45)

6. Диск AUDIO LEVEL (CH3) (стр. 45)

7. Переключатель выбора CH2 INPUT 
(стр. 45)

8. Переключатель CH2 (AUTO/MAN) 
(стр. 45)

9. Диск AUDIO LEVEL (CH2) (стр. 45)

10. Диск AUDIO LEVEL (CH4) (стр. 45)

11. Кнопка CANCEL/BACK (стр. 72)

12. Кнопки со стрелками (///) и 
кнопка SET (стр. 72)

13. Кнопка MENU (стр. 74)

14. Кнопка THUMBNAIL (стр. 71)

15. Кнопка DISPLAY (индикация на экране) 
(стр. 11)
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Гнездо для карт, задняя сторона и разъемы

18
19

7

8
9
10
11

14

12
13

23 21
22 20

15

17
16

6

1
2

3
4

5

1. Гнездо A для карты памяти XQD 
(стр. 29)

2. Индикатор доступа к карте памяти XQD 
(A) (стр. 30)

3. Гнездо B для карты памяти XQD 
(стр. 30)

4. Индикатор доступа к карте памяти XQD 
(B) (стр. 30)

5. Гнездо для наушников (стр. 33)

6. Индикатор доступа к карте памяти SD 
(стр. 32)

7. Гнездо для карты памяти UTILITY SD/MS 
(стр. 32)

8. Разъем для устройства расширения 
(внутренний) (стр. 26)

9. Разъем DC IN (стр. 20)

10. Индикатор записи/съемки (задний) 
(стр. 33)

11. Кнопка BATT RELEASE (стр. 19)

12. Аккумулятор (стр. 19)

13. Присоединение аккумуляторного 
блока (стр. 19)

14. Впускное вентиляционное отверстие

[Примечание]

Не закрывайте впускное вентиляционное отверстие.

15. Внутренний микрофон (стр. 45)
Микрофон для записи окружающих звуков.

16. Разъем SDI OUT 1 (стр. 124)

17. Разъем INPUT1 (аудиовход 1) (стр. 45)

18. Разъем INPUT2 (аудиовход 2) (стр. 45)

19. Разъем SDI OUT 2 (стр. 124)

20. Переключатель выбора IN/OUT 
(стр. 125)

21. Разъем TC IN/TC OUT (вход/выход 
временного кода) (стр. 125)

22. Разъем GENLOCK IN (вход внешней 
синхронизации)/REF OUT (выход 
синхросигнала) (стр. 125)

23. Разъем HDMI OUT (стр. 124)

Нижняя сторона

1

1. Гнезда головки штатива (1/4 дюйма, 3/8 
дюйма)

Служат для крепления штатива (не входит 
в комплект поставки, длина винтов 5,5 мм 
или менее), совместимого с винтами 1/4-20 
UNC или 3/8-16 UNC.

Видоискатель

Подробное описание процедуры установки 
видоискателя (входит в комплект поставки) 
см. на стр. 21.

1
2
3

4 65

1. Кнопка PEAKING

2. Кнопка ZEBRA

3. Кнопка ASSIGN (программируемая) 10 
(стр. 47)

4. Переключатель MIRROR

5. Крючки для крепления окуляра

6. Сенсорная панель
Сенсорные операции можно отключить 
с помощью программируемой кнопки или 
меню (стр. 10).
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Окуляр

Подробное описание процедуры 
присоединения окуляра (входит в комплект 
поставки) см. на стр. 23.

1 2

1. Регулятор диоптрийной настройки

2. Наглазник

Пульт управления на рукоятке

Подробное описание процедуры 
присоединения пульта управления на 
рукоятке (входит в комплект поставки) см. 
на стр. 24.

1
2
3

4

5
6
7
8

1. Рычаг масштабирования

2. Кнопка ASSIGN (программируемая) 4

3. Программируемый диск

4. Кнопка ASSIGN (программируемая) 6

5. Рычаг вращения на рукоятке

6. Кнопка START/STOP (пуск/остановка 
записи)

7. Многофункциональный селектор 
(кнопки 8 направлений и кнопка SET)

8. Кнопка ASSIGN (программируемая) 5 

Устройство расширения 
XDCA-FX9 (приобретается 
дополнительно)

Подробное описание процедуры 
присоединения устройства расширения 
XDCA-FX9 (приобретается дополнительно) 
см. на стр. 26.

Спереди

1

2
3

1. Гнездо для вставки приемника 
беспроводной связи

При использовании беспроводного 
микрофона установите портативный 
беспроводной тюнер.

2. Разъем DC OUT (4-контактный, круглый)
Разъем выхода питания 12 В пост. тока.

3. Разъем LIGHT (2-контактный)
Разъем выхода питания 12 В пост. тока.

Сзади

2

1

4

6

3

5

7 8

1. Разъемы USB (типа A)

2. Рычаг разблокировки аккумулятора

3. Разъем для установки аккумулятора

4. Разъем TC OUT (типа BNC)

5. Разъем REF OUT (типа BNC)

6. Разъем DC IN (типа XLR, 4-контактные)

7. Разъем RAW OUT (типа BNC)

8. Разъем LAN
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Меры предосторожности при 
использовании сенсорной 
панели

Видоискатель устройства представляет 
собой сенсорную панель с прямым 
управлением пальцами.
ˎˎ Сенсорной панели достаточно слегка 
касаться пальцем. Не нажимайте на нее 
с усилием и не пользуйтесь никакими 
предметами с острыми краями или 
наконечниками (ногтями, шариковой 
ручкой, булавкой и т. п.).
ˎˎ В указанных ниже условиях сенсорная 
панель может не реагировать на 
касания. Обратите внимание также на 
то, что такие действия могут привести 
к неисправности.
ˎˎ Управление кончиками ногтей
ˎˎ Управление, когда поверхности 
касаются другие предметы
ˎˎ Управление с установленной 
защитной пленкой или наклейкой
ˎˎ Управление, когда на дисплее 
находятся капли воды или конденсат
ˎˎ Управление влажными или потными 
пальцами
ˎˎ Управление в воде

Жесты сенсорной панели

Нажатие
Пальцем слегка коснитесь пункта, 
например значка, затем сразу же уберите 
палец.

Перетаскивание
Коснитесь экрана и сдвиньте палец 
в требуемое положение на экране, затем 
уберите палец.

Смахивание
Коснитесь экрана и быстро смахните 
пальцем вверх, вниз, влево или вправо.

[Совет]
Если содержимое экрана продолжается за краями 
экрана, вы можете перетаскивать или смахивать его 
с помощью прокрутки.

Настройка сенсорной панели

Работу сенсорной панели можно включать 
и отключать с помощью пункта Touch 
Operation (стр. 77) в меню Technical.

Использование сенсорной панели
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Дисплей
Во время съемки (записи/ожидания) и воспроизведения данные о состоянии видеокамеры 
и настройки отображаются в видоискателе поверх изображения.
Для скрытия/отображения этой информации служит кнопка DISPLAY.
Также можно выбрать отображение или скрытие каждого элемента в отдельности 
(стр. 104).

Информация, отображаемая на экране во время съемки

5 62

8

3 4

10

11 1297

13
14
15
16
17

18
19
20

21 22 23 24 25 26 27 28 29 30 31

32
33
34
35
36
37
38
39
40

1

1. Индикатор состояния сети (стр. 13)
Отображение состояния сетевого 
подключения в виде значка.

2. Индикатор отправки/индикатор 
оставшихся файлов (стр. 63)

3. Индикатор состояния режима сетевого 
клиента (стр. 13)

Отображение состояния подключения 
в режиме сетевого клиента.

4. Индикатор состояния потоковой 
передачи

5. Индикатор области фокусировки 
(стр. 35)

Отображает область фокусировки для 
автоматической фокусировки.

6. Режим съемки, гнездо A/B, индикатор 
интервала интервальной съемки 
(стр. 49)

Отображение Значение

Rec Запись

Stby Ожидание съемки

7. Индикатор глубины поля

8. Индикатор режима Imager Scan Mode 
(стр. 28)

Значок  отображается на экране при 
несоответствии размера круга изображения 
объектива и эффективного размера 
изображения, заданного в настройке 
режиме Imager Scan Mode.

9. Индикатор состояния операции вывода 
RAW (стр. 56)

Отображение состояния вывода сигнала RAW.

10. Индикатор состояния серии UWP-D 
(стр. 13)

Отображение в виде значка силы 
радиочастотного сигнала, когда к разъему 
MI, настроенному для передачи цифрового 
звука, подключено устройство серии 
UWP-D.

11. Индикатор частоты кадров при 
замедленной и ускоренной съемке 
(стр. 48)

12. Индикатор заряда аккумулятора/
напряжения DC IN (стр. 19)

13. Индикатор режима фокусировки 
(стр. 38)

Значение Отображение

Режим Focus Hold Focus Hold

Режим MF MF

Режим AF AF

AF с обнаружением лица или глаз (AF/ /
Only/ / )

Значок обнаружения 
лица или глаз

Значок AF 
с обнаружением лица 
или глаз

Only

Значок 
зарегистрированного 
лица

 

Значок приостановки AF 
в режиме AF 
с обнаружением лица 
или глаз1)

1) Отображается, когда нет зарегистрированного 
лица и никакое лицо не обнаружено, или 
когда имеется зарегистрированное лицо и это 
зарегистрированное лицо не обнаружено.

14. Индикатор положения 
масштабирования

Отображает положение масштабирования 
в диапазоне от 0 (широкоугольный режим) 
до 99 (режим телефото) (если используется 
объектив, который поддерживает 
отображение установки масштабирования).
Индикация может быть изменена на 
шкальный индикатор или индикатор 
расстояния фокусировки (стр. 113).

15. Индикатор состояния GPS (стр. 53)
Отображает состояние GPS.

16. Индикатор режима стабилизации 
изображения

17. Индикатор состояния управления 
съемкой выхода SDI/выхода HDMI 
(стр. 124)

Отображение состояния выдачи сигнала 
управления съемкой.

18. Индикатор фокусировки (стр. 38)

19. Индикатор оставшейся емкости 
носителя для записи

20. Индикатор режима баланса белого

Отображение Значение

Режим Auto

 Hold Режим Auto приостановлен

W:P Режим предустановки

W:A Режим из ячейки памяти A

W:B Режим из ячейки памяти B

21. Индикатор внешней привязки 
временного кода/отображение данных 
времени (стр. 34)

Отображает значение “EXT-LK”, когда 
установлена привязка к временному коду 
внешнего устройства.

22. Индикатор фильтра ND (стр. 42)

23. Индикатор файла сцен (стр. 122)



1. Обзор: Дисплей12

24. Индикатор диафрагмы
Отображает положение диафрагмы 
(значение F или T), если используется 
объектив, который поддерживает 
отображение установки диафрагмы.

25. Индикатор предупреждения об уровне 
видеосигнала

26. Индикатор усиления (стр. 41)
Отображается в виде значения EI, когда 
для параметра Base Setting >Shooting Mode 
(стр. 90) в меню Project задано значение 
Cine EI.

Отображение Значение

Режим Auto

H Режим предустановки H

M Режим предустановки M

L Режим предустановки L

Режим временной 
регулировки

27. Отображение названия клипа 
(стр. 71)

28. Индикатор затвора (стр. 42)

29. Индикатор режима AE/уровня AE 
(стр. 41)

30. Индикатор уровня
Отображается горизонтальный уровень с 
шагом ±1° вплоть до ±15°.

31. Измеритель уровня аудио
Отображение уровня звука каналов CH1 и 
CH2.
CH3 и CH4 можно отслеживать на экране 
состояния.

32. Монитор видеосигнала (стр. 52)
Отображает форму сигнала, вектороскоп и 
гистограмму.
Тип LUT монитора отслеживаемого сигнала 
отображается, когда для параметра Base 
Setting >Shooting Mode (стр. 90) в меню 
Project задано значение Cine EI.

33. Индикатор формата записи (кодека) 
(стр. 90)

Отображает имя формата, в котором 
выполняется запись на карты памяти XQD.

34. Индикатор базовой чувствительности/
индикатор базового ISO (стр. 41)

Когда для параметра Base Setting >Shooting 
Mode (стр. 90) в меню Project задано 
значение SDR или HDR, отображается 
базовая чувствительность, заданная 
в параметре ISO/Gain/EI >Base Sensitivity 
в меню Shooting.
Когда для параметра Base Setting >Shooting 
Mode (стр. 90) в меню Project задано 
значение Cine EI, отображается базовая 
чувствительность, заданная в параметра 
ISO/Gain/EI >Base ISO в меню Shooting.

35. Помощь в отображении гамма/
индикатор LUT монитора

Отображается состояние функции помощи 
в отображении гамма. Функцию помощи 
в отображении гамма можно включать и 
отключать, назначив функции Gamma Display 
Assist программируемой кнопке (стр. 47).
Отображает настройку таблицы 
соответствия монитора, когда для 
параметра Base Setting >Shooting Mode 
(стр. 90) в меню Project задано значение 
Cine EI (стр. 88).

36. Индикатор гаммы (стр. 98)
Отображает настройку гаммы 
изображения, записанного на карту памяти 
XQD.

37. Индикатор состояния прокси

38. Индикатор записи 4K & HD (Sub)

39. Индикатор формата записи (частоты 
кадров и метода развертки)

40. Индикатор формата записи (размера 
изображения) (стр. 90)

Отображает размер изображения, которое 
записывается на карты памяти XQD.

Информация, отображаемая на экране во время воспроизведения

Следующая информация отображается поверх воспроизводимого изображения.

1

11 12 13 14 15 16

2 3 4 5 6 7 8 9 10

1. Индикатор состояния сети

2. Индикатор отправки/индикатор 
оставшихся файлов

3. Номер клипа/общее количество 
клипов

4. Индикатор состояния воспроизведения

5. Индикатор формата воспроизведения 
(частоты кадров и метода развертки)

6. Индикатор состояния режима сетевого 
клиента

7. Индикатор состояния потоковой 
передачи

8. Индикатор формата воспроизведения 
(размера изображения)

9. Индикатор заряда аккумулятора/
напряжения DC IN

10. Индикатор формата воспроизведения 
(кодека)

11. Индикатор носителя
Если карта памяти защищена от записи, 
отображается значок  .

12. Отображение данных времени

13. Отображение названия клипа

14. Индикатор помощь в отображении 
гамма

15. Измеритель уровня аудио
Отображение уровня записи звука.

16. Индикатор гаммы
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Отображаемые значки

Отображаемые значки сетевого подключения

Режим сети Состояние подключения Значок

Режим точки доступа Работа в качестве точки доступа

Ошибка работы точки доступа

Режим станции Подключение Wi-Fi
Значок изменяется в зависимости от 
силы сигнала (4 ступени)

   

Wi-Fi отключен (в том числе во время 
установления соединения)

Ошибка подключения Wi-Fi

Модем 1) Значок изменяется в зависимости от 
силы сигнала подключения 3G/4G 
(5 ступеней)
Для модемов, которые не передают 
сведений о силе сигнала, 
отображается значок для силы 
сигнала 3.

Подключение 3G

 – 

Подключение 4G

 – 

Сетевое подключение, в 
котором невозможно 
установить соединение 
3G/4G

 – 

Подключение 3G/4G отключено (в 
том числе во время установления 
соединения)

Ошибка подключения 3G/4G

1) Когда на видеокамеру установлено устройство XDCA-FX9 (приобретается дополнительно), можно 
подключить два модема. Когда подключены два модема, значок изменяется в зависимости от состояния 
модемов, как указано ниже.

Состояние подключения Значок

Подключены два модема, используется только 
модем 1

 

Подключены два модема, используется только 
модем 2

 

Подключены два модема, используются оба 
модема

 

Отображаемый значок режима сетевого клиента

Состояние подключения режима сетевого клиента Значок

Состояние подключенного режима сетевого клиента

Состояние режима ожидания подключения режима 
сетевого клиента

Состояние ошибки подключения режима сетевого клиента

Отображение значка серии UWP-D

Состояние передатчика Состояние приема Значок

Питание выключено Нет приема

Нормальное состояние передачи Выполняется прием
 –   

(уровень приема (4 уровня))

Состояние отключения звука Прием (звук отключен)

Состояние предупреждения о заряде 
аккумулятора

Выполняется прием
 (значок мигает)

Отключение звука и состояние 
предупреждения о заряде 
аккумулятора

Выполняется прием
 (значок мигает)
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Экран состояния

Настройки и состояние видеокамеры 
можно проверить на экране состояния. 
Настройки пунктов, отмеченных 
звездочкой (*), могут быть изменены.
Экран состояния поддерживает сенсорные 
операции.

Отображение экрана состояния
ˎˎ Нажмите кнопку STATUS.

Переключение на экран состояния
ˎˎ Поверните многофункциональный диск.
ˎˎ Нажимайте кнопки со стрелками /.
ˎˎ Смахните экран состояния вверх или 
вниз.

Скрытие экрана состояния
ˎˎ Нажмите кнопку STATUS.

Изменение настройки

Когда отображается экран состояния, 
нажмите на многофункциональный диск 
или многофункциональный селектор, 
чтобы обеспечить выбор пункта настройки 
на странице. Выберите номер страницы 
и нажмите для переключения страниц. 
Можно также выбрать пункты прямо путем 
прикосновения.

[Совет]
Изменения с экрана состояния можно отключить, 
задав для пункта Menu Settings >User Menu Only 
(стр. 113) в меню Technical значение On.

Экран Main Status

Отображаются основные функции камеры и 
свободное пространство на носителе.

Отображаемый 
элемент

Описание

S&Q Frame Rate Настройка частоты кадров 
при замедленной и 
ускоренной съемке

Frequency/Scan* Настройки частоты 
системы и метода 
развертки

Imager Scan* Режим сканирования 
датчика изображения

Media Remain 
(A)

Оставшееся свободное 
место на носителе в гнезде 
A

ND Filter Настройка фильтра 
нейтральной плотности

ISO/Gain/EI Настройка ISO/усиления/
индекса экспозиции

Base ISO/
Sensitivity*

Настройка базовой 
чувствительности ISO/
базовой чувствительности

Codec* Кодек для записи и 
включение/выключение 
вывода в формате RAW

Media Remain (B) Оставшееся свободное 
место на носителе в гнезде 
B

Scene File* Используемый файл сцен 
и его настройка 
идентификатора файла

Monitor LUT* Настройка таблицы 
соответствия монитора

Shutter Настройка выдержки 
затвора или угла затвора

Iris Настройка диафрагмы

Video Format* Размер изображения для 
записи на карты памяти 
XQD

RAW Output 
Format*

Размер изображения для 
вывода в формате RAW

White Balance Настройка баланса белого

Экран Camera Status

Показывает состояние различных 
предустановленных параметров камеры.

Отображаемый 
элемент

Описание

White Switch<B> Значение настройки 
баланса белого из ячейки 
памяти B

White Switch<A> Значение настройки 
баланса белого из ячейки 
памяти A

White Switch<P> Настройка 
предустановленного 
белого

ND<Preset> Настройки ND Filter 
Preset1–3

ISO / Gain<L>* Настройка ISO/Gain<L>

ISO / Gain<M>* Настройка ISO/Gain<M>

ISO / Gain<H>* Настройка ISO/Gain<H>

Base ISO/
Sensitivity*

Настройка базовой 
чувствительности ISO/
базовой чувствительности

Zebra1 Значение On/Off (вкл./
выкл.) и уровень 
параметра Zebra1

Zebra2 Значение On/Off (вкл./
выкл.) и уровень 
параметра Zebra2

VF Gamma/
Gamma

Категория и кривая гамма

Scene File* Используемый файл сцен 
и его настройка 
идентификатора файла

Экран Audio Status

Отображает настройку входа, измеритель 
уровня аудио и настройку монитора 
громкости для каждого канала.

Отображаемый 
элемент

Описание

CH1 Level Control Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind Filter* Настройка фильтра 
подавления шума ветра 
для микрофона

CH2 Level Control Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind Filter* Настройка фильтра 
подавления шума ветра 
для микрофона

CH3 Level Control* Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind Filter* Настройка фильтра 
подавления шума ветра 
для микрофона
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Отображаемый 
элемент

Описание

CH4 Level Control* Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня 
аудио

Source* Источник входного 
сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind Filter* Настройка фильтра 
подавления шума ветра 
для микрофона

Audio Input Level* Настройка входного 
уровня основного звука

HDMI Output CH* Настройка выходных 
аудиоканалов HDMI

Headphone Out* Настройка типа выхода 
для наушников

Monitor CH* Настройка канала 
монитора

[Примечание]
Настройки источника сигнала Source для каналов 
CH1 и CH2 выбираются переключателем выбора 
CH1 INPUT (стр. 7) и переключателем выбора 
CH2 INPUT (стр. 7) с правой стороны устройства. 
Источник сигнала Source для каналов CH1 и CH2 
можно задать при использовании портативного 
беспроводного тюнера (стр. 27). Можно задать 
также источник сигнала Source для канала CH2, когда 
переключатель выбора CH2 INPUT установлен в 
положение EXT. 

Экран состояния Project

Отображаются базовые настройки, 
связанные с проектом съемки.

Отображаемый 
элемент

Описание

Frequency/Scan* Настройки частоты 
системы и метода 
развертки

Codec* Задание кодека для записи

Rec Function Включенный специальный 
формат записи и 
настройки

Simul Rec* Состояние и настройка 
включения/выключения 
функции одновременной 
записи в 2 гнезда

Title Prefix Часть заголовка в имени 
клипа

Imager Scan* Режим сканирования 
датчика изображения

Video Format* Размер изображения для 
записи на карты памяти 
XQD

Picture Cache 
Rec*

Состояние включения/
выключения и настройка 
функции записи кэша 
изображения

Number Числовой суффикс имени 
клипа

Shooting Mode* Настройка режима съемки

RAW Output 
Format*

Размер изображения для 
вывода в формате RAW

4K & HD (Sub) 
Rec*

Состояние включения/
выключения функции 
записи 4K & HD (Sub)

Proxy Rec* Состояние включения/
выключения и настройка 
функции записи прокси

Genlock Состояние внешней 
синхронизации

Экран Monitoring Status

Отображает настройки выходов SDI, HDMI и 
видеовыхода.

Отображаемый 
элемент

Описание

SDI1 Signal* Размер выдаваемого 
изображения

Info. Disp* Настройка 
включения/
выключения вывода 
индикации

Color 
Gamut*

Настройка цветового 
пространства/
состояние таблицы 
соответствия 
монитора

SDI2 Signal* Размер выдаваемого 
изображения

Info. Disp* Настройка 
включения/
выключения вывода 
индикации

Color 
Gamut*

Настройка цветового 
пространства/
состояние таблицы 
соответствия 
монитора

HDMI Signal* Размер выдаваемого 
изображения

Info. Disp* Настройка 
включения/
выключения вывода 
индикации

Color 
Gamut*

Настройка цветового 
пространства/
состояние таблицы 
соответствия 
монитора

Отображаемый 
элемент

Описание

Stream Signal Размер выдаваемого 
изображения

Info. Disp Вывод индикации 
(Выкл. 
(фиксированное 
значение))

Color 
Gamut*

Настройка цветового 
пространства/
состояние таблицы 
соответствия 
монитора

RAW Размер изображения 
для вывода 
в формате RAW

Monitor LUT* Настройка таблицы 
соответствия 
монитора

VF* Настройки помощи 
в отображении 
гамма/состояние 
таблицы соответствия 
монитора/настройка 
цветового 
пространства

[Примечание]
Настройка таблицы соответствия монитора 
связана со всеми системами вывода, в том числе 
с видоискателем. Для индикации в видоискателе 
доступна только настройка Gamma Display Assist.

Экран Assignable Button Status

Отображает функции, назначенные каждой 
их программируемых кнопок.

Отображаемый 
элемент

Описание

1 Функция, назначенная 
программируемой кнопке 
ASSIGN 1

2 Функция, назначенная 
программируемой кнопке 
ASSIGN 2
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Отображаемый 
элемент

Описание

3 Функция, назначенная 
программируемой кнопке 
ASSIGN 3

4 Функция, назначенная 
программируемой кнопке 
ASSIGN 4

5 Функция, назначенная 
программируемой кнопке 
ASSIGN 5

6 Функция, назначенная 
программируемой кнопке 
ASSIGN 6

7 Функция, назначенная 
программируемой кнопке 
ASSIGN 7

8 Функция, назначенная 
программируемой кнопке 
ASSIGN 8

9 Функция, назначенная 
программируемой кнопке 
ASSIGN 9

10 Функция, назначенная 
программируемой кнопке 
ASSIGN 10

Focus Hold 
Button

Функция, назначенная 
кнопке Focus Hold 
объектива

Multi Function 
Dial

Функция, назначенная 
многофункциональному 
диску

Assignable Dial Функция, назначенная 
программируемому диску

Экран Battery Status

Отображает информацию об аккумуляторе 
и источнике питания, подключенному к 
разъему DC IN.

Отображаемый 
элемент

Описание

Detected Battery Тип аккумулятора

Remaining Оставшаяся емкость (%)

Charge Count Количество подзарядок

Capacity Оставшаяся емкость (Ач)

Voltage Напряжение (В)

Manufacture 
Date

Дата производства 
аккумулятора

Video Light 
Remaining

Отображает оставшуюся 
емкость аккумулятора 
лампы для видеосъемки.

Power Source Источник электропитания

Supplied Voltage Напряжение, подаваемое 
источником питания

Экран Media Status

Отображает оставшуюся емкость и время 
записи на носителях.

Отображаемый 
элемент

Описание

Информация о 
носителе A

Отображает значок 
носителя, когда носитель 
для записи вставлен в 
гнездо A.

Счетчик 
оставшейся 
емкости 
носителя A

Отображает оставшуюся 
емкость на носителе для 
записи, вставленном в 
гнездо A, которая 
выражается в процентах 
на гистограмме.

Отображаемый 
элемент

Описание

Оставшееся 
время записи на 
носитель A

Отображает, сколько еще 
времени примерно может 
продолжаться запись на 
носитель, вставленный в 
гнездо A, в текущих 
условиях записи (в 
минутах).

Информация о 
носителе B

Отображает значок 
носителя, когда носитель 
для записи вставлен в 
гнездо B.

Счетчик 
оставшейся 
емкости 
носителя B

Отображает оставшуюся 
емкость на носителе для 
записи, вставленном в 
гнездо B, которая 
выражается в процентах 
на гистограмме.

Оставшееся 
время записи на 
носитель B

Отображает, сколько еще 
времени примерно может 
продолжаться запись на 
носитель, вставленный в 
гнездо B, в текущих 
условиях записи (в 
минутах).

Информация о 
карте памяти SD

Отображает значок 
носителя, когда карта 
памяти вставлена в гнездо 
для карт памяти UTILITY 
SD/MS.

Защита карты 
памяти SD

Отображает значок 
блокировки, когда карта 
памяти, вставленная в 
гнездо для карт памяти 
UTILITY SD/MS, защищена 
(заблокирована).

Счетчик 
оставшейся 
емкости карты 
памяти SD

Отображает оставшуюся 
емкость на носителе, 
вставленном в гнездо для 
карты памяти UTILITY SD/
MS, которая выражается в 
процентах на гистограмме.

Отображаемый 
элемент

Описание

Оставшаяся 
емкость карты 
памяти SD

Отображает, сколько еще 
примерно времени в 
минутах может 
продолжаться запись на 
носитель, вставленный в 
гнездо для карты памяти 
UTILITY SD/MS, или 
отображает оставшуюся 
емкость носителя в ГБ.

Экран GPS Status

Отображает состояние и информацию 
позиционирования GPS.

Отображаемый 
элемент

Описание

GPS Состояние сигнала и 
позиционирования GPS

Dilution Of 
Precision

Сведения о точности 
позиционирования

Latitude Сведения о широте

Longitude Сведения о долготе

Altitude Сведения о высоте над 
уровнем моря

Positioning date 
and time

Дата и время 
позиционирования

Current date and 
time

Текущие дата и время

Time Zone Настройка часового пояса

Экран Network Status

Отображение состояния сетевого 
подключения.

Отображаемый 
элемент

Описание

Wireless LAN Состояние подключения и 
настройки беспроводной 
сети
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Отображаемый 
элемент

Описание

Wired LAN Состояние подключения и 
настройки проводной 
локальной сети

Modem 1 Состояние подключения и 
настройки беспроводной 
сети для модема 
(приобретается 
дополнительно)

Modem 2 Состояние подключения и 
настройки беспроводной 
сети для модема 
(приобретается 
дополнительно)

Экран NCM/Streaming Status

Отображение состояния подключения 
в режиме сетевого клиента и состояния 
потоковой передачи.

Отображаемый 
элемент

Описание

Network Client 
Mode Status

Состояние режима 
сетевого клиента

CCM Name Имя CCM, подключенного в 
режиме сетевого клиента

CCM Address Адрес CCM, подключенного 
в режиме сетевого клиента

QoS Streaming1 
Bit Rate

Скорость потока данных 
потоковой передачи 1

QoS Streaming2 
Bit Rate

Скорость потока данных 
потоковой передачи 2

Streaming Status Состояние потоковой 
передачи

Streaming Type Текущий выбранный тип 
потоковой передачи

Экран File Transfer Status

Отображение сведений о передаче файлов.

Отображаемый 
элемент

Описание

Auto Upload 
(Proxy)

Состояние включения/
выключения функции 
автоматической отправки 
(прокси)

Job Status 
(Remain / Total)

Оставшееся число заданий 
и общее число заданий

Total Transfer 
Progress

Общий ход выполнения 
всех заданий

Default Upload 
Server

Имя сервера назначения 
автоматической отправки 
(прокси)

Current File 
Transfer Progress

Ход выполнения передачи 
текущего файла

Current 
Transferring File 
Name

Имя текущего 
передаваемого файла

Server Address Адрес сервера назначения 
передаваемого файла

Destination 
Directory

Каталог назначения 
сервера назначения 
передаваемого файла

Использование экранов настройки с сенсорным вводом

Компоновка экрана

Пункт Кнопка Set

Метка, 
показывающая 
текущую 
настройку

Курсор выбора настройки 
(оранжевая рамка)

Название пункта

Варианты 
выбора

Управление

1 Нажмите пункт настройки.

Нажатие

Отображаются варианты для выбора 
значения.

2 Прямо нажмите на значение или 
перетащите/смахните требуемое 
значение к положению курсора.

Смахивание

3 Нажмите кнопку Set или курсор выбора 
значения.
Значение применяется, и снова 
отображается предыдущий экран.

[Советы]
ˎˎ Можно также нажать кнопку со стрелкой , чтобы 

применить значение.
ˎˎ  Нажмите кнопку CANCEL/BACK, чтобы вернуться 

к предыдущему значению.
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ˎˎ  Можно использовать также многофункциональный 
диск или многофункциональный селектор.
ˎˎ  Кроме того, сенсорные операции можно 

отключить (стр. 10).
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Подготовка источника питания
Можно использовать аккумуляторный 
блок или электропитание от адаптера 
переменного тока.
В целях безопасности используйте только 
аккумуляторные блоки и адаптеры 
переменного тока Sony из списка ниже.

Литий-ионные аккумуляторные блоки
BP-U35 (входит в комплект поставки)
BP-U60
BP-U70
BP-U90
BP-U100

Зарядные устройства
BC-U1A (входит в комплект поставки)
BC-U2A

Адаптер переменного тока (входит в 
комплект поставки)

Если установлен устройство расширения 
XDCA-FX9, можно использовать 
аккумулятор с башмаком V.
В целях безопасности используйте только 
аккумуляторные блоки и адаптеры 
переменного тока Sony из списка ниже.

Литий-ионные аккумуляторные блоки
BP-GL95B

Адаптер переменного тока
AC-DN10A

[ВНИМАНИЕ]

Не храните аккумуляторные блоки в местах, 
подвергающихся воздействию прямого 
солнечного света, огня или высокой 
температуры.

[Примечания]
ˎˎ При работе от источника питания переменного 

тока используйте входящий в комплект поставки 
адаптер переменного тока.

ˎˎ Всегда устанавливайте переключатель POWER 
в положение Off перед отключением или 
подключением аккумулятора или адаптера 
переменного тока. Если он отключается или 
подключается, когда переключатель POWER 
находится в положении On, в некоторых 
случаях видеокамера может не включиться. 
Если видеокамера не включается, установите 
переключатель POWER в положение Off и 
временно отключите аккумулятор или адаптер 
переменного тока, затем подождите 30 секунд, 
прежде чем подключать его обратно. (Если адаптер 
переменного тока отключается или подключается, 
когда видеокамера работает от аккумулятора, или 
наоборот, его можно отключить или подключить 
без проблем, когда переключатель POWER 
находится в положении On.)

ˎˎ При использовании адаптера AC-DN10A, когда 
к видеокамере подключены периферийные 
устройства, общее энергопотребление этих 
периферийных устройств не должно превышать 25 Вт.

Использование 
аккумуляторного блока

Для присоединения аккумуляторного 
блока вставьте его в отсек (стр. 8), 
а затем надавите на него вниз, чтобы 
зафиксировать на месте.

Для извлечения аккумуляторного блока 
нажмите и удерживайте кнопку BATT 
RELEASE (стр. 8), затем потяните 
аккумуляторный блок вверх и вытащите его 
из отсека.

Кнопка BATT 
RELEASE

[Примечания]
ˎˎ Перед установкой аккумуляторного блока 

зарядите аккумулятор с помощью специального 
зарядного устройства BC-U1A или BC-U2A.
ˎˎ При зарядке теплого аккумулятора (например, 

сразу после использования) он может зарядиться 
только частично.

Проверка оставшейся емкости

При съемке/воспроизведении с 
использованием аккумуляторного блока 
оставшаяся емкость аккумулятора 
отображается в видоискателе (стр. 11).

Значок Значение

От 91% до 100%

От 71% до 90%

От 51% до 70%

От 31% до 50%

От 11% до 30%

От 0% до 10%

Видеокамера указывает оставшуюся 
емкость аккумулятора, вычисляя 
оставшееся время работы при условии 
продолжения работы с текущим уровнем 
энергопотребления.

При использовании модуля 
расширения

При использовании устройства расширения 
XDCA-FX9 напряжение и оставшаяся 
емкость аккумулятора отображаются 
в зависимости от используемого 
аккумулятора.

[Примечание]
При подключении к видеокамере устройства 
XDCA-FX9 на нее невозможно установить 
стандартный аккумуляторный блок. Для обеспечения 
питания необходимо присоединить аккумуляторный 
блок к устройству XDCA-FX9 либо подключить 
внешнее питание.

Если заряд аккумулятора иссякает

Если во время работы оставшийся заряд 
аккумулятора падает ниже определенного 
уровня (состояние Low Battery), появляется 
сообщение о низком уровне заряда 
аккумулятора, индикатор записи/съемки 
начинает мигать и подается звуковой 
сигнал.
Если заряд аккумулятора падает до 
уровня, при котором работа не может 
продолжаться (состояние Battery 
Empty), выдается сообщение о том, что 
аккумулятор разряжен.
Замените его на заряженный 
аккумуляторный блок.
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Изменение уровней напряжения, на 
которых выдаются предупреждения

По умолчанию уровень Low Battery 
установлен на 10% от полного заряда 
аккумулятора, а уровень Battery Empty — 
на 3%. Изменить настройки уровней, на 
которых выдаются предупреждения, можно 
с помощью пункта Camera Battery Alarm 
(стр. 114) в меню Technical.

Использование электропитания 
переменного тока

Подключив видеокамеру к источнику 
питания переменного тока, вы сможете 
использовать камеру, не беспокоясь 
о необходимости подзаряжать 
аккумуляторный блок.

Разъем DC IN

Адаптер переменного 
тока

Шнур питания

Подсоедините адаптер переменного тока 
к разъему DC IN на видеокамере, после 
чего подсоедините шнур питания (входит 
в комплект поставки) к источнику питания 
переменного тока.

Если выходное напряжение адаптера 
переменного тока становится низким

Если во время работы выходное 
напряжение адаптера переменного тока 
становится ниже определенного уровня 
(состояние DC Low Voltage1), отображается 
сообщение о снижении выходного 
напряжения адаптера переменного тока, 
начинает мигать индикатор записи/съемки 
и подается звуковой сигнал.
Если выходное напряжение адаптера 
переменного тока становится ниже 
уровня, при котором дальнейшая работа 
невозможна (состояние DC Low Voltage2), 
отображается сообщение о слишком 
низком выходном напряжении адаптера 
переменного тока.
В этом случае адаптер переменного тока 
может быть неисправен. Проверьте адаптер 
переменного тока.

[Совет]
При использовании источника питания переменного 
тока, когда в видеокамеру установлен аккумулятор, 
видеокамера автоматически переключается на 
питание от аккумулятора при падении выходного 
напряжения адаптера переменного тока.

Изменение уровней, на которых 
выдаются предупреждения

По умолчанию уровню DC Low Voltage1 
задано значение 16,5 В, а уровню 
DC Low Voltage2 — 15,5 В. Изменить 
настройки уровней, на которых выдаются 
предупреждения, можно с помощью пункта 
Camera DC IN Alarm (стр. 114) в меню 
Technical.

Адаптер переменного тока

ˎˎ Не располагайте адаптер переменного 
тока в ограниченном пространстве, 
например, между стеной и мебелью.

ˎˎ Подсоединяйте адаптер переменного 
тока к ближайшему источнику питания 
переменного тока. Если во время работы 
возникнет неисправность, сразу же 
отсоедините шнур питания от источника 
питания переменного тока.
ˎˎ Не замыкайте металлические части вилки 
адаптера переменного тока. Это приведет 
к повреждению прибора.
ˎˎ Аккумулятор нельзя заряжать, когда он 
присоединен к видеокамере, даже если 
подключен адаптер переменного тока.
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Присоединение устройств

Использование рукоятки 
зажима

Используйте рукоятки зажимов при 
установке, снятии или регулировке 
положения микрофона и видоискателя.
При установке поверните рукоятку зажима 
по часовой стрелки, чтобы зафиксировать 
штангу.
При снятии или регулировке положения 
поверните рукоятку зажима против часовой 
стрелки, чтобы ослабить ее.
Если рукоятка зажима находится в 
положении, в котором ее трудно повернуть, 
снимите рукоятку (потянув за нее) и 
разверните ее под углом, в котором с ней 
будет удобно работать. Затем установите 
рукоятку зажима на место.

Рукоятка зажима

Регулировка положения 
держателя микрофона

Ослабьте рычаг зажима, поверните 
держатель микрофона, чтобы переместить 
его вперед или назад и отрегулировать 
положение.

Рукоятка зажима

Держатель микрофона и ориентация 
микрофона

Установите таким образом, чтобы 
держатель микрофона и микрофон были 
ориентированы, как показано на схеме 
ниже.

Замена штанги микрофона

[Примечания]
ˎˎ Штанга микрофона установлена при поставке с 

завода.
ˎˎ Присоединять и снимать штангу микрофона 

следует, когда питание видеокамеры отключено.
ˎˎ Присоединять и снимать штангу микрофона 

следует, когда крышка корпуса надета, чтобы не 
повредить датчик изображения.

1 Ослабьте винт.

2 Снимите штангу микрофона.

3 Установка штанги микрофона 
производится в обратной 
последовательности.

Присоединение видоискателя

[Примечание]
Присоединять и снимать видоискатель следует, 
когда питание видеокамеры отключено. В случае 
отсоединения видоискателя, когда видеокамера 
включена, она будет автоматически перезапущена.

1 Ослабьте рукоятку зажима 
видоискателя и вставьте видоискатель 
на штангу микрофона.

Рукоятка 
зажима

 [Примечание]
При установке видоискателя установите зажим 
штанги на штангу микрофона таким образом, 
чтобы эти детали были расположены так, как 
показано на следующем рисунке.
 – Рычаг фиксации зажима находится между 

штангой видоискателя и рукояткой
 – Штанга видоискателя расположена над 

штангой микрофона

Ручка

Рычаг 
фиксации 

зажима

Штанга 
видоискателя

Штанга 
микрофона

Зажим 
штанги
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2 Отрегулируйте положение 
видоискателя влево-вправо, затяните 
рукоятку зажима, подключите кабель 
видоискателя к разъему видоискателя 
на видеокамере и закрепите кабель 
видоискателя в кабельном хомуте.

Кабельный зажим

 [Примечания]
ˎˎ  Установите видоискатель таким образом, 

чтобы штанга видоискателя находилась над 
рычагом фиксации зажима видоискателя.

Штанга видоискателя

Рычаг фиксации 
зажима

Зажим 
видоискателя

Видоискатель

ˎˎ Удостоверьтесь в том, что видоискатель 
надежно закреплен. Если рукоятка зажима 
зафиксирована неплотно, видоискатель может 
отвалиться во время съемки.

Регулировка ориентации 
видоискателя

Наклоняйте видоискатель вверх и вниз, 
чтобы отрегулировать угол его установки.

Угол можно отрегулировать так, что 
видоискатель будет направлен на объект 
съемки. Если установить переключатель 
MIRROR в положение B/T, изображение 
на ЖК-экране будет перевернуто 
по горизонтали. Записываться же 
изображение при этом будет с правильной 
ориентацией.

Регулировка положения 
видоискателя

Регулировка под углом 90°
Если на шарнир соединения штанг 
установлена квадратная втулка, положение 
видоискателя можно регулировать с шагом 
90°.
Временно снимите видоискатель, 
чтобы настроить угол, затем установите 
видоискатель на место.

Регулировка под произвольным углом
Если на шарнир соединения штанг 
установлена круглая втулка, для 
регулировки положения видоискателя его 
можно поворачивать на штанге.

Если видоискатель развернут на 180°, 
как показано на следующем рисунке, 
установите переключатель MIRROR в 
положение ROT, чтобы перевернуть 
изображение и текстовую индикацию по 
горизонтали и вертикали.

[Примечание]
При установке круглой втулки зажима 
устанавливайте ее на имеющуюся в продаже штангу 
диаметром 15 мм.

[Совет]
По умолчанию на заводе-изготовителе 
устанавливается круглая втулка зажима.

Замена втулки зажима

Снимите втулку зажима, как показано 
на следующей схеме, совместите выступ 
на квадратной или круглой втулке с 
углублением в зажиме и установите втулку.

Выступ

Выступ

Углубление

Углубление

[Примечание]
Обязательно устанавливайте шайбу. Если шайба 
не установлена, зажимное усилие на штанге может 
оказаться недостаточным и видоискатель может 
свалиться.

Форму втулки можно определить, как 
показано на следующих схемах.
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Квадратная втулка зажима

Квадратная 
метка

Круглая втулка зажима

Круглая метка

Снятие видоискателя

Ослабьте рукоятку зажима видоискателя 
и выполните процедуру присоединения 
видоискателя в обратном порядке.

Присоединение окуляра

[Примечание]
Присоединять и снимать окуляр следует, когда 
питание видеокамеры отключено.

1 Закрепите крючок вверху окуляра за 
крючок вверху видоискателя, затем 
закрепите металлический зажим внизу 
окуляра на крючке внизу видоискателя.

Крючки крепления

2 Нажмите на фиксирующую пластину 
внизу окуляра в направлении стрелки 
для фиксации окуляра.

Фиксирующая 
пластина

Откидывание окуляра

Нажмите кнопку, на которую указывает 
стрелка.

Когда защелка разблокируется, 
приподнимите окуляр. Видоискатель виден 
непосредственно, когда окуляр приподнят.

Снятие задней части окуляра

Откройте окуляр вверх, освободите 
фиксатор окуляра в направлении 
стрелки () и сдвиньте заднюю 
часть окуляра наружу в направлении 
стрелки (). Когда задняя часть окуляра 
снята, переднюю часть окуляра можно 
использовать вместо бленды.

Установка задней части окуляра
При установке задней части окуляра 
совместите выступ петли с направляющей 
канавкой и нажмите его в направлении 
стрелки на следующем рисунке до 
фиксации.

Направляющая 
канавка

Выступ

Снятие окуляра

Разблокируйте защелку окуляра и снимите 
окуляр с видоискателя.

Присоединение объектива

[ВНИМАНИЕ]
Не оставляйте объектив на солнечном свете. Прямые 
солнечные лучи могут пройти через объектив, 
сфокусироваться в видеокамере и привести к 
возгоранию.

[Примечания]
ˎˎ Присоединять и снимать объектив следует, когда 

питание видеокамеры отключено.
ˎˎ Объектив является точным прибором. Не кладите 

объектив на поверхность байонетом вниз. 
Устанавливайте входящую в комплект поставки 
крышку байонета объектива.

[Совет]
Подробные сведения о том, какие объективы 
поддерживает видеокамера, можно получить у 
представителя службы технического обслуживания 
компании Sony.
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Присоединение объектива с 
байонетом E

1 Снимите крышку с объектива.

2 Освободите стопор кольца блокировки 
объектива, поверните кольцо 
блокировки объектива по часовой 
стрелке и снимите крышку корпуса с 
видеокамеры.

Стопорное 
кольцо 
объектива

Стопор 
кольца 
блокировки 
объектива

3 Выровняйте метку на байонете 
объектива (белую) с видеокамерой, 
осторожно вставьте объектив, после 
чего медленно поверните стопорное 
кольцо объектива против часовой 
стрелки, чтобы закрепить объектив.

Установочные метки (белые)

[Примечания]
ˎˎ Если стопор кольца блокировки объектива не 

вернулся в положение фиксации при установке 
объектива, переместите стопор в положение 
фиксации вручную.
ˎˎ При установке объектива совместите 

установочную метку (белую) на стопорном кольце 
объектива с установочной меткой (белой) на 
видеокамере.

Присоединение объектива с 
байонетом A

Для использования объективов с 
байонетом A сначала установите адаптер 
байонета объектива (не входит в комплект 
поставки) и только затем присоединяйте 
объектив с байонетом A.

[Примечание]
При использовании объективов с байонетом 
A диафрагма устанавливается вручную, а для 
фокусировки устанавливается режим MF.

Снятие объектива

Для снятия объектива выполните 
следующую процедуру.

1 Освободите стопор кольца блокировки 
объектива и поверните кольцо 
блокировки объектива по часовой 
стрелке, крепко держа объектив.

2 Потяните объектив вперед.

[Примечания]
ˎˎ При снятии объектива совместите установочную 

метку на стопорном кольце объектива с 
установочной меткой на видеокамере.
ˎˎ Надежно держите объектив рукой, чтобы он не 

упал.
ˎˎ Если не планируется сразу же установить другой 

объектив, обязательно установите крышку 
корпуса.

Регулировка диафрагмы для 
объективов с переключателем Auto 
Iris

ˎˎ Если переключатель Auto Iris на 
объективе установлен в положение AUTO, 
диафрагма настраивается автоматически 
и может также настраиваться вручную на 
видеокамере.
ˎˎ Если переключатель Auto Iris на 
объективе установлен в положение 
MANUAL, диафрагма может быть 
настроена только при помощи кольца 
объектива. Регулировка диафрагмы, 
производимая на видеокамере, не имеет 
никакого эффекта.

Регулировка фокуса для объективов с 
переключателем фокуса

ˎˎ Если переключатель фокуса на объективе 
установлен в положение AF/MF или AF, 
фокус настраивается автоматически и 
может также настраиваться вручную 
с пульта дистанционного управления.
ˎˎ Если переключатель фокуса на объективе 
установлен в положение MF, фокус 
настраивается с помощью кольца 
объектива, а также может настраиваться 
вручную с пульта дистанционного 
управления.

 [Примечание]
При использовании объектива с байонетом A 
ручная настройка с пульта дистанционного 
управления может быть недоступна.

ˎˎ Если переключатель фокуса на объективе 
установлен в положение Full MF, фокус 
может быть настроен только при помощи 
кольца объектива. Регулировка фокуса, 
производимая на видеокамере, не имеет 
никакого эффекта.

Крепление к штативу

При присоединении к штативу используйте 
гнезда головки штатива на видеокамере. 
Использование крепления для штатива на 
объективе может привести к повреждению.

Присоединение пульта 
управления на рукоятке

[Примечание]
Присоединять и снимать пульт управления на 
рукоятке следует, когда питание видеокамеры 
отключено.

1 Присоедините штангу к точке 
крепления рукоятки и затяните винт.
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2 Подключите кабель пульта управления 
на рукоятке к разъему USB/
многоцелевому разъему на 
видеокамере и зафиксируйте его 
с помощью кабельного зажима.

Зажим

[Примечания]
ˎˎ При подключении кабеля пульта управления на 

рукоятке зафиксируйте его с помощью кабельного 
зажима во избежание повреждений.
ˎˎ Убедитесь, что штанга надежно закреплена на 

видеокамере. Если винт не затянут, видеокамера 
может упасть во время съемки.
ˎˎ Не удерживайте видеокамеру на весу, держась 

только за рукоятку с пультом управления.
ˎˎ После подключения кабеля пульта управления 

на рукоятке обязательно закрепляйте кабель в 
зажиме. Если во время работы сильно потянуть за 
кабель, можно повредить разъем.
ˎˎ Если кабель рукоятки мешает, закрепите его с 

помощью кабельного зажима в центре штанги.

Регулировка положения пульта 
управления на рукоятке

ˎˎ Ослабьте винт крепления штанги, 
отрегулируйте угол штанги (1), затем 
затяните винт.
ˎˎ Ослабьте винт удлинения штанги, 
отрегулируйте длину штанги (2), затем 
затяните винт.

ˎˎ Нажмите рычаг вращения рукоятки 
(стр. 9), чтобы отрегулировать угол 
рукоятки с пультом управления (3).

2

3

1

Установка рукоятки близко от 
видеокамеры

1 Вывинтите крепежный винт штанги (1).

2 Ослабьте винт удлинения штанги (2) и 
раздвиньте штангу, чтобы стало видно 
отверстие (3).

1

2

3

 [Примечание]
После удлинения штанги надежно затяните винт.

3 Подключите кабель пульта управления 
на рукоятке к разъему USB/
многоцелевому разъему на 
видеокамере.

4 Совместите выступ она штанге с 
углублением в точке крепления 
рукоятки и зафиксируйте положение с 
помощью винта, снятого на шаге 1.
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Регулировка положения 
плечевой накладки

Плечевую накладку можно сдвинуть вперед 
или назад. Отрегулируйте положение 
плечевой накладки, чтобы было удобно 
работать с видеокамерой, поставленной на 
плечо.

2

1 3

1 3 1 3

Плечевая накладка

1 Ослабьте три винта плечевой накладки.

2 Сдвиньте плечевую накладку вперед 
или назад в требуемое положение.

3 Надежно затяните винты.

Присоединение устройства 
XDCA-FX9

К видеокамере можно добавлять такие 
функции, как аккумулятор с башмаком 
V или проводная локальная сеть, путем 
присоединения к видеокамере устройства 
расширения XDCA-FX9 (не входит в 
комплект поставки).

[Примечания]
ˎˎ При подключении к видеокамере устройства 

XDCA-FX9 на нее невозможно установить 
стандартный аккумуляторный блок. Для 
обеспечения питания необходимо присоединить 
аккумуляторный блок к устройству XDCA-FX9 либо 
подключить внешнее питание.
ˎˎ Присоединять и отсоединять устройство XDCA-FX9 

следует, когда питание видеокамеры отключено.

1 Извлеките аккумуляторный блок 
(стр. 19), присоединенный к 
видеокамере.

2 Выверните два винта и снимите с 
видеокамеры крышку блока разъемов 
модуля расширения.

3 Совместите выступы устройства 
XDCA-FX9 с левым и правым желобком 
видеокамеры и вдвиньте до упора, 
затем сдвиньте модуль вниз в блок 
разъемов.

Пазы Выступы

4 Затяните два винта, расположенных на 
верхней части устройства XDCA-FX9, 
чтобы зафиксировать его.

Снятие устройства XDCA-FX9

Ослабьте два винта, расположенных 
на верхней части устройства XDCA-FX9, 
и снимите устройство XDCA-FX9 с 
видеокамеры.

Установка аккумулятора с 
башмаком V

Вставьте аккумулятор с башмаком V в 
крепление аккумулятора на устройстве 
XDCA-FX9.

Снятие аккумулятора с башмаком V

Потяните аккумулятор с башмаком V из 
крепления аккумулятора на устройстве 
XDCA-FX9, удерживая нажатым рычаг 
разблокировки аккумулятора.
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Установка защиты

Можно установить защиту для защиты 
модема или другого USB-устройства, 
установленного в разъем USB.
Установите защиту и монтажный 
кронштейн защиты на модуль расширения 
и зафиксируйте ее винтами монтажного 
кронштейна.

Монтажная 
пластина защиты

Установка с помощью ремня 
крепления

Закрепите ремень крепления на защите, 
чтобы зафиксировать устройство USB на 
месте.
Закрепите петлю ремня на задней части 
защиты и пропустите ремень над защитой, 
как показано ниже.

Ремень крепления

Петля

Установка портативного 
беспроводного тюнера (при 
использовании беспроводного 
микрофона)

При использовании беспроводного 
микрофона на выключенную видеокамеру 
можно установить любой из следующих 
портативных беспроводных тюнеров.
ˎˎ Тюнер с поддержкой разнесенного 
приема в УВЧ-диапазоне URX-S03D
ˎˎ Цифровой приемник радиомикрофона 
DWR-S02DN

См. также инструкцию по эксплуатации портативного 
беспроводного тюнера.

[Примечание]
Поддержка беспроводных тюнеров зависит 
от региона и соответствующего диапазона 
частот. Узнайте у дилера Sony или в торговом 
представительстве Sony, какие беспроводные 
тюнеры можно использовать с данным устройством.

1 Выверните четыре винта крепления 
крышки установочного гнезда и 
снимите эту крышку.

2 Вставьте тюнер DWR-S02DN или URX-
S03D в гнездо в корпусе и закрепите 
его четырьмя винтами.

DWR-S02DN или 
URX-S03D

3 Задайте одну из следующих настроек.
Для входа CH1: установите 

переключатель выбора CH1 INPUT 
в положение MI SHOE и задайте для 
параметра Audio Input >CH1 MI SHOE 
Input Select в меню Audio значение 
Wireless.

Для входа CH2: установите 
переключатель выбора CH2 INPUT 
в положение MI SHOE и задайте для 
параметра Audio Input >CH2 MI SHOE 
Input Select в меню Audio значение 
Wireless.

Для входа CH3/CH4: задайте для пункта 
Audio Input >CH3 Input Select или CH4 
Input Select в меню Audio значение 
Wireless.
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Настройка основных операций видеокамеры
Начальный экран настройки открывается 
в видоискателе при первом включении 
видеокамеры либо после того, как 
резервный аккумулятор был полностью 
разряжен.
На этом экране задайте дату и время для 
внутренних часов прибора.
Перед съемкой настройте основные 
операции видеокамеры в соответствии с 
потребностями.

Time Zone
В параметре Time Zone задается разница 
во времени от универсального глобального 
времени. Задайте нужное значение.

Установка даты и времени

Кнопками со стрелками (стр. 7) 
или многофункциональным диском 
(стр. 4) выбирайте элементы или 
настройки, затем нажмите кнопку SET 
или многофункциональный диск, чтобы 
применить настройки и запустить часы.
После закрытия экрана настроек изменить 
дату, время и часовой пояс можно с 
помощью пункта Clock Set (стр. 121) в 
меню Maintenance.

[Примечания]
ˎˎ Если настройка времени сбилась после полного 

разряда резервного аккумулятора, возникшего 
из-за отключения питания на продолжительное 
время (аккумуляторный блок отключен, а внешний 
источник электропитания не подсоединен к 
разъему DC IN), начальный экран настройки 
откроется, когда видеокамера будет включена в 
следующий раз.
ˎˎ Когда в видоискателе отображается начальный 

экран настройки, какие-либо другие операции, 
кроме выключения видеокамеры, можно будет 
выполнять только после задания настроек на этом 
экране.
ˎˎ В видеокамере имеется встроенный элемент 

питания для хранения данных о дате, времени 

и других данных даже в случае выключения 
видеокамеры. Подробнее о встроенном элементе 
питания см. на стр. 127.

Режим съемки

Можно выбрать один из следующих 
режимов съемки: “SDR mode” (для гибкого 
создания изображений на месте), “HDR 
mode” (для съемки с широким цветовым 
пространством и широким динамическим 
диапазоном) и “Cine EI mode” (режим, 
в котором видеокамера работает как 
кинокамера, когда отснятый материал 
монтируется в студии).
Выберите режим съемки с помощью пункта 
Base Setting* >Shooting Mode (стр. 90) 
в меню Project.
* Можно настроить также на экране состояния.

[Примечания]
ˎˎ Режим Cine EI имеет следующие ограничения.

ˎˎ Функции, которые невозможно настроить 
автоматически (трекинг)
 – Баланс белого
 – Усиление
 – Затвор

ˎˎ Функции, которые невозможно настроить
 – Чувствительность ISO/усиление 

(задана базовая чувствительность ISO 
(фиксированная))

 – Настройки меню Paint (все отключены)
 – Scene File (отключен)

ˎˎ Следующие функции доступны только в режиме 
Cine EI.

ˎˎ Exposure Index
ˎˎ Monitor LUT

Когда используется режим съемки Cine EI, 
выберите базовое цветовое пространство 
для сигнала записи и выходного сигнала. 
Выбранное здесь цветовое пространство 
используется для выходного видеосигнала, 
когда параметру MLUT задано значение Off.

Выберите цветовое пространство 
с помощью пункта Cine EI Setting >Color 
Gamut (стр. 92) в меню Project.
ˎˎ S-Gamut3.Cine/SLog3: простая 
в настройке цветовая гамма для 
цифровой камеры (DCI-P3).
ˎˎ  S-Gamut3/SLog3: широкое цветовое 
пространство, охватывающее Sony’s ITU-R 
BT.2020.

Частота системы

Выберите частоту с помощью пункта Rec 
Format >Frequency* (стр. 90) в меню 
Project. В зависимости от выбранного 
значения, видеокамера может 
автоматически перезагрузиться после 
переключения.
* Можно настроить также на экране состояния.

[Примечание]
Переключение частоты системы во время записи или 
воспроизведения невозможно.

Режим Imager Scan Mode

Можно задать эффективный размер 
изображения и разрешение датчика 
изображения.
Выберите режим с помощью пункта Rec 
Format >Imager Scan Mode* (стр. 90) 
в меню Project.
* Можно настроить также на экране состояния.

ˎˎ FF 6K: полнокадровый размер 
с разрешением 6K.
ˎˎ FFcrop 5K: полнокадровый размер, 
кадрированный приблизительно до 83% 
от разрешения 5K.
ˎˎ S35 4K: размер Super 35mm 
с разрешением 4K.

ˎˎ FF 2K: полнокадровый размер 
с разрешением 2K.
ˎˎ S35 2K: размер Super 35mm с 
разрешением 2K.

[Примечания]
ˎˎ Переключение режима Imager Scan Mode во время 

записи или воспроизведения невозможно.
ˎˎ Если для датчика изображения задан режим 

развертки FF 2K или S35 2K, настройка формата 
записи ограничена разрешением 1920×1080.

Кодек

Выберите кодек с помощью пункта Rec 
Format >Codec* (стр. 90) меню Project.
* Можно настроить также на экране состояния.

[Примечание]
Переключение кодека во время записи или 
воспроизведения невозможно.

Видеоформат

Можно задать видеоформат для записи. 
Формат выбирается с помощью пункта 
Rec Format >Video Format* (стр. 90) меню 
Project.
* Можно настроить также на экране состояния.

[Примечания]
ˎˎ Переключение видеоформата во время записи 

или воспроизведения невозможно.
ˎˎ В зависимости от настройки видеоформата 

могут накладываться ограничения на сигнал, 
выводимый на разъемы SDI OUT и HDMI OUT.
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Использование карт памяти XQD
Видеокамера записывает аудио- и видеосигналы на карты памяти XQD (не входят в 
комплект поставки), которые вставляются в гнезда для карт.

О картах памяти XQD

Используйте в видеокамере следующие карты памяти Sony XQD.
Подробные сведения о работе с носителями других производителей см. в инструкции по 
эксплуатации носителей или в информации от производителя.
Карты памяти XQD серии S (QD-S64E/S32E/S64/S32)
Карты памяти XQD серии H (QD-H32/H16)
Карты памяти XQD серии N (QD-N64)
Карты памяти XQD серии M (QD-M128A/M64A/M32A)
Карты памяти XQD серии G (QD-G240F/G120F/G256E/G128E/G64E/G32E/G128A/G64A/G32A)
Возможность использования других карт памяти (кроме карт памяти Sony XQD) не 
гарантируется.

[Совет]
Подробное описание использования карт памяти XQD и предупреждения см. в инструкции по эксплуатации 
карты памяти XQD.

Рекомендуемый носитель

Условия гарантированной работы зависят от формата записи (Rec Format) и настроек 
записи (Recording).
Да: работа поддерживается
Нет: нормальная работа не гарантируется

Формат записи Серия G
Серия S
(QD-S64E/S32E)

Серия N
Серия M

Серия H
Серия S
(QD-S64/S32)

XAVC Intra 
422

4096×2160 Нормальный 
режим или 
S&Q (60P или 
ниже)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P/ 
24P

Да Нет Нет

3840×2160 Нормальный 
режим или 
S&Q (60P или 
ниже)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Да Нет Нет

1920×1080 Нормальный 
режим или 
S&Q (60P или 
ниже)

59.94P/ 
50P

Да Нет Нет

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Да Да Нет

S&Q (выше 
60P)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Да Нет Нет
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Формат записи Серия G
Серия S
(QD-S64E/S32E)

Серия N
Серия M

Серия H
Серия S
(QD-S64/S32)

XAVC Long 
422

3840×2160 Нормальный 
режим или 
S&Q (60P или 
ниже)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Да Да Нет

1920×1080 Нормальный 
режим или 
S&Q (60P или 
ниже)

59.94P/ 
50P/ 
59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Да Да Да

S&Q (выше 
60P)

59.94P/ 
50P

Да Да Нет

29.97P Да 50 Мбит/с: 
Нет
35 Мбит/с: Да

Нет

25P/ 
23.98P

Да Нет Нет

MPEG2 HD 
422

1920×1080 Нормальный 
режим

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Да Да Да

Установка карт памяти XQD

1 Откройте крышку отделения с гнездами 
для карт памяти.

2 Вставьте карту памяти XQD так, чтобы 
ярлык XQD был направлен влево.
Индикатор доступа (стр. 8) 
загорится красным, после чего его цвет 
изменится на зеленый, если карта 
является работоспособной.

3 Закройте крышку носителя.

[Примечания]
ˎˎ Сама карта памяти, гнездо для карт памяти и 

данные, записанные на карту памяти могут быть 
повреждены, если вставлять карту в гнездо с 
усилием, когда она неправильно ориентирована.
ˎˎ При записи в оба гнезда для карт памяти XQD (A 

и B) вставляйте носители, рекомендуемые для 
работы с соответствующим форматом.

Извлечение карт памяти XQD

Откройте крышку отделения с гнездами 
для карт памяти и слегка нажмите на карту 
памяти XQD, чтобы извлечь ее.

[Примечания]
ˎˎ Если видеокамера выключается, когда карта 

памяти используется, или карта памяти 
извлекается в этот момент, целостность 
находящихся на карте памяти данных не 
гарантируется. Все данные, записанные на карту 
памяти, могут быть потеряны. Перед выключением 
видеокамеры или извлечением карты памяти 
всегда необходимо убедиться, что индикатор 
доступа горит зеленым цветом или не горит.
ˎˎ При извлечении карты памяти XQD сразу после 

завершения съемки она может быть горячей, но 
это не указывает на неисправность.

Форматирование 
(инициализация) карт памяти 
XQD

Если в видеокамеру вставить 
неформатированную карту памяти XQD 
или карту памяти XQD, которая была 
отформатирована в другой системе, 
в видоискателе откроется сообщение 
“Media Needs to be Formatted” (Носитель 
необходимо отформатировать).
Для форматирования карты выполните 
следующую процедуру.

1 Выберите пункт Format Media 
(стр. 103) в меню TC/Media.

2 Выберите Media(A) (гнездо A) или 
Media(B) (гнездо B), затем выберите 
Execute.
Отображается сообщение с запросом 
подтверждения.

3 Выберите Execute.
Во время выполнения форматирования 
на экране отображается сообщение, а 
индикатор доступа горит красным.
После завершения форматирования 
отображается сообщение о 
завершении. Нажмите кнопку SET или 
многофункциональный диск, чтобы 
закрыть сообщение.

[Примечание]
При форматировании карты памяти все находящиеся 
на ней данные, в том числе записанные видеоклипы 
и файлы настройки, стираются.
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Если выполнить форматирование не 
удалось

Карты памяти, которые не поддерживаются 
видеокамерой, нельзя отформатировать.
На экране появится сообщение с 
предупреждением. Выполните инструкции 
по замене карты на поддерживаемую карту 
памяти XQD.

Проверка оставшегося времени 
записи

При съемке (записи/в режиме ожидания) 
можно отслеживать оставшееся свободное 
место на картах памяти XQD, установленных 
в гнезда, по индикаторам оставшейся 
емкости носителей A и B, которые 
отображаются в видоискателе (стр. 11).
Оставшееся время записи вычисляется 
по оставшейся емкости носителей, 
установленных в каждом гнезде, и 
текущему формату видео (скорости 
передачи данных при записи). Оно 
отображается в минутах.

Время замены карты памяти XQD

ˎˎ Когда общее оставшееся время записи на 
обеих картах памяти становится менее 5 
минут, на экране появляется сообщение 
“Media Near Full” (Носитель почти 
заполнен), индикатор записи/съемки 
начинает мигать и подается звуковой 
сигнал (через выход на наушники).  
Замените на носитель с достаточным 
свободным местом.
ˎˎ Если продолжить запись до тех пор, 
пока вся емкость не будет исчерпана, то 
на экране появится сообщение “Media 

Full” (Носитель заполнен) и запись будет 
остановлена.

[Примечание]
На одну карту памяти XQD можно записать 
приблизительно 600 клипов.
Если количество записанных клипов достигнет 
порогового значения, индикатор оставшегося 
времени записи будет показывать “0”, а на экране 
появится сообщение.

Восстановление карт памяти 
XQD

Если по какой-либо причине на карте 
памяти произойдет ошибка, эту карту 
необходимо восстановить перед 
использованием.
При загрузке карты памяти XQD, которая 
требует восстановления, на экране 
видоискателя отображается сообщение с 
запросом, хотите ли вы восстановить карту.

Восстановление карты

Кнопками со стрелками (стр. 7) или 
многофункциональным диском (стр. 4) 
выберите Execute, затем нажмите кнопку 
SET или многофункциональный диск.
Во время выполнения форматирования 
на экране отображается сообщение, а 
индикатор доступа горит красным.
После завершения восстановления 
отображается сообщение.

В случае сбоя восстановления

ˎˎ Карта памяти XQD, на которой возникли 
ошибки памяти, не может быть 
восстановлена. На экране появится 
сообщение с предупреждением. 
Выполните инструкции по замене карты 
памяти XQD.

ˎˎ При повторном форматировании карт 
памяти XQD, на которых возникли 
ошибки памяти, эти карты могут стать 
непригодными для использования.
ˎˎ В некоторых случаях какие-то клипы 
могут быть восстановлены, а другие 
— нет. Восстановленные клипы 
воспроизводятся нормально.
ˎˎ Если сообщение “Could not Restore Some 
Clips” продолжает появляться после 
нескольких попыток восстановления, 
попробуйте восстановить карту памяти 
XQD с помощью следующей процедуры.
1 Скопируйте требуемые клипы на 

другую карту памяти XQD с помощью 
пункта Copy Clip (стр. 110) в меню 
Thumbnail.

2 Отформатируйте неисправную карту 
памяти XQD в видеокамере.

3 Скопируйте требуемые клипы обратно 
на заново отформатированную карту 
памяти XQD.

[Примечания]
ˎˎ Восстановление носителя, записанного в данной 

видеокамере, обязательно выполняйте с помощью 
данной видеокамеры.
ˎˎ С помощью данной видеокамеры невозможно 

восстановить носитель, записанный в другом 
устройстве или в другой видеокамере другой 
версии (даже этой же модели).
ˎˎ Восстановление клипов длительностью менее 2 с 

невозможно.
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Использование карты памяти UTILITY SD/MS
Карта UTILITY SD/MS служит для записи 
прокси, а также для сохранения и загрузки 
настроек. Она также используется для 
обновления программного обеспечения.

Поддерживаемые карты памяти 
SD/MS

Карты памяти SDXC*
Карты памяти SDHC*
Карты памяти SD*
“Memory Stick PRO-HG Duo”**
“Memory Stick PRO Duo”**
* В этом руководстве такие карты памяти совместно 

именуются “Карты памяти SD”.
** В этом документе совместно именуются “Memory 

Stick”.

[Примечание]
Запись прокси на носитель “Memory Stick” не 
поддерживается.

Установка карты памяти SD/MS

1 Откройте крышку отделения с гнездами 
для карт памяти.

2 Установите карту памяти SD или 
носитель “Memory Stick” в гнездо для 
карт памяти этикеткой вправо.
Индикатор доступа (стр. 8) 
загорится красным, после чего 
погаснет, если карта является 
работоспособной.

3 Закройте крышку носителя.

Извлечение карты памяти SD/
MS

Откройте крышку отделения с гнездами 
для карт памяти и слегка нажмите на карту 
SD или носитель “Memory Stick”, чтобы 
извлечь его.

[Примечания]
ˎˎ В случае выключения видеокамеры или 

извлечения карты памяти SD или носителя 
“Memory Stick” во время обращения к карте 
памяти SD или носителю “Memory Stick” 
целостность данных не гарантируется. Все 
данные, записанные на карту памяти, могут быть 
потеряны. Перед выключением видеокамеры 
или извлечением карты памяти SD или носителя 
“Memory Stick” необходимо обязательно 
убедиться, что индикатор доступа не горит.
ˎˎ Соблюдайте осторожность при установке и 

извлечении карты памяти SD или носителя 
“Memory Stick”, они могут выскочить.

Форматирование 
(инициализация) карт памяти 
SD/MS

Перед использованием карт памяти SD или 
носителей “Memory Stick” в видеокамере в 
первый раз их необходимо форматировать.
Карта памяти SD или носитель “Memory 
Stick”, которые будут использоваться 
с этой видеокамерой, необходимо 
отформатировать с помощью функции 
форматирования данной видеокамеры.

1 Выберите пункт Format Media 
(стр. 103) в меню TC/Media.

2 Укажите Utility SD/MS, затем выберите 
Execute.

Отображается сообщение с запросом 
подтверждения.

3 Выберите Execute.
Во время форматирования на экране 
отображается сообщение и ход 
выполнения, а индикатор доступа горит 
красным.
После завершения форматирования 
отображается сообщение о 
завершении. Нажмите кнопку SET или 
многофункциональный диск, чтобы 
закрыть сообщение.

[Примечание]
При форматировании карты памяти SD или носителя 
“Memory Stick” с него удаляются все данные. 
Восстановление данных невозможно.

Проверка оставшейся емкости

Посмотреть объем свободного места на 
карте памяти SD или носителе “Memory 
Stick” можно на экране Media Status 
(стр. 16).
Если при съемке (запись/ожидание) для 
записи прокси задано значение On, можно 
контролировать оставшуюся емкость 
карты памяти SD с помощью индикаторов 
оставшегося носителя на экране 
видоискателя (стр. 11).

[Примечание]
Если карта памяти SD защищена, отображается 
значок .

Использование карты памяти SD, 
отформатированной в видеокамере, 
в гнезде другого устройства

Прежде всего, создайте резервную копию 
находящихся на карте данных, затем 

отформатируйте карту на том устройстве, 
где она будет использоваться.
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Основные операции
Далее описана процедура ведения простой 
съемки.

1 Присоедините необходимые устройства 
и удостоверьтесь в том, что подается 
питание.

2 Вставьте карты памяти.

3 Установите переключатель POWER во 
включенное положение.
Загорается индикатор POWER, и в 
видоискателе появляется изображение 
камеры.

4 Нажмите кнопку/индикатор START/
STOP (пуск/остановка записи) 
(стр. 6).
Загорается индикатор записи/съемки, и 
начинается запись.

5 Чтобы остановить запись, нажмите 
кнопку START/STOP (пуск/остановка 
записи) (стр. 6) еще раз.
Запись будет остановлена, и 
видеокамера перейдет в режим STBY 
(режим ожидания).

[Примечание]
Если кнопка START/STOP (пуск/остановка записи) 
нажата в течение нескольких секунд после 
включения видеокамеры, индикатор записи/съемки 
загорается, указывая на то, что устройство находится 
в состоянии записи, но запись на носитель может не 
осуществляться в течение первых нескольких секунд 
в зависимости от выбранного формата записи.

Переключение между картами 
памяти XQD

Если в видеокамеру вставлены две карты 
памяти XQD, для переключения карт служит 
кнопка SLOT SELECT (стр. 7).
Запись автоматически переключается на 
вторую карту памяти непосредственно 
перед тем, как оставшаяся емкость первой 
карты памяти уменьшится до нуля (запись 
с переключением). Можно продолжать 
непрерывную съемку с переключением 
карт памяти, заменяя заполненную карту 
памяти новой.

[Примечание]
Переключаться между картами памяти в режиме 
воспроизведения нельзя. Кроме того, непрерывное 
воспроизведение клипов с носителей, вставленных в 
гнезда A и B, не поддерживается.

Клипы (записанные данные)
Когда запись останавливается, видео, звук и 
сопутствующие данные от начала до конца 
записи сохраняются в виде единого “клипа” 
на карту памяти XQD.

Названия клипов
Имя каждого клипа, записанного 
видеокамерой, автоматически назначается 
с использованием формата, заданного 
в пункте Clip Name Format (стр. 102) меню 
TC/Media.

Максимальная продолжительность клипа
До 6 часов на клип.
Максимальная длительность непрерывной 
съемки совпадает с максимальной 
длительностью клипа. Если время съемки 
превышает максимальную длительность 
клипа, автоматически создается новый клип 
и съемка продолжается. На экране эскизов 
новый клип отображается как отдельный клип.

Несколько клипов записывается 
последовательно во время записи 
с переключением карт, но запись 
останавливается автоматически 
приблизительно через 24 часов.

[Примечания]
ˎˎ Не извлекайте карту памяти в тот момент, когда на 

нее ведется запись. Во время записи заменяйте 
карты памяти только в гнездах, для которых не 
горит индикатор доступа к гнезду.
ˎˎ Когда на карте памяти, на которую выполняется 

запись, остается места менее чем на одну минуту 
видео, а в другое гнездо вставлена доступная 
для записи карта памяти, на экране открывается 
сообщение “Will Switch Slots Soon” (Гнезда скоро 
будут переключены). Это сообщение исчезнет 
после того, как переключение гнезд будет 
произведено.
ˎˎ Запись с переключением карт памяти может не 

работать, если запись запускается в тот момент, 
когда на карте памяти осталось свободного 
места менее чем на одну минуту видео. Во 
избежание ошибок при выполнении записи с 
переключением карт памяти перед началом 
записи удостоверьтесь, что на карте памяти 
осталось больше свободного места, чем на одну 
минуту видео.
ˎˎ Видео, записанное с помощью функции записи 

с переключением карт памяти, не может 
воспроизводиться на видеокамере без паузы.
ˎˎ Для объединения видео, записанного с помощью 

функции записи с переключением карт памяти, 
используйте программное обеспечение “Catalyst 
Browse”.

Мониторинг звука

Прослушивать записываемый звук можно с 
помощью наушников.
Подключите наушники к гнезду для 
наушников (стр. 8), и вы сможете 
прослушивать записываемый звук. 
Прослушивать воспроизводимый звук 
(стр. 72) также можно с помощью 
встроенного динамика (стр. 6) или 
наушников.
Настройте громкость контроля звука с 
помощью кнопок VOLUME (регулировка 
громкости контроля звука) (стр. 6).
Аудиоканал для контроля можно выбрать 
с помощью пункта Audio Output >Monitor 
CH* (стр. 108) в меню Audio.
* Можно настроить также на экране состояния.
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Указание данных времени

Установка временного кода

Временной код для записи задается в 
пункте Timecode (стр. 102) меню TC/Media.

Задание пользовательских битов

В записанное изображение можно 
добавить 8-значный шестнадцатеричный 
номер в виде пользовательских битов. 
Можно также задать для пользовательских 
битов текущее время. Для задания 
используйте пункт Users Bit (стр. 102) в 
меню TC/Media.

Отображение данных времени

Временной код для отображения задается 
в пункте TC Display (стр. 102) >Display 
Select меню TC/Media.
Нажатием программируемой кнопки 
(стр. 47), которой назначена функция 
DURATION/TC/U-BIT, отображаемые 
на экране данные последовательно 
переключаются между временным 
кодом, битами пользователя и 
продолжительностью.

Переключение ввода/вывода 
временного кода

Для переключения ввода/вывода 
временного кода служит переключатель IN/
OUT (стр. 8).
Подробное описание см. на стр. 125.

Перемотка записи назад (Rec 
Review)

Последний записанный клип можно 
просмотреть на экране (просмотр записи).

[Примечание]
Функция Rec Review не будет работать при 
изменении формата видео после записи клипа.

Способ просмотра записи

Заранее назначьте функцию Rec Review 
одной из программируемых кнопок.
Когда запись остановлена, нажмите 
программируемую кнопку (стр. 47), 
которой назначена функция Rec Review. 
Начнется воспроизведение клипа, 
записанного последним.
Клип будет воспроизведен до конца, работа 
функции Rec Review будет завершена, 
а видеокамера вернется в режим STBY 
(режим ожидания).

Остановка работы функции Rec 
Review

Нажмите программируемую кнопку, 
которой назначена функция Rec Review, или 
нажмите кнопку CANCEL/BACK.

Настройки просмотра записи

С помощью настройки Rec Review 
(стр. 112) из меню Technical можно задать 
одну из следующих позиций начала 
воспроизведения.
ˎˎ Последние 3 секунды клипа
ˎˎ Последние 10 секунд клипа
ˎˎ Начало клипа

[Совет]
Если требуется просмотреть конкретный клип 
после съемки нескольких клипов, нажмите кнопку 
THUMBNAIL, чтобы открыть экран эскизов, и выберите 
клип для начала воспроизведения.
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Настройка фокусировки
Фокусировку можно настраивать 
автоматически или вручную в соответствии 
с условиями съемки.

Регулировка фокусировки 
вручную (Manual Focus)

Чтобы выполнять фокусировку вручную, 
установите переключатель FOCUS 
(стр. 6) в положение “MAN”.
Это позволит регулировать фокус вручную в 
зависимости от условий съемки.
Ручная фокусировка подходит для съемки 
объектов следующих видов.
ˎˎ Объекты, которые находятся за окном, 
покрытом каплями воды
ˎˎ Объекты, которые сливаются с фоном
ˎˎ Объекты, находящиеся дальше 
расположенных поблизости объектов

Автоматическая регулировка 
фокусировки (Auto Focus)

В видеокамере используется фазовая AF 
для быстрой фокусировки и контрастная AF 
для точной фокусировки.
Сочетание этих двух методов 
автофокусировки обеспечивает быструю и 
точную автоматическую фокусировку.
Чтобы фокусировка выполнялась 
автоматически, установите переключатель 
FOCUS (стр. 6) видеокамеры 
в положение “AUTO”. Если объектив 
оборудован селекторным переключателем 
фокуса, установите его в положение “AF/MF” 
или “AF”. Если переключатель установлен в 
положение “Full MF” или “MF”, видеокамера 
не может управлять фокусировкой 
объектива (стр. 24).
В режиме AF горит светодиод FOCUS AUTO.

[Совет]
Даже если для параметра Focus >AF Assist 
(стр. 87) в меню Shooting задано значение On, 
фокусировку все равно можно настраивать во время 
автоматической фокусировки с помощью кольца 
фокусировки на объективе.

[Примечания]
ˎˎ Требуется объектив, поддерживающий 

автоматическую фокусировку.
ˎˎ В некоторых условиях съемки точность может не 

обеспечиваться.
ˎˎ Фокус невозможно настроить автоматически на 

объективе с байонетом A.

Задание области/положения 
автоматической фокусировки (Focus 
Area)

Целевую область для автоматической 
фокусировки можно задать с помощью 
параметра Focus >Focus Area (стр. 87) в 
меню Shooting.

Flexible Spot:
Производит фокусировку на указанное 
положение изображения.
Если выбран этот вариант, укажите 
положение кнопками со стрелками 
(стр. 7) или многофункциональным 
селектором (стр. 9).
Вернуться в центральное положение 
можно, нажав и удерживая кнопку SET 
(стр. 7) или многофункциональный 
селектор.

Zone:
Автоматический поиск положения 
фокусировки в указанной зоне.
Если выбран этот вариант, укажите 
положение кнопками со стрелками 
(стр. 7) или многофункциональным 
селектором (стр. 9).
Вернуться в центральное положение 
можно, нажав и удерживая кнопку SET 
(стр. 7) или многофункциональный 
селектор.

Wide:
При фокусировке производится поиск 
объекта по широкому углу изображения. 
Рамка не отображается.

[Совет]
Эта же операция поддерживается с помощью 
программируемой кнопки (стр. 47), которой 
назначена функция Focus Area.
Рамку области фокусировки можно отобразить или 
скрыть с помощью пункта Display On/Off >Focus Area 
Indicator (стр. 104) в меню Monitoring.

[Примечание]
При использовании кнопки DISPLAY рамка области 
фокусировки не скрывается.

Быстрое изменение области 
фокусировки (Focus Setting)

Чтобы иметь возможность быстро 
изменять положение и размер области 
автоматической фокусировки во время 
съемки, назначьте функцию Focus Setting 
программируемой кнопке (стр. 47).
Работа функции зависит от настройки 
области фокусировки.

Когда пункту Focus >Focus Area (стр. 87) 
в меню Shooting задано значение Flexible 
Spot или Zone
Чтобы изменить положение области 
фокусировки, нажмите программируемую 
кнопку, которой назначена функция 
Focus Setting, и выполните регулировку 
с помощью кнопок со стрелками (стр. 7), 
многофункционального селектора 
(стр. 9) или операции прикосновения 
(стр. 36).
Чтобы вернуть область фокусировки 
в центр во время регулировки ее 
положения, нажмите кнопку SET (стр. 7) 
или многофункциональный селектор.
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Чтобы изменить размер области 
фокусировки, нажмите и удерживайте 
программируемую кнопку, которой 
назначена функция Focus Setting.
После изменения размера, задайте 
положение области фокусировки, нажав 
кнопку SET или многофункциональный 
селектор.
Завершив регулировку, нажмите 
программируемую кнопку, которой 
назначена функция Focus Setting, чтобы 
вернуться на исходный экран.

Когда пункту Focus >Focus Area (стр. 87) 
в меню Shooting задано значение Wide
Изменить можно только размер области 
фокусировки. Для этого нажмите и 
удерживайте программируемую кнопку, 
которой назначена функция Focus Setting. 
Чтобы изменить положение, сначала 
необходимо изменить тип на Flexible Spot 
или Zone.

[Советы]
ˎˎ Рамка области фокусировки отображается 

оранжевым цветом, когда положение области 
фокусировки можно изменить.
ˎˎ Когда параметру Focus >Push AF Mode (стр. 87) 

в меню Shooting задано значение Single-shot 
AF(AF-S), можно изменять положение области 
фокусировки Focus Area(AF-S) (стр. 87).

Перемещение рамки области 
фокусировки с помощью сенсорных 
операций (область сенсорной 
фокусировки)

Область фокусировки можно перемещать 
при помощи операции прикосновения, 
когда область фокусировки отображается 
оранжевым цветом в результате настройки 
Focus > Focus Area (стр. 87) в меню 
Shooting на Flexible Spot или Zone, или 
путем нажатия программируемой кнопки, 
связанной с функцией Focus Setting.

Нажмите экран для перемещения центра 
области фокусировки в место нажатия. 
Перетаскивайте экран, чтобы область 
фокусировки перемещалась вслед за 
пальцем (стр. 10).

Нажмите в любом месте

Центр области фокусировки 
перемещается в нажатое место.

Перетащите для перемещения области 
фокусировки вслед за пальцем

[Примечания]
ˎˎ  Если нажать в некотором положении или 

перетащить область фокусировки в положение 
вне диапазона настройки, область фокусировки 
перемещается к верхнему, нижнему, левому или 
правому краю диапазона настройки.
ˎˎ  В указанных ниже условиях эта функция 

недоступна.
 – Если для пункта Touch Operation (стр. 77) 

в меню Technical задано значение Off
 – Если область фокусировки отображается серым 

цветом или вообще не отображается

Настройка работы автофокусировки 
(скорость изменения AF, 
чувствительность к смене объекта AF)

Скорость изменения AF
Скорость изменения фокусировки при 
изменении объекта можно задать с 
помощью пункта Focus >AF Transition Speed 
(стр. 87) в меню Shooting.
Если задана низкая скорость, при 
изменении объекта фокусировки фокус 
перемещается медленно, что позволяет 
снимать впечатляющие кадры.
Если задана высокая скорость, фокус 
быстро переключается между объектами. 
Камера моментально фокусируется на 
объекте съемки, попадающем в кадр, что 

делает эту настройку идеальным вариантом 
для документальной съемки, требующей 
быстрой фокусировки.

Во время изменения:
1(Slow): фокус изменяется 
медленно
.
.
.
7(Fast): фокус изменяется 
быстро

Фокусировка на дальний объект

Фокусировка на ближний объект
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Чувствительность к смене объекта AF
Чувствительность к смене объектов можно 
задать с помощью пункта Focus >AF Subj. 
Shift Sens. (стр. 87) в меню Shooting.
Когда задана низкая чувствительность, 
фокус не будет сразу же изменяться, если 
перед объектом, на который наведен фокус, 
появляется другой объект. Когда задана 
высокая чувствительность, фокусировка 
изменяется, отдавая приоритет объекту, 
появившемуся впереди.

[Совет]
Если функция AF Speed/Sens. назначена 
программируемой кнопке, при каждом нажатии 
этой кнопки отображаются полосы уровня для 
регулировки значений, позволяя изменять скорость 
изменения AF и чувствительность к смене объекта AF.
Скорость изменения AF  Чувствительность к смене 
объекта AF  Нет индикации …

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Медленное изменение фокусировки на 
другой объект

Быстрое изменение фокусировки на 
другой объект

Изменение целевой области 
фокусировки вручную (AF Assist)

Кода параметру Focus >AF Assist (стр. 87) 
в меню Shooting задано значение On, 
целевую область для автоматической 
фокусировки можно выбирать во время 
съемки с автофокусом с помощью кольца 
фокусировки на объективе.
Работа функции автоматической 
фокусировки восстанавливается, когда 
оператор перестает использовать кольцо 
фокусировки.
Задание параметру Focus >AF Subj. 
Shift Sens. (стр. 87) в меню Shooting 
значения 1(Locked On) удобно, когда нужно, 
чтобы работа функции автоматической 
фокусировки продолжалась без изменений 
при перемещении положения фокуса на 
объект съемки, находящийся на другом 
расстоянии.

Временное использование 
ручной фокусировки (Push 
Manual Focus)

Нажмите кнопку PUSH AUTO FOCUS (стр. 6) 
при работе в режиме автоматической 
фокусировки, чтобы фокусироваться вручную, 
пока нажата эта кнопка.
После того как кнопка будет отпущена, 
восстанавливается автоматическая 
фокусировка.
Это позволяет временно останавливать 
автоматическую фокусировку и 
фокусироваться вручную, когда что-либо, 
не являющееся объектом съемки, проходит 
перед ним.
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[Совет]
Эта же операция поддерживается с помощью 
программируемой кнопки (стр. 47), которой 
назначена функция Push AF/Push MF.

Временное использование 
автоматической фокусировки 
(Push Auto Focus)

Если для параметра Focus >Push AF 
Mode (стр. 87) в меню Shooting 
задано значение AF, нажмите кнопку 
PUSH AUTO FOCUS (стр. 6) в режиме 
ручной фокусировки, чтобы использовать 
автоматическую фокусировку, пока эта 
кнопка удерживается нажатой.
Фокусировка производится в пределах 
области фокусировки, заданной с помощью 
параметра Focus >Focus Area (стр. 87) в 
меню Shooting.
После того как кнопка будет отпущена, 
восстанавливается ручная фокусировка.
Это удобно, когда требуется медленно 
перемещать фокус с одного объекта на 
другой во время ручной фокусировки.

[Советы]
ˎˎ Эта же операция поддерживается с помощью 

программируемой кнопки (стр. 47), которой 
назначена функция Push AF/Push MF.
ˎˎ Функцию Push AF Mode также можно назначить 

программируемой кнопке (стр. 47).

[Примечание]
Функция Push Auto Focus не работает, если в 
объективе задана фокусировка вручную.

Использование покадровой 
автоматической фокусировки 
(Push Auto Focus (AF-S))

Задайте для параметра Focus >Push AF 
Mode (стр. 87) в меню Shooting значение 
Single-shot AF(AF-S), затем задайте область 
фокусировки с помощью параметра 
Focus >Focus Area(AF-S) (стр. 87) в меню 
Shooting.
Нажмите кнопку PUSH AUTO FOCUS при 
работе в режиме ручной фокусировки, 
чтобы автоматически сфокусироваться 
с высокой скоростью. Фокусировка 
прекратится, как только оператор отпустит 
кнопку.
Состояние фокусировки обозначается 
индикатором фокусировки.
ˎˎ On: фокус фиксируется в положении 
фокусировки.
ˎˎ Мигает: не в фокусе. Поскольку 
фокусировка ведется не автоматически, 
измените композицию и настройки 
фокусировки, чтобы установить фокус.

После того как кнопка будет отпущена, 
восстанавливается ручная фокусировка.
Это полезно, когда требуется быстро 
сфокусироваться на объекте перед началом 
съемки.

[Советы]
ˎˎ Эта же операция поддерживается с помощью 

программируемой кнопки (стр. 47), которой 
назначена функция Push AF/Push MF.
ˎˎ Функцию Push AF Mode также можно назначить 

программируемой кнопке (стр. 47).
ˎˎ Функцию Focus Area(AF-S) также можно назначить 

программируемой кнопке (стр. 47).
ˎˎ Рамку области фокусировки можно отобразить 

или скрыть с помощью пункта Display On/
Off >Focus Area Ind.(AF-S) (стр. 104) в меню 
Monitoring.
ˎˎ Во время фокусировки с использованием 

увеличенного изображения фокусировка 
регулируется в соответствии с положением, 

в котором производится увеличение области 
фокусировки.

[Примечания]
ˎˎ Функция Push Auto Focus не работает, если в 

объективе задана фокусировка вручную.
ˎˎ При использовании кнопки DISPLAY рамка области 

фокусировки не скрывается.

Фокусировка с использованием 
увеличенного изображения 
(Focus Magnifier)

По умолчанию функция Focus Magnifier 
×3/×6 задана кнопке ASSIGN 4, 
расположенной на пульте управления 
на рукоятке, и кнопке ASSIGN 10 на 
видоискателе (стр. 47).
Нажмите кнопку ASSIGN 4 или ASSIGN 10, 
чтобы переключиться на экран увеличения 
для фокусировки, на котором центр кадра 
увеличивается приблизительно в три 
раза. Нажмите эту кнопку еще раз, чтобы 
увеличить эту область приблизительно 
в шесть раз. Эта функция полезна для 
проверки фокуса.
Нажмите кнопку еще раз, чтобы вернуться к 
нормальному изображению.
Положение, в котором производится 
увеличение области фокусировки, 
можно перемещать с помощью 
кнопок со стрелками (стр. 7) или 
многофункционального селектора 
(стр. 9). Вернуться в центральное 
положение можно, нажав и 
удерживая кнопку SET (стр. 7) или 
многофункциональный селектор.
Если во время увеличения области 
фокусировки используется автоматическая 
фокусировка при нажатой кнопке (AF), 
фокусировка производится в пределах 
области фокусировки, заданной с помощью 

пункта Focus >Focus Area (стр. 87) в меню 
Shooting.
Если автоматическая фокусировка при 
нажатой кнопке (AF-S) используется во 
время увеличения области фокусировки, 
фокусировка регулируется в соответствии 
с положением, в котором производится 
увеличение области фокусировки.

[Примечания]
ˎˎ При увеличении области фокусировки 

записываемое изображение и изображение, 
передающееся на выход SDI/HDMI, не 
увеличиваются.
ˎˎ Во время увеличения области фокусировки кнопка 

STATUS и кнопка MENU не работают.
ˎˎ При выключении видеокамеры область 

увеличения возвращается в центр экрана.

Фокусировка с использованием 
обнаружения лиц и глаз (Face/
Eye Detection AF)

Видеокамера может обнаруживать лица и 
глаза людей и настраивать фокус на лица и 
глаза в пределах области фокусировки.
Эта функция доступна только при настройке 
фокусировки в режиме AF или во время 
автофокусировки при нажатой кнопке.
Если обнаружены лица, отображаются 
серые рамки обнаружения лица или 
глаз. Если возможна автоматическая 
фокусировка, цвет рамки изменяется 
на белый. Если обнаружены глаза и 
настраивается фокусировка, рамка 
обнаружения лица/глаз отображается 
на глазах. Если обнаружено несколько 
человек, главный объект определяется 
автоматически.
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[Советы]
ˎˎ Если задана область фокусировки Zone или 

Flexible Spot и лица или глаза перекрываются 
в указанной области фокусировки, цвет рамок 
обнаружения лиц/глаз изменяется на белый, и 
видеокамера фокусируется на эти лица или глаза.
ˎˎ Если используется функция автоматической 

фокусировки при нажатой кнопке (AF-S), цвет 
рамок обнаружения лиц/глаз, находящихся 
в фокусе, изменяется на зеленый.

Работа AF с обнаружением лиц/глаз 
задается с помощью пункта Focus >Face/Eye 
Detection AF (стр. 87) в меню Shooting.

Face/Eye Only AF:
Камера обнаруживает лица или глаза 
объектов (людей) и фокусируется только 
на их лицах или глазах. Если лицо или 
глаза не обнаружены, AF временно 
останавливается (MF) и отображается 
значок приостановленной автоматической 
фокусировки в режиме Face/Eye Only AF  
(стр. 11). Этот режим эффективен, если 
требуется автоматическая фокусировка 
только на лица или глаза.

Face/Eye Priority AF:
Камера обнаруживает лица или глаза 
объектов (людей) и устанавливает 
приоритет фокусировки на лица или глаза. 
Если лицо или глаза не обнаружены, 
фокусировка производится в режиме AF 
(настройка по умолчанию).

Off:
Функция автоматической фокусировки 
с обнаружением лиц или глаз отключена.

[Примечания]
ˎˎ Во время использовании автоматической 

фокусировки при нажатой кнопке включается 
режим Face/Eye Priority AF, даже если выбран 
режим Face/Eye Only AF.
ˎˎ Если переключатель FOCUS установлен 

в положение MAN, AF с обнаружением лиц/глаз 
отключена (кроме автоматической фокусировки 
при нажатой кнопке).

ˎˎ Если выключить видеокамеру, когда выбран 
режим Face/Eye Only AF, при следующем 
включении видеокамеры автоматически 
устанавливается режим Face/Eye Priority AF.

Скрытие рамок обнаружения лиц или 
глаз

Рамки обнаружения лиц или глаз можно 
отображать или скрывать с помощью 
пункта Display On/Off >Face/Eye Detection 
Frame (стр. 104) в меню Monitoring.

[Примечание]
Зеленые рамки обнаружения лиц или глаз 
отображаются для лиц и глаз, находящихся в фокусе 
при использовании автофокусировки при нажатой 
кнопке (AF-S), и они не скрываются с помощью 
кнопки DISPLAY или когда для пункта Face/Eye 
Detection Frame задано значение Off.

Фокусировка на зарегистрированное 
лицо

Во время работы автофокусировки 
с обнаружением лиц или глаз можно 
зарегистрировать лицо объекта (человека) 
для фокусировки на это лицо.
Можно зарегистрировать только одно 
лицо. При регистрации лица существующая 
регистрация стирается.
Когда лицо зарегистрировано, 
рамка обнаружения лиц или глаз 
изменяется на двойную рамку (рамку 
зарегистрированного лица) и отображается 
значок зарегистрированного лица  
(стр. 11).
В режиме AF с обнаружением лиц 
или глаз выполняются следующие 
действия в зависимости от сочетания 
зарегистрированного лица и режима 
работы AF с обнаружением лиц или глаз.

В режиме Face/Eye Priority AF:
Если камера обнаруживает 
зарегистрированное лицо, она 

фокусируется на это лицо. Если 
зарегистрированное лицо не обнаружено, 
включается автофокусировка 
с обнаружением лиц и глаз.

В режиме Face/Eye Only AF:
Если камера обнаруживает только 
зарегистрированное лицо, она 
фокусируется на это лицо или глаза. Если 
зарегистрированное лицо не обнаружено, 
AF временно останавливается (MF) и 
отображается значок приостановленной 
автоматической фокусировки в режиме 
Face/Eye Only AF  (стр. 11). Этот 
режим эффективен, если требуется 
автоматическая фокусировка только на 
зарегистрированного человека.

Задание зарегистрированного лица
С помощью кнопок со стрелками (стр. 7) 
или многофункционального селектора 
(стр. 9), переместите указатель выбора 
лица (оранжевое подчеркивание) на лицо, 
которое требуется зарегистрировать, 
и нажмите кнопку SET (стр. 7) или 
многофункциональный селектор.

Другие рамки 
обнаружения 
лиц (серые)

Рамка 
зарегистрированного 
лица/глаз (двойная 
белая рамка)

Курсор выбора 
лица (оранжевый)

Удаление зарегистрированного лица
С помощью кнопок со стрелками (стр. 7) 
или многофункционального селектора 
(стр. 9), переместите указатель выбора 

лица на рамку зарегистрированного лица 
и нажмите кнопку SET (стр. 7) или 
многофункциональный селектор.
Регистрация лица удаляется, рамка 
обнаружения лица/глаз изменяется 
на одинарную рамку, и значок 
зарегистрированного лица исчезает.
Если лица или глаза обнаружены, но 
рамка зарегистрированного лица не 
отображается, а отображается указатель 
(оранжевый) выбора лица, регистрацию 
лица можно удалить, дважды нажав кнопку 
SET или многофункциональный селектор.

[Примечания]
ˎˎ Лица и глаза могут не обнаруживаться 

в зависимости от условий съемки, состояния 
объекта или настроек.
ˎˎ В некоторых условиях съемки можно не получить 

нужного эффекта, или в качестве лиц будут 
обнаруживаться объекты, не являющиеся 
лицами. В таком случае задайте для функции AF 
с обнаружением лиц и глаз значение Off.
ˎˎ Рекомендуется регистрировать лицо человека, на 

которого требуется сфокусироваться, до начала 
съемки.
ˎˎ Лицо может не регистрироваться в зависимости 

от прически, наличия украшений на лице или в 
случае, если лицо не обращено непосредственно 
к камере. В таком случае рамка обнаружения 
лица или глаз может стать двойной, но значок 
зарегистрированного лица не отображается и 
лицо не регистрируется.
ˎˎ Если лицо уже было зарегистрировано, 

рекомендуется удалить существующее лицо и 
зарегистрировать его заново.

Переключение режима AF 
с обнаружением лиц и глаз 
с помощью программируемой кнопки

Назначьте функцию Face/Eye Detection 
AF программируемой кнопке (стр. 47). 
Затем режим функции AF с обнаружением 
лиц и глаз будет переключаться при 
каждом нажатии этой кнопки в следующем 
порядке: Face/Eye Priority AF, Face/Eye Only 
AF и Off.
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Настройка с помощью прямого меню

Режим работы функции AF с обнаружением 
лиц и глаз можно задавать также 
с помощью прямого меню (стр. 47).
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Яркость можно регулировать путем 
настройки диафрагмы, усиления, 
выдержки, а также уровня освещенности с 
помощью фильтров ND. Регулировку также 
можно выполнять автоматически.
Целевой уровень для автоматической 
регулировки яркости задается с помощью 
параметра Auto Exposure (стр. 83) 
>Level в меню Shooting. Функцию Auto 
Exposure Level также можно назначить 
программируемой кнопке (стр. 47).

[Примечание]
Усиления нельзя регулировать использовать 
в режиме Cine EI. Базовая чувствительность 
является фиксированной. Яркость также нельзя 
регулировать автоматически с помощью 
выдержки. Автоматическая регулировка яркости с 
использованием диафрагмы и фильтра нейтральной 
плотности поддерживается.

Выбор базовой 
чувствительности

В видеокамере можно выбрать один из 
двух типов базовой чувствительности.
В режиме SDR/HDR можно задать для 
пункта Base Sensitivity* в меню Shooting 
значение High или Low. В режиме Cine EI 
можно задать для пункта Base ISO* в меню 
Shooting значение ISO 4000 или ISO 800.
* Можно настроить также на экране состояния.

Для съемки с хорошим балансом, без 
повышенных шумов, выберите значение 
Low или ISO 800 в обычных условиях 
освещения или выбрав High или ISO 4000 
при недостаточной освещенности.

[Совет]
Функцию Base ISO/Sensitivity также можно назначить 
программируемой кнопке (стр. 47).

Регулировка диафрагмы

Можно настраивать диафрагму для 
регулировки яркости.

Автоматическая регулировка 
диафрагмы

Эта функция регулирует яркость в 
соответствии с объектом съемки. 
Требуется объектив, поддерживающий 
автоматическую диафрагму.

1 Если присоединен объектив с 
переключателем Auto Iris, переведите 
переключатель в положение AUTO.

2 Нажмите и удерживайте кнопку IRIS (F) 
для отображения прямого меню 
(стр. 47), затем выберите Auto.

 [Совет]
Функцию Auto Iris также можно назначить 
программируемой кнопке (стр. 47).

 [Примечание]
Диафрагму невозможно настроить 
автоматически на объективе с байонетом A.

Регулировка диафрагмы вручную

1 Нажмите и удерживайте кнопку 
функции IRIS (F) для отображения 
прямого меню (стр. 47), затем 
выберите Manual.

2 Нажмите кнопку функции IRIS (F), чтобы 
величина диафрагмы отображалась на 
белом фоне.

3 Настройте значение, поворачивая 
многофункциональный диск.

 [Советы]
ˎˎ Многофункциональный диск можно 

также использовать как диск IRIS 
(стр. 47), назначив функцию IRIS 
многофункциональному диску.
ˎˎ Функцию IRIS также можно назначить 

программируемому диску (стр. 47).

Временная регулировка 
в автоматическом режиме

Нажмите кнопку PUSH AUTO IRIS (E), чтобы 
видеокамера автоматически регулировала 
диафрагму, пока эта кнопка удерживается 
нажатой.
После того как кнопка будет отпущена, 
диафрагма вернется к ранее заданной 
установке.

[Совет]
Функцию Push Auto Iris также можно назначить 
программируемой кнопке (стр. 47).

[Примечание]
Если переключатель Auto Iris на объективе 
установлен в положение MANUAL, функции Auto 
Iris и Push Auto Iris на видеокамере не работают. 
Регулировка диафрагмы вручную на видеокамере 
также не приведет к каким-либо изменениям.

Регулировка усиления

В режиме SDR/HDR можно регулировать 
усиление для настройки яркости.

Автоматическая регулировка 
усиления

Нажмите и удерживайте кнопку функции 
ISO/GAIN (I) для отображения прямого 
меню (стр. 47), затем выберите Auto.

[Советы]
ˎˎ Это же действие можно выполнить, задав для 

пункта Auto Exposure (стр. 83) >AGC в меню 
Shooting значение On.
ˎˎ Функцию AGC также можно назначить 

программируемой кнопке (стр. 47).

Регулировка усиления вручную

Управлять усилением можно, когда 
требуется отрегулировать экспозицию 
при использовании фиксированного 
значения диафрагмы, либо если вы хотите 
воспрепятствовать увеличению усиления 
из-за AGC.

1 Нажмите и удерживайте кнопку 
функции ISO/GAIN (I) для отображения 
прямого меню (стр. 47), затем 
выберите Manual.

2 Установите переключатель ISO/GAIN (J) 
в положение H, M или L.

Регулировка яркости
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[Совет]
Можно также назначить функцию Push AGC 
программируемой кнопке и временно включать AGC, 
нажимая эту кнопку и удерживая ее нажатой.

Управление усилением (точная 
регулировка)

1 Нажмите кнопку функции ISO/GAIN (I), 
чтобы величина усиления 
отображалась на белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Совет]
Измените предустановленное значение усиления 
в соответствии с настройкой переключателя ISO/
GAIN (J).

Временное управление усилением 
(точная регулировка)

Поворачивайте программируемый диск 
(стр. 47), которому назначена функция 
ISO/Gain/EI, чтобы отрегулировать значение 
усиления, заданное переключателем ISO/
GAIN (J).
Это полезно, когда требуется 
отрегулировать экспозицию по одному 
шагу, не меняя глубину поля.
Регулировка значения усиления отменяется 
изменением положения переключателя 
ISO/GAIN (J), изменением базовой 
чувствительности, включением функции 
AGC или выключением питания.

[Совет]
Можно также назначить эту функцию 
многофункциональному диску (стр. 47).

Регулировка индекса 
экспозиции

В режиме Cine EI предполагается, что 
видеовыход, параметру MLUT которого 
задано значение Off, записывается 
как основной сигнал. Изменив яркость 
изображения когда параметру MLUT задано 
значение On, в соответствии со значением 
EI, можно во время съемки проверить 
результат регулировки чувствительности 
экспозиции при работе с отснятым 
материалом в студии.
Для изменения значения EI необходимо 
установить переключатель ISO/GAIN (J) 
в положение H, M или L.

[Совет]
Изменить значение EI, заданное каждому положению 
переключателя, можно с помощью пунктов ISO/Gain/
EI >Exposure Index<H>/<M>/<L> (стр. 82) в меню 
Shooting или с помощью экрана Camera Status 
(стр. 14).

Точная регулировка индекса 
экспозиции

1 Нажмите кнопку функции ISO/GAIN (I), 
чтобы значение EI отобразилось на 
белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Совет]
Измените предустановленное значение EI 
в соответствии с настройкой переключателя ISO/
GAIN (J).

Регулировка выдержки

Можно регулировать выдержку для 
настройки яркости.

Автоматическая регулировка 
выдержки

Нажмите и удерживайте кнопку функции 
SHUTTER (G) для отображения прямого 
меню (стр. 47), затем выберите Auto для 
автоматической регулировки выдержки 
или угла затвора в соответствии с яркостью 
изображения.

[Совет]
Это же действие можно выполнить, задав для пункта 
Auto Exposure (стр. 84) >Auto Shutter в меню 
Shooting значение On.

Регулировка выдержки вручную

1 Нажмите и удерживайте кнопку 
функции SHUTTER (G) для отображения 
прямого меню (стр. 47), затем 
выберите Speed или Angle.

2 Нажмите кнопку функции SHUTTER (G), 
чтобы значение выдержки 
отобразилось на белом фоне.

3 Настройте выдержку, поворачивая 
многофункциональный диск.

[Советы]
ˎˎ Для настройки времени экспозиции в соответствии 

с интервалом между кадрами выберите значение 
Off на шаге 1.
ˎˎ Также можно задать угол и отрегулировать частоту 

(стр. 82).

Регулировка уровня 
освещенности (фильтр ND)

Когда освещенность слишком яркая, ее 
уровень можно понизить с помощью 
фильтра ND.
В видеокамере предусмотрено два 
режима фильтра нейтральной плотности. 
Между этими двумя режимами можно 
переключаться с помощью переключателя 
ND PRESET/VARIABLE.

Настройка в предустановленном 
режиме

Установите переключатель ND PRESET/
VARIABLE (A) в положение PRESET и 
установите кнопки вверх/вниз ND FILTER 
POSITION (B) на одну из следующих 
настроек.
Clear: фильтр ND не используется
1: Коэффициент пропускания задается 
настройкой ND Filter >Preset1 (стр. 82) в 
меню Shooting.
2: Коэффициент пропускания задается 
настройкой ND Filter >Preset2 (стр. 82) в 
меню Shooting.
3: Коэффициент пропускания задается 
настройкой ND Filter >Preset3 (стр. 82) в 
меню Shooting.

Настройка в переменном режиме

Установите переключатель ND PRESET/
VARIABLE (A) в положение VARIABLE. 
Переключайте кнопки вверх/вниз ND FILTER 
POSITION (B) между положениями CLEAR и 
On.
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Автоматическая регулировка уровня 
освещенности
Можно задать для параметра Auto ND 
Filter значение On, чтобы включить 
автоматическую регулировку экспозиции с 
помощью фильтра нейтральной плотности.

1 Нажмите кнопку [+] кнопки вверх/вниз 
ND FILTER POSITION (B), чтобы включить 
фильтр ND.

2 Нажмите и удерживайте кнопку ND 
VARIABLE AUTO (C), пока не будет 
выбран вариант Auto.

Регулировка уровня освещенности 
вручную

1 Нажмите кнопку [+] кнопки вверх/вниз 
ND FILTER POSITION (B), чтобы включить 
фильтр ND.

2 Нажмите и удерживайте кнопку ND 
VARIABLE AUTO (C), пока не будет 
выбран вариант Manual.

3 Поворачивайте диск ND VARIABLE (D) 
для настройки коэффициента 
пропускания фильтра.

[Совет]
Функцию ND Filter также можно назначить 
программируемому диску (стр. 47).

Временная регулировка в автоматическом 
режиме
Можно назначить функцию Push Auto 
ND программируемой кнопке (стр. 47) 
и временно задавать для параметра 
Auto ND Filter значение On, нажимая и 
удерживая эту кнопку. При отпускании 
кнопки для параметра Auto ND Filter снова 
устанавливается значение Off.

Нажмите кнопку [+] кнопки вверх/вниз ND 
FILTER POSITION (B), чтобы включить фильтр 
ND.

[Примечание]
При переключении фильтра ND на значение 
CLEAR или из этого значения во время съемки на 
изображении отображается рамка фильтра ND и звук 
срабатывания записывается на звуковую дорожку.

[Советы]
ˎˎ Чтобы задать значение CLEAR, когда фильтру 

задано значение ND1/4, необходимо повернуть 
диск ND VARIABLE (D) вниз. Поворот диска вверх, 
когда фильтру задано значение CLEAR, задает ему 
значение ND1/4. Это действие можно отменить 
с помощью пункта ND Dial >CLEAR with Dial 
(стр. 112) в меню Technical.
ˎˎ Можно также назначить функцию ND Filter Position 

программируемой кнопке (стр. 47), и нажимать 
эту кнопку для изменения настройки вместо 
использования кнопок вверх/вниз ND FILTER 
POSITION.  
Предустановленный режим: Clear  Preset1  
Preset2  Preset3  Clear… 
Переменный режим: Clear  On  Clear…
ˎˎ Можно также назначить функцию Auto ND Filter 

программируемой кнопке (стр. 47), и нажимать 
эту кнопку для выключения функции Auto ND Filter.
ˎˎ Если при съемке ярко освещенного объекта 

слишком сильно закрыть диафрагму, может 
возникнуть дифракционное размытие, в 
результате чего изображение начнет выходить 
из фокуса (типичное явление в видеокамерах). С 
помощью диска фильтр ND можно подавить это 
явление для улучшения результатов съемки.
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Обеспечение естественных цветов (баланс белого)
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Режим регулировки можно выбрать, исходя 
из условий съемки.

ATW (автоматическое 
отслеживание баланса белого)

Эта функция автоматически подбирается 
подходящий уровень баланса белого.
Баланс белого автоматически регулируется 
при изменении цветовой температуры 
источника света.
Нажмите и удерживайте кнопку функции 
WHT BAL (H) для отображения прямого 
меню (стр. 47), затем выберите ATW.
Скорость регулировки можно изменять 
(есть пять значений) с помощью пункта 
White Setting >ATW Speed (стр. 86) из 
меню Shooting.

[Совет]
Можно зафиксировать текущее значение баланса 
белого, назначив функцию ATW Hold одной из 
программируемых кнопок (стр. 47) и нажав 
соответствующую кнопку, чтобы приостановить 
работу режима ATW.

[Примечания]
ˎˎ ATW невозможно использовать в режиме Cine EI.
ˎˎ Обеспечить запись правильных цветов с помощью 

функции ATW не всегда возможно. Это зависит от 
условий освещенности и объекта съемки. 
Примеры приведены ниже.
 – Когда в объекте съемки, например небе, море, 

земле или цветах, имеется один доминирующий 
цвет.

 – Когда цветовая температура чрезвычайно 
высокая или низкая.

 Если нужного эффекта не удается добиться из-за 
того, что скорость автоматического отслеживания 
функции ATW слишком медленная или по 
другим причинам, используйте автоматическую 
регулировку баланса белого.

Регулировка баланса белого 
вручную

1 Когда для баланса белого задан режим 
ATW, нажмите и удерживайте кнопку 
функции WHT BAL (H) для отображения 
прямого меню (стр. 47), затем 
выберите Manual.

2 С помощью переключателя WHT BAL (K) 
выберите значение B, A или PRESET.
B: режим из ячейки памяти B
A: режим из ячейки памяти A
PRESET: режим предустановки

[Совет]
Режим ATW можно включить для ячейки памяти 
B, задав в пункте White Setting >White Switch<B> 
(стр. 86) в меню Shooting значение ATW.

Режим из ячейки памяти A/B
Этот режим задает балансу белого 
настройку, сохраненную в ячейке памяти A 
или B соответственно.

Режим предустановки
В этом режиме цветовой температуре 
устанавливается заранее заданное 
значение (по умолчанию это 3200K).

Изменение предустановленного 
значения по умолчанию

В режиме предустановки действующее 
предустановленное значение можно 
изменять напрямую.
Нажмите и удерживайте кнопку функции 
WHT BAL (H) и выберите в прямом меню 
один из следующих функций.
Режим SDR/HDR: ˎ3200K, ˎ4300K, ˎ

5600K, ˎ6300K
Режим Cine EI: ˎ3200K, ˎ4300K, ˎ

5500K

[Совет]
Можно также назначить функцию Preset White Select 
программируемой кнопке (стр. 47) и нажимать эту 
кнопку для изменения настройки.
Режим SDR/HDR: 3200K  4300K  5600K  6300K 
 3200K…

Режим Cine EI: 3200K  4300K  5500K  3200K…

Изменение цветовой температуры

1 Нажмите кнопку функции WHT BAL (H), 
чтобы значение цветовой температуры 
отображалось на белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Советы]
ˎˎ В режиме предустановки можно задавать 

значение в единицах 100K.
ˎˎ В режиме памяти можно задавать значение в 

единицах 20K. Можно также настроить значение 
оттенка с помощью пункта White (стр. 85) >Tint в 
меню Shooting.

Выполнение автоматической 
регулировки баланса белого

Баланс белого, сохраняемый в ячейки 
памяти A/B, настраивается автоматически.

1 Выберите режим из ячейки памяти A 
или режим из ячейки памяти B.

2 Поместите лист белой бумаги (или 
другой предмет) в место, в котором 
имеются такой же источник и такие же 
условия освещения, как у объекта 
съемки, затем увеличьте масштаб и 
заполните белым весь экран.

3 Отрегулируйте яркость.
Отрегулируйте диафрагму, выполнив 
процедуру, которая описана в разделе 
“Регулировка диафрагмы вручную” 
(стр. 41).

4 Нажмите кнопку WB SET (стр. 4).
ˎˎ Если автоматический баланс белого 
выполняется в режиме ячейки памяти, 
то заданное в результате регулировки 
значение будет сохранено в ячейке 
памяти (A или B), выбранной в шаге 1.
ˎˎ Если автоматический баланс белого 
выполняется в режиме ATW, то по 
окончании регулировки баланс 
белого возвращается к значению, 
установленному в режиме ATW.

[Примечание]
Если регулировка завершится неудачно, на экране 
будет примерно в течение трех секунд отображаться 
сообщение об ошибке. Если после повторных 
попыток настроить баланс белого сообщение 
об ошибке появляется снова, обратитесь к 
представителю службы технического обслуживания 
компании Sony.
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Записываемый звук настраивается 
с помощью входных разъемов, 
переключателей и дисков видеокамеры.

Входные разъемы для внешнего 
аудиосигнала и селекторные 
переключатели

Разъем INPUT1 (стр. 8)
Разъем INPUT2 (стр. 8)
Многоцелевой разъем (стр. 4)
Переключатель выбора CH1 INPUT 
(стр. 7)
Переключатель выбора CH2 INPUT 
(стр. 7)
Переключатель INPUT1 (LINE/MIC/MIC+48V) 
(стр. 4)
Переключатель INPUT2 (LINE/MIC/MIC+48V) 
(стр. 4)

Переключатели для задания уровня 
звука

Переключатель CH1 (AUTO/MAN) (стр. 7)
Переключатель CH2 (AUTO/MAN) (стр. 7)
Диск AUDIO LEVEL (CH1) (стр. 7)
Диск AUDIO LEVEL (CH2) (стр. 7)
Диск AUDIO LEVEL (CH3) (стр. 7)
Диск AUDIO LEVEL (CH4) (стр. 7)

Выбор устройства, подающего 
входной аудиосигнал

1 Выберите входной аудиоразъем.
Для CH1/CH2 выберите аудиовход 
с помощью переключателя выбора CH1 
INPUT или переключателя выбора CH2 
INPUT.
Задайте значение EXT, чтобы 
использовать разъем INPUT1 или 
разъем INPUT2.
Если используется микрофон, адаптер 
XLR, устройство UWP (беспроводной 
микрофон УВЧ) или портативный 
беспроводной тюнер, установленные 
на многоцелевой разъем, аналогичным 
образом укажите MI SHOE. Подробную 
информацию об адаптере XLR см. в 
разделе “Добавление входных 
аудиоразъемов” (стр. 46).
Подробную информацию о 
портативном беспроводном тюнере см. 
в разделе “Использование 
портативного беспроводного тюнера” 
(стр. 46).
Для CH3/CH4 выберите аудиовход 
с помощью пунктов Audio Input >CH3 
Input Select* (стр. 107) и CH4 Input 
Select* (стр. 107) в меню Audio.
* Можно настроить также на экране состояния.

 [Совет]
Для CH2 можно также выбрать INPUT1 с помощью 
пункта Audio Input >CH2 EXT Input Select* 
(стр. 107) в меню Audio.
* Можно настроить также на экране состояния.

 [Примечание]
Видеокамера оснащена встроенным 
микрофоном для записи окружающих звуков. 
Он может использоваться для синхронизации 
времени с другим оборудованием. В этом случае 
задайте INT или Internal MIC.

2 Выберите источник входного 
аудиосигнала.
Переключатели INPUT1/INPUT2 (LINE/
MIC/MIC+48V) относятся к устройствам, 
подключенным к разъемам INPUT1/
INPUT2 соответственно.

Подключенное 
устройство

Положение 
переключателя

Внешний источник 
аудиосигнала (например, 
микшер)

LINE

Динамический 
микрофон, беспроводной 
микрофон

MIC

Микрофон с фантомным 
питанием +48 В

MIC+48V

ˎˎ Если выбрать MIC+48V и подключить 
микрофон, который несовместим с 
источником +48В, это может привести 
к повреждению подключенного 
устройства. Проверьте настройку 
перед подключением устройства.
ˎˎ Если беспокоит шум на разъемах, к 
которым не подключены устройства, 
установите соответствующие 
переключатели INPUT1/INPUT2 (LINE/
MIC/MIC+48V) в положение LINE.

Автоматическая регулировка 
уровня записи звука

Переключатели CH1/CH2 (AUTO/MAN) 
для каналов, регулировка которых будет 
производиться автоматически, необходимо 
установить в положение AUTO.
Для CH3/CH4 установите для параметров 
Audio Input >CH3 Level Control* и CH4 Level 
Control* в меню Audio значение Auto 
(стр. 107).

* Можно настроить также на экране состояния.

Регулировка уровня записи 
звука вручную

Для регулировки уровня записи звука 
каналов CH1/CH2 используется следующая 
процедура.

1 Переключатели CH1/CH2 (AUTO/MAN) 
для каналов, регулировка которых 
будет производиться вручную, 
установите в положение MAN.

2 Во время съемки или в режиме 
ожидания регулировка уровня звука 
производится дисками AUDIO LEVEL 
(CH1)/(CH2) соответствующих каналов.
ˎˎ Для CH3/CH4 установите для 
параметров Audio Input >CH3 Level 
Control* и CH4 Level Control* в меню 
Audio значением Manual, затем 
установите уровень записи звука 
дисками AUDIO LEVEL(CH3)/(CH4).
ˎˎ Можно настроить уровень для 
каналов с CH1 по CH4 в качестве 
группы. Регулировать уровень записи 
можно с помощью программируемого 
диска (стр. 47) которому назначена 
функция Audio Input Level, либо 
с помощью пункта Audio Input >Audio 
Input Level* в меню Audio.

* Можно настроить также на экране состояния.

[Совет]
На экране Audio Status удобно проверять входной 
уровень звука (стр. 14).

[Примечания]
ˎˎ Параметры Audio Input Level могут быть отключены 

в зависимости от настроек, заданных в меню 
Audio. Подробные сведения см. на диаграмме, 
приведенной на стр. 146.

Настройка записываемого звука
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ˎˎ Если переключатель выбора CH1 INPUT или 
CH2 INPUT установлен в положение INT, CH2 
переключается в автоматический/ручной режим 
вместе с переключателем CH1 (AUTO/MAN). Кроме 
того, уровень записи звука CH2 устанавливается в 
соответствии с диском AUDIO LEVEL (CH1).
ˎˎ Видеокамера поддерживает сочетания различных 

настроек. Подробные сведения см. на диаграмме, 
приведенной на стр. 146.

Добавление входных 
аудиоразъемов

К видеокамере можно подключить до 
четырех каналов аудиоустройств XLR 
одновременно с помощью адаптера 
XLR-K2M XLR (не входит в комплект 
поставки) или адаптера XLR-K3M XLR (не 
входит в комплект поставки).
Присоедините адаптер XLR 
к многоцелевому разъему и установите для 
параметра Audio Input >CH3 Input Select* 
значение Shoe CH1 и для параметра CH4 
Input Select* значение Shoe CH2 в меню 
Audio.
Для каналов, в которых в качестве входа 
выбран адаптер XLR, накладывающиеся 
функции видеокамеры будут отключены. 
Для регулировки используйте 
переключатели и диски на адаптере XLR.
* Можно настроить также на экране состояния.

[Примечания]
ˎˎ Видеокамера поддерживает цифровой 

аудиоинтерфейс XLR-K3M.
ˎˎ Если для параметров Audio Input >CH3 Level и 

CH4 Level установлено значение Audio Input 
Level в меню Audio, значение Audio Input Level 
видеокамеры будет соответствовать уровню, 
настроенному на адаптере XLR.  
Функция Audio Input Level также включается, 
когда переключатель XLR-адаптера установлен в 
положение AUTO.  
Когда указано значение “Through”, звук будет 
записываться с уровнем, настроенным на 
адаптере XLR (стр. 147).

ˎˎ Чтобы подключить к видеокамере адаптер 
XLR-K2M XLR (не входит в комплект поставки) или 
XLR-K3M XLR (не входит в комплект поставки), 
снимите с нее держатель микрофона.

Использование портативного 
беспроводного тюнера

Требуется устройство расширения 
XDCA-FX9 (приобретается дополнительно). 
Подробное описание процедуры 
присоединения устройства XDCA-FX9 см. на 
стр. 26.
При портативном беспроводном тюнере, 
подключенном к XDCA-FX9, в меню Audio 
выберите параметр Audio Input (стр. 107) 
>CH1 MI SHOE Input Select*, CH2 MI SHOE 
Input Select*, CH3 Input Select* или CH4 
Input Select* и установите его значение на 
Wireless.
* Можно настроить также на экране состояния.
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Использование прямого меню

Можно проверять состояние и настройки 
видеокамеры, отображаемые на экране 
видоискателя, и напрямую выбирать и 
изменять настройки.
Можно настроить указанные ниже пункты.
ˎˎ Face/Eye Detection AF
ˎˎ Steady Shot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1 Нажмите многофункциональный диск 
или программируемую кнопку, которой 
назначена функция Direct Menu.
Только элементы, которые допускают 
настройку с помощью прямого меню, 
можно выбрать на экране с помощью 
оранжевого курсора.

2 Многофункциональным диском 
переместите курсор на нужный пункт 
меню, затем нажмите диск 
многофункциональный диск.
Открывается меню, или пункт 
отображается на белом фоне.

3 Поворачивая многофункциональный 
диск, выберите настройку, затем 
нажмите многофункциональный диск.
Меню или белый фон исчезает, и на 
экране появляется новая настройка 
с оранжевым курсором.
Чтобы закрыть Direct Menu, снова 
нажмите программируемую кнопку, 
которой назначен вызов Direct Menu, 
или подождите 3 секунды, не выполняя 
никаких действий.

 [Советы]
ˎˎ Прямые настройки можно также задавать, 

нажимая и удерживая каждую из кнопок 
функций (стр. 6).
ˎˎ Когда пункты отображаются на белом 

фоне, многофункциональный диск может 
использоваться как программируемый диск.
ˎˎ Многофункциональный селектор (стр. 9) 

также можно использовать для операций 
выбора.

Программируемые кнопки/
диски

На видеокамере есть десять 
программируемых кнопок (стр. 6, 9), 
которым можно назначать функции.
Можно также назначить функции 
программируемому диску (стр. 9), 
расположенному на пульте управления на 
рукоятке, и многофункциональному диску 
на видеокамере.

Изменение функции кнопки

Для этого служит пункт Assignable Button 
(стр. 93) в меню Project.
Просмотреть функции, назначенные 
программируемым дискам, можно на 
экране Assignable Button Status (стр. 15).

По умолчанию программируемым кнопкам 
назначены функции
Кнопка 1 S&Q Motion
Кнопка 2 Off
Кнопка 3 Off
Кнопка 4 Focus Magnifier x3/x6
Кнопка 5 Direct Menu
Кнопка 6 Off
Кнопка 7 Off
Кнопка 8 Off
Кнопка 9 Off
Кнопка 10 Focus Magnifier x3/x6
Кнопка Focus Hold Focus Hold

Функции, которые можно назначить
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Last Clip Del.
ˎˎ Shot Mark1
ˎˎ Shot Mark2
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Network Client Mode
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Изменение функции диска

Можно изменить функцию 
многофункционального диска на 
видеокамере и программируемого диска 
на пульте управления на рукоятке.
Для многофункционального диска 
используйте пункт Multi Function Dial 
(стр. 96) > Default Function в меню Project.
По умолчанию назначено значение Off.

Полезные функции
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Функции, которые можно назначить 
многофункциональному диску
ˎˎ Off
ˎˎ IRIS
ˎˎ ISO/Gain/EI
ˎˎ Audio Input Level

[Примечание]
Настройка отображается, пока меню находится на 
экране.

Для программируемого диска используйте 
пункт Assignable Dial (стр. 96) в меню 
Project.
Диск IRIS имеет назначенную по умолчанию 
функцию.

Функции, которые можно назначить 
программируемому диску
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Audio Input Level

Просмотреть функции, назначенные 
программируемым дискам, можно на 
экране Assignable Button Status (стр. 15).

Съемка с замедлением/ускорением движения

Если для формата записи (стр. 90) задано одно из следующих значений, можно 
установить разную частоту кадров записи и частоту кадров воспроизведения.

Формат записи Частота кадров

Частота системы Режим Imager 
Scan Mode

Codec Формат видео

59.94/50 FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 
180*1

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

29.97/25/23.98 FF 6K XAVC-I 4096×2160P 1-30

3840×2160P 1–30

1920×1080P 1–30

XAVC-L 3840×2160P 1–30

1920×1080P 1–30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 
180*2

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF 6K XAVC-I 4096×2160P 1-30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

*1 Можно выбрать при частоте системы 59.94.
*2 Можно выбрать при частоте системы 29.97/23.98.



3. Съемка: Полезные функции49

Формат записи Частота кадров

Частота системы Режим Imager 
Scan Mode

Codec Формат RAW

59.94/50 FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/
RAW&XAVC-I*3

2048×1080 1–60, 100, 120, 150, 
180*1

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

29.97/25/23.98 FF 6K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–30

FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/
RAW&XAVC-I*3

2048×1080 1–60, 100, 120, 150, 
180*2

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

24 FF 6K RAW 4096×2160 1–30

FFcrop 5K/S35 4K RAW 4096×2160 1–60

*1 Можно выбрать при частоте системы 59.94.
*2 Можно выбрать при частоте системы 29.97/23.98.

*3 Видеоформат становится 1920×1080.

Режим Slow & Quick Motion можно включать 
и выключать, нажимая программируемую 
кнопку (стр. 47), которой назначена 
функция S&Q Motion.
Частоту кадров для съемки можно задать, 
нажав и удерживая эту кнопку.

[Примечания]
ˎˎ Режим с замедлением/ускорением движения 

нельзя задать во время записи, воспроизведения, 
либо когда отображается экран эскизов.
ˎˎ В режиме с замедлением/ускорением движения 

запись звука не поддерживается.
ˎˎ Функция автоматической фокусировки, функция 

автоматической регулировки диафрагмы и 
функция автоматического управления затвором 
отключаются в режиме с замедлением/
ускорением движения.
ˎˎ Подробную информацию об использовании 

выхода RAW см. на стр. 56.

Запись видео с промежутками 
(Interval Rec)

С помощью функции Interval Rec 
видеокамеры можно записывать видео с 
заданной длительностью во внутреннюю 
память видеокамеры. Эта функция 
обеспечивает эффективный способ съемки 
медленно движущихся объектов.
При начале записи видеокамера 
автоматически записывает заданное 
количество кадров (Number of Frames) 
через указанный временной интервал 
(Interval Time).

Интервал съемки (Interval Time)

Количество кадров в одном дубле
(Number of Frames)

Когда функция Interval Rec включена, 
лампа для видеосъемки HVL-LBPC 
(приобретается дополнительно) включается 
автоматически перед началом съемки, что 
дает возможность снимать при стабильном 
освещении и цветовой температуре 
(функция предварительного освещения).

[Примечания]
ˎˎ Одновременно можно использовать только одну 

функцию записи в особом режиме, например 
Interval Rec.
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ˎˎ При включении другого особого режима записи в 
то время, когда используется функция Interval Rec, 
она будет автоматически отключена.
ˎˎ Работа в режиме Interval Rec автоматически 

завершается после изменения таких системных 
настроек, как формат видео.
ˎˎ Настройки функции Interval Rec нельзя изменить 

во время съемки или воспроизведения, либо, 
когда отображается экран эскизов.

Настройка функции Interval Rec

Задайте параметру Interval Rec (стр. 92) 
>Setting в меню Project значение On, а 
также задайте значения параметрам 
Number of Frames и Interval Time.
При использовании лампы для 
видеосъемки HVL-LBPC (приобретается 
дополнительно) с помощью параметра 
Interval Rec >Pre-Lighting в меню Project 
задайте необходимый временной интервал 
включения лампы для видеосъемки перед 
началом съемки.

[Примечания]
ˎˎ Если требуется, чтобы лампа для видеосъемки 

включилась перед началом съемки, переведите 
переключатель лампы для видеосъемки в 
положение AUTO. Лампа для видеосъемки 
включается и выключается автоматически в 
соответствии со значением параметра Video Light 
Set (стр. 114), заданным в меню Technical.
ˎˎ Если перевести переключатель лампы для 

видеосъемки в положение ON, лампа будет гореть 
всегда (она не будет включаться и выключаться 
автоматически).
ˎˎ Если лампа для видеосъемки настроена таким 

образом, что она выключается на 5 секунд или 
менее, она не будет выключаться.

Видеокамера выходит из режима Interval 
Rec при отключении питания, но при этом 
значения параметров Number of Frames, 
Interval Time и Pre-lighting сохраняются. 
Их не нужно будет снова задавать в 
следующий раз при использовании режима 
Interval Rec.

Съемка в режиме Interval Rec

Нажмите кнопку START/STOP (пуск/
остановка записи), чтобы начать 
съемку. В видоискателе попеременно 
отображаются надписи “Int Rec” и “Int 
Stby”.
При использовании функции 
предварительного освещения лампа для 
видеосъемки включится перед началом 
съемки.

Остановка съемки

Остановите съемку.
Когда съемка завершается, видеоданные, 
которые были сохранены в памяти вплоть 
до этого момента, записываются на 
носитель.

Выход из режима Interval Rec

Выполните одно из следующих действий.
ˎˎ Переведите переключатель POWER в 
положение Off.
ˎˎ В режиме ожидания записи задайте 
параметру Interval Rec >Setting в меню 
Project значение Off.

Кроме того, работа в режиме Interval 
Rec автоматически завершается при 
перезапуске видеокамеры.

Ограничения во время записи

ˎˎ Звук не записывается.
ˎˎ Просмотр записи (Rec Review) 
невозможен.
ˎˎ Внешняя синхронизация не применяется.

Если видеокамера выключается во 
время записи

ˎˎ Если переключатель POWER 
видеокамеры переводится в положение 

Off, видеокамеры обращается к носителю 
на несколько секунд, чтобы записать на 
него изображения, сохраненные в памяти 
вплоть до этого момента, после чего 
питание автоматически выключается.
ˎˎ Если подача питания прекращается из-за 
извлечения аккумулятора, отсоединения 
шнура питания постоянного тока либо 
отключения подачи питания от адаптера 
переменного тока, видео- и аудиоданные, 
снятые до этого момента, могут быть 
потеряны (максимум 10 секунд). При 
замене аккумулятора следует соблюдать 
осторожность.

Запись кэшированных 
изображений (Picture Cache Rec)

Функция Picture Cache Rec позволяет 
записывать видео задним числом при 
начале записи, после чего записывать 
его на карты памяти XQD, поддерживая 
внутреннюю кэш-память заданной 
продолжительности при съемке. Задайте 
для параметра Picture Cache Rec >Setting* 
(стр. 93) в меню Project значение 
On. Время записи в кэш изображения 
устанавливается при помощи команд 
Picture Cache Rec >Cache Rec Time 
(стр. 93) в меню Project.
* Можно настроить также на экране состояния.

Поддерживаемые форматы записи

Codec Формат 
видео

Частота 
системы

Время 
записи в 
кэш [с]

XAVC-I 4096×2160P 59.94 0–4 с

50

29.97

25 0–4/ 
4–8 с23.98

24

3840×2160P 59.94 0–4 с

50

29.97

25 0–4/ 
4–8 с23.98

1920×1080P 59.94 0–4/ 
4–8 с50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 с

25

23.98 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

1920×1080i 59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20 с

1920×1080i 50 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 с
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Codec Формат 
видео

Частота 
системы

Время 
записи в 
кэш [с]

XAVC-L 3840×2160P 59.94 0–4/ 
4–8/ 
8–12/ 
12–16 с

50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

25

23.98

1920×1080P 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

29.97

25

23.98

1920×1080P 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

29.97

25

23.98

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

1920×1080i 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

Codec Формат 
видео

Частота 
системы

Время 
записи в 
кэш [с]

XAVC-L 1920×1080i 
25

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

MPEG 
HD422

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 с

50

29.97

25

23.98

[Примечания]
ˎˎ Функция Picture Cache Rec не может быть 

включена (On) одновременно с функцией Interval 
Rec или Slow & Quick Motion. Когда функция 
Picture Cache Rec включена (On), остальные 
перечисленные режимы записи принудительно 
отключаются (Off).
ˎˎ Режим Picture Cache Rec нельзя выбрать во время 

записи, либо когда выполняется функция Rec 
Review.
ˎˎ Когда функция Picture Cache Rec включена (On), 

временной код записывается в режиме Free Run 
независимо от значения, заданного в меню TC/
Media (стр. 102).
ˎˎ Иногда задать значение параметра Output Format 

в режиме Picture Cache Rec бывает невозможно. В 
этом случае временно задайте параметру Picture 
Cache Rec значение Off, после чего измените эту 
настройку.

Настройка перед съемкой

Настройте функцию с помощью пункта 
Picture Cache Rec (стр. 93) из меню Project 
перед съемкой.
Функцию Picture Cache Rec также можно 
назначить программируемой кнопке 
(стр. 47), после чего можно будет с 
помощью этой кнопки переключаться 

между значениями On и Off параметра 
Picture Cache Rec >Setting.
Когда функция включена, в видоискателе 
отображается индикатор “” ( зеленый).

Запуск записи кэша изображения

При нажатии кнопки START/STOP (пуск/
остановка записи) запись запускается, и 
видео записывается на карты памяти XQD, 
начиная с видео, которое хранится в кэш-
памяти.

Отмена функции Picture Cache Rec

Установите для пункта Picture Cache Rec 
>Setting в меню Project значение Off или 
нажмите программируемую кнопку, 
которой назначена функция Picture Cache 
Rec.

[Примечания]
ˎˎ При изменении формата записи видео, 

хранящиеся в кэш-памяти, удаляется, и 
кэширование начинается заново. Соответственно, 
запись картинки в кэш изображения перед 
изменением формата невозможна, даже если 
начать запись сразу же после смены формата.
ˎˎ Если для функции Picture Cache Rec задано 

значение On или Off сразу же после установки 
карты памяти XQD, данные из кэша нельзя будет 
записывать на карту.
ˎˎ Видео сохраняется в кэш-памяти, когда 

функция Picture Cache Rec включена (On). Видео, 
записываемое до включения этой функции, не 
кэшируется.
ˎˎ Во время доступа к карте памяти XQD, например 

при воспроизведении, работе функции Rec Review 
или при отображении экрана эскизов, видео в 
кэш-память не сохраняется. Запись видео в кэш 
изображения в это время невозможна.

Одновременная запись на 
карты памяти A и B (2-slot Simul 
Rec)

Можно одновременно записывать на карты 
памяти A и B, задав для параметра Simul 
Rec >Setting* в меню Project значение On.
* Можно настроить также на экране состояния.

[Примечание]
Одновременная запись не поддерживается в режиме 
с замедлением/ускорением движения (стр. 87) 
или в режиме Picture Cache Rec (стр. 93). Кроме 
того, одновременная запись не поддерживается для 
следующих форматов записи (стр. 90).

XAVC-I
Формат видео
4096×2160P, 3840×2160P

XAVC-L
Формат видео
4096×2160P, 3840×2160P

Изменение настроек кнопок 
записи START/STOP, 
находящихся на видеокамере и 
рукоятке

Когда включена функция одновременной 
записи (Simul Rec), запускать и 
останавливать запись можно будет для 
каждой карты памяти отдельно с помощью 
кнопок записи START/STOP, расположенных 
на видеокамере и рукоятке.
По умолчанию обе кнопки настроены 
запускать и останавливать одновременную 
запись на обе карты памяти (A и B).
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ˎˎ “Rec Button [SlotA SlotB] Handle Rec Button 
[SlotA SlotB]”

Когда кнопки настраиваются для 
управления записью на различные карты 
памяти, параметр SDI/HDMI Rec Control 
следует за состоянием записи гнезда A.

Изменение настройки

Выберите пункт Simul Rec >Rec Button Set в 
меню Project.

Rec Button Set Кнопки и карты 
памяти

“Rec Button [SlotA 
SlotB] Handle Rec 
Button [SlotA SlotB]”

Запуск/остановка 
одновременной 
записи на карты 
памяти A и B с 
помощью любой из 
двух кнопок.

“Rec Button [SlotA] 
Handle Rec Button 
[SlotB]”

Кнопка START/STOP 
записи запускает/
останавливает запись 
на карту памяти A, а 
кнопка START/STOP 
записи на рукоятке 
запускает/
останавливает запись 
на карту памяти B.

“Rec Button [SlotB] 
Handle Rec Button 
[SlotA]”

Кнопка START/STOP 
записи запускает/
останавливает запись 
на карту памяти B, а 
кнопка START/STOP 
записи на рукоятке 
запускает/
останавливает запись 
на карту памяти A.

Запись 4K & HD (Sub)

На одну карту памяти XQD можно 
одновременно записывать видео 4K (QFHD) 
как основной клип и видео MPEG HD422 
как дополнительный клип, который можно 
использовать для монтажа.
Для записи 4K & HD (Sub) можно 
использовать следующие форматы записи 
на карту памяти XQD.
Формат записи дополнительного клипа 
зависит от частоты системы основного 
клипа.

Формат записи 
основного 
клипа

Частота 
системы

Формат записи 
дополнительного 
клипа

 ˎ XAVC-I  
4096×2160P

 ˎ XAVC-I  
3840×2160P

 ˎ XAVC-L  
3840×2160P

29.97/25/ 
23.98

MPEG HD422 
1920×1080P

59.94/50 MPEG HD422 
1920×1080i

[Совет]
Дополнительные клипы можно скопировать на 
другой носитель как основные клипы с помощью 
пункта Copy Sub Clip (стр. 110) из меню Thumbnail.

Монитор видеосигнала

С помощью параметра Display On/Off 
>Video Signal Monitor (стр. 105) в меню 
Monitoring можно задать тип отображения 
видеосигнала на экране видоискателя: 
форму сигнала, вектороскоп или 
гистограмму.
Монитор видеосигнала видеокамеры 
измеряет видеосигнал на стадии выходного 
видеосигнала. Соответственно, если 
выходной видеосигнал кадрирован 

по краям относительно записанного 
видеосигнала, кадрированный компонент 
сигнала не измеряется. В таком случае 
в левом верхнем углу монитора 
видеосигнала отображается значок “EC”.

Отображение цели мониторинга

В режиме Cine EI в правом верхнем углу 
монитора видеосигнала для индикации 
цели мониторинга отображается 
информация о настройке цветового 
пространства (стр. 28) или о таблице 
соответствия монитора LUT (стр. 88).

Съемка с широким 
динамическим диапазоном 
(HDR)

Можно задать режим HDR (High Dynamic 
Range), чтобы записывать и выводить 
изображения в эквивалентном цветовом 
пространстве BT.2020 и с увеличенным 
динамическим диапазоном.

Задание режима HDR

Задайте для параметра Base Setting 
>Shooting Mode* (стр. 90) в меню Project 
значение HDR.

* Можно настроить также на экране состояния.

Настройка типа HLG

Задайте тип HLG для режима HDR 
с помощью параметра HDR Paint Setting 
>HLG Look (стр. 98) в меню Paint.

Настройка HLG 
Look

Описание

Natural Характеристика, 
соответствующая ITU-R 
BT.2100(HLG).

Live Характеристика, 
соответствующая 
ITU-R BT.2100(HLG), 
обеспечивающая 
улучшенное 
воспроизведение 
HDR. Однако при 
использовании этой 
настройки возможно 
увеличение уровня 
шумов.

Задание функции Gamma Display 
Assist

Задайте для параметра Gamma 
Display Assist >Setting (стр. 106) 
в меню Monitoring значение On для 
просмотра вспомогательной индикации 
в видоискателе, упрощающей съемку 
в режиме HDR.

* Можно настроить также на экране состояния.
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Пользовательская таблица 
соответствия 3D LUT

В режиме Cine EI можно загрузить 
файл CUBE (*.cube) для 17-точечной или 
33-точечной таблицы соответствия 3D LUT, 
созданный с помощью программы RAW 
Viewer или DaVinci Resolve (от компании 
Blackmagic Design Pty. Ltd.).

[Примечание]
Сохраните пользовательский файл 3D LUT 
в следующем каталоге SD-карты.
\PRIVATE\SONY\PRO\LUT\

Следующая процедура необходима для 
использования пользовательской 3D LUT.

1 Установите карту памяти SD в гнездо 
для карт памяти UTILITY SD/MS 
(стр. 8) этикеткой вправо.

2 Выберите параметр Monitor 3D LUT 
>Load SD Card (стр. 88) в меню 
Shooting.

3 Выберите целевой каталог для 
загрузки.
Можно зарегистрировать до 16 файлов 
во внутренней памяти устройства.

4 Выберите файл для загрузки.

5 Выберите OK.
Выбранный файл загружается.

6 Выберите OK.

7 Присвоение параметру Monitor LUT 
>Category (стр. 88) значения User 3D 
LUT в меню Shooting.

8 Выберите пользовательскую таблицу 
соответствия 3D LUT, которую вы хотите 
использовать, при помощи команд 
Monitor LUT >User 3D LUT Select 
(стр. 88) в меню Shooting.

Получение сведений о 
местоположении (GPS)

Если для параметра GPS в меню 
Technical задано значение On, значок 

 отображается, когда видеокамера 
производит поиск спутников GPS. Когда 
местоположение определено, данные о 
нем записываются при съемке видео.

[Примечания]
ˎˎ Для параметра GPS невозможно установить 

значение On в меню Technical, когда ручка не 
присоединена, так как приемник GPS встроен в 
ручку.

ˎˎ Отображаемый значок изменяется в зависимости 
от качества приема сигнала спутников GPS.
ˎˎ Если при использовании функции GPS держаться 

за ручку, это может отрицательно повлиять на 
точность определения местоположения.

Состояние 
позиционирования

Отображение Состояние приема 
сигнала GPS

Off Не 
отображается

Параметру GPS 
задано значение Off 
либо возникла 
ошибка.

Определение 
местоположения 
невозможно

Сведения о 
местоположении не 
удалось получить 
из-за отсутствия 
сигнала GPS. 
Перейдите на 
открытое 
пространство.

Поиск 
спутников

Выполняется поиск 
спутников GPS. На это 
может уйти несколько 
минут.

Позиционирование Принимается слабый 
сигнал GPS.

Сигнал GPS 
принимается. Данные 
о местоположении 
могут быть получены.

Принимается сильный 
сигнал GPS. Данные о 
местоположении 
могут быть получены.

[Советы]
ˎˎ По умолчанию функции GPS задано значение On. 

Когда позиционирование включено, видеокамера 
записывает данные о местоположении и времени.
ˎˎ Если значок позиционирования не появится 

на экране через несколько минут, возможно, 
возникла проблема с приемом сигнала. Начните 
съемку без записи данных о местоположении 
либо перейдите на открытое пространство. 
Если при съемке значок позиционирования 
не отображается, это означает, что данные о 
местоположении не записываются.

ˎˎ Проблемы с приемом сигнала GPS могут возникать 
при нахождении в помещении или вблизи 
высоких сооружений. Перейдите на открытое 
пространство.
ˎˎ Запись данных о местоположении может быть 

прервана, даже если значок позиционирования 
отображается на экране. Это зависит от уровня 
принимаемого сигнала.

Метаданные планирования

Метаданные планирования содержат 
сведения о планах съемки и записи, 
записанные в виде XML-файла.
При съемке можно использовать названия 
клипов и меток, заранее определенные в 
файле метаданных планирования.
Метаданные планирования можно 
отправлять и получать по сети помощью 
приложения “Content Browser Mobile”.

[Примечания]
ˎˎ При открытии крышки гнезд носителей передача 

метаданных планирования по сети прерывается. 
Передача метаданных планирования при 
открытой крышке невозможна. После закрытия 
крышки передача возобновляется.
ˎˎ Для определения названий клипов или меток 

кадров используйте шрифт, заданный для языка, 
указанного в пункте Language >Select (стр. 121) 
меню Maintenance. При использовании языка, 
отличного от языковой настройки видеокамеры, 
текстовые символы могут отображаться 
неправильно.
ˎˎ Если названия клипов и меток определены на 

французском, нидерландском или финском языке, 
некоторые символы отображаются другим (но 
очень похожим) шрифтом.

Загрузка файла метаданных 
планирования

Чтобы записывать метаданные 
планирования вместе с клипами, 
необходимо заранее загрузить файл 
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метаданных планирования в память 
видеокамеры.
Установите карту памяти XQD с файлом 
метаданных планирования (.xml), 
сохраненным в указанном ниже каталоге, 
в гнездо для карт видеокамеры, затем 
выберите и загрузите файл с помощью 
пункта Planning Metadata (стр. 97) >Load 
Media(A) или Load Media(B) в меню Project.
exFAT: XDROOT/General/Sony/Planning

Проверка подробной информации в 
метаданных планирования
После загрузки метаданных планирования 
в видеокамеру можно проверить 
содержащиеся в них подробные сведения, 
такие как имена файлов, дата и время 
создания и заголовки.
Выберите Planning Metadata (стр. 97) 
>Properties >Execute в меню Project.

Очистка загруженных метаданных 
планирования
Можно удалить данные планирования, 
загруженные в память видеокамеры.
Выберите Planning Metadata (стр. 97) 
>Clear Memory >Execute в меню Project.

Определение названия клипа 
в метаданных планирования

В файл метаданных планирования можно 
записывать строки названий клипов 
следующих двух типов.
ˎˎ Название в формате ASCII, которое 
отображается на экране видоискателя
ˎˎ Название в формате UTF-8, которое 
фактически регистрируется в качестве 
названия клипа

При указании названия клипа в метаданных 
планирования это название отображается 
на экране видоискателя под индикатором 
состояния операции.

Пример строк названия клипов
Для изменения описания тега <Title> в 
метаданных планирования используйте 
текстовый редактор.
Выделенные поля в этом примере являются 
строками названия клипа.
Название “Typhoon” задано в формате 
ASCII (до 44 символов). Название “Typhoon_
Strikes” задано в формате UTF-8 (до 44 
байт).
“sp” обозначает пробел, а  обозначает 
возврат каретки.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata" spassignId="
P0001" spcreationDate="
2011-08-20T17:00:00+09:00"sp

lastUpdate="
2011-09-28T10:30:00+09:00"sp

version="1.00">
<Properties sppropertyId="
assignment" spupdate="
2011-09-28T10:30:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhoon"sp

xml:lang="en">Typhoon_Strikes
</Title>

</Properties>
</PlanningMetadata>

[Примечания]
ˎˎ При создании файла вводите каждый оператор 

на отдельной строке, разделяя строки символами 
возврата каретки только после последнего 
символа строки. Вводите пробелы только в местах, 
указанных символами “sp”.
ˎˎ В качестве названия клипа может использовать 

строка длиной до 44 байтов (или 44 символов).  
Если длина строки в формате UTF-8 превышает 44 
байта, в качестве названия клипа используются 
первые 44 байта.  
Если указана только строка в формате ASCII, в 
качестве названия клипа используется название в 
формате ASCII по 44-ый символ.  

Если как строка в формате ASCII, так и строка в 
формате UTF-8 недействительны, используется 
название клипа в стандартном формате.
ˎˎ Следующие символы нельзя использовать 

в названиях клипов. При их вводе они заменяются 
символом подчеркивания (_).  
Недопустимые символы: "*/:<>?\|

Использование названия клипа, 
определенного в метаданных 
планирования
Загрузите в память видеокамеры файл 
метаданных планирования, содержащий 
название клипа, затем выберите пункт Clip 
Name Format >Auto Naming (стр. 102) >Plan 
в меню TC/Media.
Названия клипов создаются путем 
добавления символа подчеркивания (_) и 
5-значного порядкового номера (00001–
99999).
Пример: Typhoon_Strikes_00001, Typhoon_
Strikes_00002, …
[Примечания]
ˎˎ Если порядковый номер достигает значения 

99999, при следующей записи снова используется 
значение 00001.
ˎˎ При загрузке другого файла метаданных 

планирования для 5-значного порядкового 
номера восстанавливается значение 00001.

Определение названий меток кадров 
в метаданных планирования

При записи метки кадра 1 или 2 можно 
применить к метке название, используя 
строку, определенную в метаданных 
планирования.

Пример строк названий меток кадров
Для изменения описания тега <Meta name> 
в метаданных планирования используйте 
текстовый редактор.
Выделенные поля в этом примере являются 
строками названия метки кадра.
Названия могут быть в формате ASCII (до 32 
символов) или UTF-8 (до 16 символов).

“sp” обозначает пробел, а  обозначает 
возврат каретки.

[Примечание]
Если строка названия содержит хотя бы один символ, 
не входящий в набор символов ASCII, максимальная 
длина строки ограничена 16 символами.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2011-04-15T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 15/04/2011
</Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
</Properties>

</PlanningMetadata>

[Примечание]
При создании файла вводите каждый оператор 
на отдельной строке, разделяя строки символами 
возврата каретки только после последнего символа 
строки. Вводите пробелы только в местах, указанных 
символами “sp” (кроме внутренних пробелов в 
строках названий меток кадров).
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Данные прокси можно записывать на карту 
памяти SD одновременно с записью на 
карту памяти XQD.

Сведения о поддерживаемых картах памяти SD, 
форматировании карт памяти SD и проверке 
оставшейся емкости см. в разделе “Использование 
карты памяти UTILITY SD/MS” (стр. 32).

Настройка перед съемкой

1 Задайте для параметра Proxy Rec* 
>Setting в меню Project значение On.
* Можно настроить также на экране состояния.

2 Установите карту памяти SD в гнездо 
для карт памяти UTILITY SD/MS 
(стр. 8) этикеткой вправо.

[Примечание]
Для параметра Proxy Rec невозможно задать 
значение On одновременно с параметрами S&Q 
Motion, Interval Rec, Picture Cache Rec, 2-slot Simul Rec 
или 4K & HD (Sub) Rec. При задании для параметра 
Proxy Rec значения On для этих режимов записи 
принудительно устанавливается значение Off.

Запись прокси

После задания необходимых настроек для 
съемки нажмите кнопку START/STOP (пуск/
остановка записи), чтобы начать съемку.

[Примечания]
ˎˎ Если видеокамера выключается, когда карта 

памяти SD используется, или карта памяти 
SD извлекается в этот момент, целостность 
находящихся на карте памяти данных не 
гарантируется. Все данные, записанные на карту 
памяти, могут быть потеряны. Перед выключением 
видеокамеры или извлечением карты памяти 
SD всегда необходимо убедиться, что индикатор 
доступа не горит.
ˎˎ Соблюдайте осторожность при установке и 

извлечении карты памяти SD, так как она может 
выскочить.

Для выхода остановите съемку.
При остановке записи на карту памяти 
XQD запись данных прокси также 
останавливается.

Изменение настроек записи 
прокси

Задание размера изображения

Выберите пункт Proxy Rec >Proxy Format 
(стр. 92) в меню Project и задайте размер 
изображения.

Задание аудиоканала

Выберите пункт Proxy Rec >Audio Channel 
(стр. 92) в меню Project и задайте 
аудиоканал для записи данных прокси.

О записанном файле

Файл имеет расширение “.mp4”.
Одновременно записывается временной 
код.

Место сохранения записанного 
файла

Записанный файл сохраняется в каталоге  
“/PRIVATE/PXROOT/Clip”.

Об имени файла

Имя файла состоит из названия клипа, 
записанного на карту памяти XQD, и 
последовательного числового суффикса.
В режима 2-slot Simul Rec приоритет имеет 
название клипа из гнезда A.
Последовательная нумерация сохраняется 
даже после выключения видеокамеры. 
Последовательный номер сбрасывается на 
0001 при выполнении команды All Reset.
Подробные сведения о названиях клипов 
см. в пункте Clip Name Format (стр. 102) в 
меню TC/Media.

Запись прокси
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Выходной видеосигнал RAW можно 
записывать с разъема RAW OUT 
установленного на видеокамеру блока 
XDCA-FX9 (приобретается дополнительно) 
на внешнее устройство записи.

1 Подключите внешнее устройство 
записи RAW к разъему RAW OUT 
устройства XDCA-FX9, подключенного к 
видеокамере.

2 Задайте для параметра Base Setting 
>Shooting Mode* в меню Project 
значение Cine EI.

3 Задайте для параметра Rec Format 
>Codec* в меню Project кодек RAW.
При выборе значения RAW & XAVC-I 
одновременно записываются 
видеосигнал RAW на внешнее 
устройство записи RAW и видеосигнал 
HD на карты памяти XQD 
в видеокамере.

4 Выберите режим развертки и 
разрешение с помощью параметра Rec 
Format >Imager Scan Mode* в меню 
Project.

5 Убедитесь, что внешнее устройство 
записи включено, затем нажмите 
кнопку START/STOP (пуск/остановка 
записи) на видеокамере. 

 [Примечание]
Если запустить запись на внешнем устройстве 
записи без использования кнопки записи на 
видеокамере, клипы могут не записываться 
должным образом.

[Совет]
Функции, помеченные символом звездочки (*), 
можно настроить также на экране состояния.

Ниже приведены поддерживаемые 
форматы выходных сигналов RAW.

Project >Rec Format

Frequency Codec Imager 
Scan 
Mode

RAW 
Output 
Format

59.94/50 RAW FFcrop 5K 4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG 
HD 422

FFcrop 5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K 

2048×1080

29.97/25/ 
23.98

RAW FF 6K/
FFcrop 5K

4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG 
HD 422

FF 6K/
FFcrop 5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K

2048×1080

24 RAW FF 6K/
FFcrop 5K/ 
S35 4K

4096×2160

Индикация состояния 
управления записью

Если для параметра Display On/Off 
(стр. 104) >RAW Output Control Status 
в меню Monitoring задано значение 
On, в видоискателе с помощью значка 
отображается состояние управления 
записью RAW.

[Примечание]
Сигнал управления записью выводится на разъем 
RAW OUT видеокамеры, но получить состояние 
внешнего устройства записи невозможно. 
Соответственно, видеокамера может показывать, что 
выполняется видеозапись RAW, когда фактически 
внешнее устройство записи ничего не записывает. 
Для получения правильного состояния работы 
проверяйте индикатор на внешнем устройстве 
записи.

[Совет]
Отображается также значение параметра RAW 
Output Format.

Съемка с замедлением/
ускорением движения

Если для параметра S&Q Motion >Setting 
в меню Shooting задано значение On, 
видеосигнал RAW записывается в режиме 
съемки с замедлением/ускорением 
движения.
Подробные сведения о поддерживаемых 
значениях частоты кадров при съемке см. 
на стр. 48.

Запись видео в формате RAW
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Подключение к другим устройствам по локальной сети
Видеокамера может подключаться 
к смартфонам, планшетам и другим 
устройствам по локальной сети.
Установление подключения по локальной 
сети между устройством и видеокамерой 
позволяет выполнять следующие действия 
с помощью дистанционного управления 
по веб-интерфейсу (стр. 67) или 
приложения “Content Browser Mobile”.
ˎˎ Метаданные планирования (стр. 53) 
Отправка и получение метаданных 
планирования с использованием 
устройства и видеокамеры.  
Можно заранее отправить метаданные 
планирования в видеокамеру, чтобы 
указать названия клипов.
ˎˎ Дистанционное управление по локальной 
сети 
Видеокамерой можно управлять со 
смартфона, планшета или компьютера, 
подключенных к видеокамере по 
локальной сети.
ˎˎ Передача файлов по локальной сети 
Можно передавать на сервер 
по локальной сети файл прокси 
(низкого разрешения), записанный 
на карту памяти SD в видеокамере, 
или оригинальный файл (высокого 
разрешения), записанный видеокамерой.
ˎˎ Контроль видео по локальной сети 
Можно создать поток (H.264) с камеры 
или воспроизводить видео из 
видеокамеры и контролировать видео 
с помощью приложения “Content 
Browser Mobile” на другом устройстве по 
локальной сети.

Приложение “Content Browser Mobile”

С помощью приложения “Content Browser 
Mobile” можно дистанционно управлять 
видеокамерой с экрана другого устройства, 
просматривая видеоизображение 
с видеокамеры, а также задавать настройки 
видеокамеры.

Подробные сведения о приложении “Content Browser 
Mobile” можно получить у представителя службы 
технического обслуживания компании Sony.

Потоковая передача видео высокого 
качества с использованием 
технологии Sony QoS (стр. 65)

Можно передавать потоковое видео 
высокого качества с помощью Sony Network 
RX Station (продается отдельно) или XDCAM 
air* Connection Control Manager (CCM), 
подключенного к видеокамере в режиме 
сетевого клиента.
* XDCAM air — это облачная служба, 

предоставляемая Sony.  
Для использования этой службы требуется 
регистрация.  
В некоторых регионах служба XDCAM air не 
предоставляется. Сведения об областях, в которых 
доступна эта служба, см. на следующем сайте.  
https://www.xdcam-air.com  
Кроме того, сведения о политике 
конфиденциальности службы XDCAM air см. на 
следующих сайтах.
 – Условия обслуживания 

https://www.xdcam-air.com/site/tos_eu.html
 – Политика конфиденциальности службы XDCAM 

air 
https://sony-imaging-products-solutions.co.jp/
pp/sips/en/index.html

 – Политика конфиденциальности службы 
Professional ID 
https://www.pro-id.sony.net/#/privacyPolicy

 За дополнительной информацией обращайтесь 
к представителю по продаже профессиональных 
продуктов корпорации Sony.

Задание имени пользователя и 
пароля

Имя пользователя и пароль видеокамеры 
необходимо задать, чтобы можно было 
использовать сетевые функции.

1 Задайте значение параметра Access 
Authentication >User Name (стр. 116) 
в меню Network.

2 Задайте значение параметра Access 
Authentication >Password (стр. 116) 
в меню Network.

Подключение с использованием 
режима точки доступа 
беспроводной локальной сети

Видеокамера выполняет функции точки 
доступа и подключается к устройству по 
беспроводной локальной сети.

Смартфон/
планшет

Компьютер

Подключение к устройству с 
поддержкой NFC одним касанием

Устройства, поддерживающие NFC, можно 
подключить (одним касанием) с помощью 
NFC.

1 Откройте меню [Settings] на устройстве, 
выберите [More] и установите флажок 
NFC.

2 Включите видеокамеру.

3 Включите функцию NFC.
Нажмите и удерживайте (в течение 3 с) 
программируемую кнопку, которой 
назначена функция NFC, или выберите 
пункт Wireless LAN >NFC в меню 
Network, чтобы включить режим 
подключения по NFC.
Функция NFC доступна только тогда, 
когда на экране отображается значок 

.

4 Прикоснитесь к видеокамере 
устройством.
Устройство подключается к 
видеокамере, и запускается 
приложение “Content Browser Mobile”.

 [Примечания]
ˎˎ Заранее отключите спящий режим и 

блокировку экрана.
ˎˎ Коснитесь устройством видеокамеры 

и удерживайте его, пока не запустится 
приложение “Content Browser Mobile” (1–2 
секунды).

https://www.xdcam-air.com
https://www.xdcam-air.com/site/tos_eu.html
https://sony-imaging-products-solutions.co.jp/pp/sips/en/index.html
https://sony-imaging-products-solutions.co.jp/pp/sips/en/index.html
https://www.pro-id.sony.net/#/privacyPolicy
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Подключение к устройству, 
поддерживающему WPS

Устройства, поддерживающие WPS, можно 
подключать с использованием WPS.

1 Выберите пункт Wireless LAN >Setting 
>Access Point Mode в меню Network.

2 Выберите пункт Wireless LAN >WPS 
>Execute в меню Network.

3 Откройте настройки сети или 
настройки Wi-Fi на устройстве и 
включите Wi-Fi.

4 Выберите SSID видеокамеры в списке 
SSID сети Wi-Fi на устройстве, затем 
выберите WPS Push Button в пункте 
Option на устройстве для подключения.

 [Примечания]
ˎˎ Способ выполнения операций зависит от 

конкретного устройства.
ˎˎ SSID и пароль видеокамеры можно проверить 

в пункте AP Mode Settings >Camera SSID & 
Password (стр. 116) в меню Network.

5 Откройте дистанционное управление 
по веб-интерфейсу (стр. 67). Или 
подключитесь с помощью приложения 
Content Browser Mobile.

Подключение с вводом SSID и пароля 
на устройстве

Видеокамеру можно подключить к 
устройству, введя SSID и пароль на 
устройстве.

1 Выберите пункт Wireless LAN >Setting 
>Access Point Mode в меню Network.

2 Откройте настройки сети или 
настройки Wi-Fi на устройстве и 
включите Wi-Fi.

3 Подключите устройство к видеокамере, 
выбрав SSID видеокамеры в списке SSID 
сети Wi-Fi и введя пароль.
SSID и пароль видеокамеры можно 
проверить в пункте AP Mode Settings 
>Camera SSID & Password (стр. 116) в 
меню Network.

 [Примечание]
Способ выполнения операций зависит от 
конкретного устройства.

4 Откройте дистанционное управление 
по веб-интерфейсу (стр. 67). Или 
подключитесь с помощью приложения 
Content Browser Mobile.

Подключение с использованием 
режима станции беспроводной 
локальной сети

Видеокамера подключается к 
существующей точке доступа 
беспроводной сети в качестве клиента. 
Видеокамера и устройство подключаются 
через точку доступа.
В журнале отображаются 10 последних 
использовавшихся точек доступа.
Журнал подключения сохраняется в файле 
ALL, но пароли доступа не сохраняются. При 
следующем подключении после загрузки 
файла ALL требуется ввести пароль.

Смартфон/
планшет

Точка 
доступа

Компьютер

Подключение к точке доступа с 
помощью функции WPS

Если точка доступа поддерживает функцию 
WPS, к точке доступа можно подключиться 
с помощью простой настройки.

1 Включите точку доступа.

2 Включите видеокамеру.

3 Выберите пункт Wireless LAN >Setting > 
Station Mode в меню Network.

4 Выберите пункт Wireless LAN >WPS 
>Execute в меню Network.

5 Нажмите кнопку WPS на точке доступа.
Сведения об использовании кнопки 
WPS см. в инструкции по эксплуатации 
точки доступа.
После успешного подключения значок 
индикатора состояния сети на экране 
видоискателя показывает силу сигнала 
1 или выше.

 [Примечание]
В случае сбоя подключения повторите 
операцию, начиная с шага 1.

6 Подключите устройство к точке доступа.
Сведения о подключении см. в 
инструкции по эксплуатации 
устройства.

7 Откройте дистанционное управление 
по веб-интерфейсу (стр. 67). Или 
подключитесь с помощью приложения 
Content Browser Mobile.

Подключение к точке доступа с 
помощью автоматического 
обнаружения сетей или вручную

Подключение к требуемой точке доступа 
можно настроить из меню настройки.
Подключение к требуемой точке доступа 
можно настроить с помощью функции 
автоматического обнаружения сетей.

Подключение с помощью функции 
автоматического обнаружения сетей

1 Выполните шаги с 1 по 3 из раздела 
“Подключение к точке доступа с 
помощью функции WPS” (стр. 58).

2 Выберите ST Mode Settings >Scan 
Networks (стр. 117) >Execute в меню 
Network.
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Видеокамера начинает обнаружение 
точек для подключения.
Обнаруженные возможные варианты 
подключения отображаются в виде 
списка.

3 Выберите из списка точку для 
подключения.
Открывается экран сведений о сети 
(точке доступа). Выбранное 
подключение отображается в поле SSID.

4 Выберите поле Password и задайте 
пароль на экране ввода пароля.
При выборе идентификатора SSID в 
журнале подключений настройки 
задаются автоматически, включая 
пароль.
Задайте пароль, чтобы вернуться на 
экран сведений о сети (точке доступа).

5 Задайте следующие параметры 
подключения.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  
Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите шлюз для точки доступа.  
Эта настройка доступна только в том 

случае, если для параметра DHCP 
задано значение Off.
ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 
автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите основной сервер DNS для 
точки доступа.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.
ˎˎ Secondary DNS Server 
Введите дополнительный сервер DNS 
для точки доступа.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

6 После завершения выберите Connect 
для подключения к точке доступа.

Подключение вручную

1 Выполните шаги с 1 по 3 из раздела 
“Подключение к точке доступа с 
помощью функции WPS” (стр. 58).

2 Выберите ST Mode Settings >Manual 
Register (стр. 117) >Execute в меню 
Network.
Сразу открывается экран сведений о 
сети (точке доступа).

3 Задайте следующие параметры 
подключения.
ˎˎ SSID 
Введите идентификатор SSID 
подключаемой точки доступа.

ˎˎ Security 
Введите способ шифрования.
ˎˎ Password 
Введите пароль для подключаемой 
точки доступа.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  
Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите адрес шлюза.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 
автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите адрес основного сервера 
DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

ˎˎ Secondary DNS Server 
Введите адрес дополнительного 
сервера DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

4 После завершения выберите Connect 
для подключения к точке доступа.

Подключение к устройству с 
помощью кабеля ЛВС

Соединиться с устройством можно, 
подключив разъем проводной ЛВС 
установленного на видеокамеру устройства 
XDCA-FX9 (стр. 26) к коммутатору ЛВС с 
помощью кабеля ЛВС.

Компьютер

Коммутатор ЛВС
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Подключения кабеля ЛВС и настройки 
проводной ЛВС

1 Подключите разъем проводной ЛВС 
устройства XDCA-FX9 к коммутатору 
ЛВС с помощью кабеля ЛВС.

2 Включите видеокамеру.

3 Задайте для параметра Wired LAN 
>Setting (стр. 118) в меню Network 
значение On.

4 Настройте параметры подключения с 
помощью пункта Wired LAN >Detail 
Settings (стр. 118) в меню Network.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  
Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите адрес шлюза.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 

автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите адрес основного сервера 
DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.
ˎˎ Secondary DNS Server 
Введите адрес дополнительного 
сервера DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

5 После завершения выберите Set, чтобы 
применить настройки.

[Примечание]
Обязательно выбирайте Set после изменения 
настроек подключения. Если не выбрать Set, 
настройки не применяются.
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Видеокамеру можно подключать к 
Интернету с помощью модема, проводной 
ЛВС или беспроводной ЛВС.

Подключение с помощью 
модема

Видеокамеру можно подключить к 
Интернету по сети 3G/4G, установив 
на видеокамеру устройство XDCA-FX9 
(стр. 26) и установив дополнительно 
приобретаемый модем на устройство 
XDCA-FX9.
Одновременная установка и использование 
нескольких модемов обеспечивает 
потоковую передачу высокого качества в 
режиме сетевого клиента по двум линиям 
для повышения качества потоковой 
передачи и дублирования устройств.
За сведениями о совместимых модемах 
обращайтесь к дилеру Sony или к 
представителю службы технического 
обслуживания компании Sony.

[Примечание]
Модем не может использоваться одновременно с 
проводной ЛВС.

Присоединение устройства XDCA-FX9 
к устройству

Присоедините модем, поддерживающий 
стандарт USB, к разъему USB (тип A) 
устройства XDCA-FX9. Одновременно 
можно использовать два модема, 
подключив их к обоим разъемам.

[Примечание]
Присоединять и снимать модем следует, когда 
питание видеокамеры отключено.

Подключение к сети

1 Включите видеокамеру.

2 Задайте для параметра Modem >Setting 
в меню Network значение On.

 [Примечание]
Для подключения к сети 3G/4G может 
потребоваться некоторое время (около 1 
минуты). Подождите, пока значок индикатора 
состояния сети (стр. 11) на экране 
видоискателя не будет показывать силу сигнала 
1 или выше.

Подключение с помощью 
кабеля USB

Можно подключить смартфон через кабель 
USB к подсоединенному к видеокамере 
устройству XDCA-FX9 и подключиться 
к Интернету с помощью смартфона.

Подключение смартфона 
к видеокамере

Подключите смартфон с помощью 
кабеля USB к разъему USB (тип A) 
(стр. 4) подсоединенного к видеокамере 
устройства XDCA-FX9.

[Примечания]
ˎˎ  Подключать и отключать смартфон следует при 

отключенном питании видеокамеры.
ˎˎ  Подключение по кабелю USB не может 

использоваться, если смартфон подключен через 
концентратор USB.

Подключение к сети

1 Включите видеокамеру.

2 Задайте для параметра Modem >Setting 
в меню Network значение On.

Подключение с использованием 
режима станции беспроводной 
локальной сети

Видеокамеру можно подключить к 
Интернету в режиме станции Wi-Fi с 
помощью дополнительно приобретаемого 
беспроводного маршрутизатора ЛВС или с 
помощью кабеля.

Смартфон/
планшет

Маршрутизатор 
беспроводной ЛВС

Компьютер

Интернет

Смартфон/
планшет

Интернет

Подключитесь к беспроводному 
маршрутизатору ЛВС или устройству, 
как описано в разделе “Подключение 
с использованием режима станции 
беспроводной локальной сети” (стр. 58).

Подключение к Интернету
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Подключение с помощью 
кабеля ЛВС

Соединиться с устройством можно, 
подключив разъем проводной ЛВС 
установленного на видеокамеру устройства 
XDCA-FX9 (стр. 26) к маршрутизатору 
Интернета с помощью кабеля ЛВС.

Компьютер

Маршрутизатор

Интернет

Подключитесь к маршрутизатору 
Интернета, как описано в разделе 
“Подключение к устройству с помощью 
кабеля ЛВС” (стр. 59).
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Отправка файлов
Записанный видеокамерой файл прокси 
или оригинальный файл можно отправить 
на сервер в Интернете или в локальной 
сети по сети 3G/4G или через точку доступа.

[Примечание]
При открытии крышки гнезд носителей передача 
файлов по сети прерывается. Передача файлов 
при открытой крышке невозможна. После закрытия 
крышки передача возобновляется.

Подготовка

Подключение к сети

Подключите видеокамеру к Интернету или 
локальной сети, как описано в разделе 
“Подключение к Интернету” (стр. 61) или 
“Подключение к другим устройствам по 
локальной сети” (стр. 57).

Регистрация места назначения 
передачи файлов

Заранее зарегистрируйте сервер для 
отправки.

1 Выберите File Transfer >Server Settings1 
(или Server Settings2, Server Settings3) в 
меню Network.
Открывается экран настройки пункта 
назначения передачи.

2 Задайте каждый параметр на экране 
настройки пункта назначения 
передачи.
Display Name
Введите имя сервера для отображения 
в списке пунктов назначения передачи.
Service
Отображается тип сервера.
“FTP”: FTP-сервер

Host Name
Введите адрес сервера.
Port
Введите номер порта для подключения 
к серверу.
User Name
Введите имя пользователя.
Password
Введите пароль.
Passive Mode
Включение и выключение пассивного 
режима.
Destination Directory
Введите имя каталога на целевом 
сервере.

 [Примечания]
ˎˎ При редактировании “” обозначает 

символы, изменить которые невозможно. 
При редактировании имени каталога, 
содержащего эти символы, правильная работа 
не гарантируется.  
Если требуется редактирование, удалите все 
символы и введите значение заново.
ˎˎ Если в параметр Destination Directory введены 

символы, недопустимые на целевом сервере, 
файлы будут переданы в главный каталог 
пользователя. Недопустимые символы зависят 
от сервера.

Using Secure Protocol
Задает, требуется ли выполнять 
безопасную отправку по FTP.
Root Certificate
Загрузка или очистка сертификата.
ˎˎ Load 
Выберите Set на шаге 3, чтобы 
импортировать сертификат CA.

* Загружаемый сертификат должен быть 
в формате PEM и должен записываться 
в корневой каталог вспомогательной SD-карты 
с именем файла “certification.pem”.

ˎˎ Clear 
Выберите Set на шаге 3, чтобы удалить 
сертификат CA.
ˎˎ None 
Не загружать и не удалять сертификат.

 [Примечания]
ˎˎ Перед импортом сертификата CA установите 

правильное время на часах видеокамеры.
ˎˎ При записи в формате XAVC-I 3840×2160P 

59.94/50P пункт Load недоступен.
ˎˎ В состоянии с низким напряжением пункты 

Load/Clear для сертификата CA недоступны.

Root Certificate Status
Отображение состояния загрузки 
сертификата.
Reset
Сброс настроек в пункте Server Settings 
на значения по умолчанию.

3 После завершения выберите Set, чтобы 
применить настройки.
Обязательно выбирайте Set после 
изменения настроек. Если не выбрать 
Set, настройки не применяются.

Сервер можно также зарегистрировать с 
помощью дистанционного управления по 
веб-интерфейсу “Регистрация целевого 
сервера” (стр. 68).

Выбор файла и его отправка

На сервер можно отправить файл, 
записанный на SD-карту, или оригинальный 
файл, записанный на карту памяти XQD.
Файлы можно также отправлять с помощью 
дистанционного управления по веб-
интерфейсу. Подробное описание см. на 
“Передача файлов (Slot A, Slot B, Slot SD/
MS)” (стр. 69).

Отправка файла прокси на SD-карте с 
экрана эскизов

1 Подключите устройство к видеокамере 
по ЛВС (стр. 57).

2 Выберите Transfer Clip (Proxy) >Select 
Clip в меню Thumbnail.
Экран переключается с меню настройки 
на экран эскизов.
Клипы можно передавать с экрана 
эскизов или с экрана отфильтрованных 
эскизов клипов.

3 Выберите клип, который необходимо 
перенести, и нажмите кнопку MENU.
Открывается экран подтверждения 
передачи.

4 Выберите Execute.
Файл прокси, соответствующий 
выбранному файлу, регистрируется как 
задание по передаче, после чего 
начинается отправка файла.
После успешной регистрации задания 
по передаче открывается экран 
результатов передачи.

5 Выберите OK.

Отправка всех файлов
Выберите All Clips вместо Select Clip на 
шаге 2, чтобы передать файлы прокси, 
соответствующие всем файлам.

[Примечание]
Можно передать не более 200 файлов.

Отправка оригинального файла на 
карте памяти XQD с экрана эскизов

1 Подключите устройство к видеокамере 
по ЛВС (стр. 57).

2 Выберите Transfer Clip >Select Clip в 
меню Thumbnail.
Экран переключается с меню настройки 
на экран эскизов.
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Клипы можно передавать с экрана 
эскизов или с экрана отфильтрованных 
эскизов клипов.

3 Выберите клип, который необходимо 
перенести, и нажмите кнопку MENU.
Открывается экран подтверждения 
передачи.

4 Выберите Execute.
Выбранный файл регистрируется как 
задание по передаче, после чего 
начинается отправка файла.
После успешной регистрации задания 
по передаче открывается экран 
результатов передачи.

5 Выберите OK.

Отправка всех файлов
Выберите All Clips вместо Select Clip на шаге 
2, чтобы передать все файлы.

[Примечание]
Можно передать не более 200 файлов.

Проверка передачи файла

Состояние передачи файла можно 
проверить, выбрав File Transfer >View Job 
List (стр. 119) в меню Network.
Состояние отправки можно проверить на 
экране Job List, который отображается при 
выборе пункта Job List на экране SD Card, 
Slot A, или Slot B (стр. 69).

[Советы]
ˎˎ Состояние передачи файла можно также 

проверить на экране дистанционного управления 
по веб-интерфейсу.
ˎˎ Если для параметра File Transfer >Auto Upload 

(Proxy) в меню Network задано значение On и 
имеется сетевое подключение, по завершении 
записи файлы прокси автоматически 
отправляются на сервер, указанный в пункте 
Default Upload Server. Подробное описание см. 

на “Автоматическая отправка файла прокси” 
(стр. 69).

[Примечания]
ˎˎ Можно зарегистрировать до 200 заданий 

передачи.
ˎˎ Список заданий сохраняется при выключении 

видеокамеры, но до 10 минут последней 
информации о ходе выполнения могут быть 
утрачены, если снять аккумулятор или выключить 
видеокамеру, предварительно не установив 
переключатель POWER в положение STANDBY.
ˎˎ Задания, добавленные после перехода в 

состояние низкого напряжения аккумулятора, не 
сохраняются в списке заданий.
ˎˎ Если во время передачи файла произошла 

ошибка, передача клипа с тем же именем, что и 
переданный клип, может не возобновиться — это 
зависит от настроек и состояния целевого сервера 
передачи. В таким случае проверьте настройки и 
состояние целевого сервера передачи.

Отправка с использованием 
протокола Secure FTP

Файлы можно отправлять в 
зашифрованном виде с использованием 
для подключения к целевому файловому 
серверу протокола FTPS в явном режиме 
(FTPES).

Настройка безопасной передачи по 
FTP

Для безопасной передачи по FTP задайте 
на целевом файловом сервере для 
параметра Using Secure Protocol значение 
ON и импортируйте сертификат.
Подробное описание конфигурации см. в 
разделе “Регистрация места назначения 
передачи файлов” (стр. 63).
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Для поддержки потоковой передачи 
высокого качества включите режим 
сетевого клиента и подсоедините Sony 
Network RX Station (опция) как Connection 
Control Manager (CCM) или подключитесь 
через XDCAM air.

Настройка подключения в 
режиме сетевого клиента

В настройках NCM Settings можно задать 
до трех подключений в режиме сетевого 
клиента.

1 Выберите Network Client Mode >NCM 
Settings1 (или NCM Settings2, NCM 
Settings3) в меню Network.
Открывается экран настройки пункта 
назначения подключения в режиме 
сетевого клиента.

2 Задайте каждый параметр на экране 
настройки пункта назначения 
подключения.
Display Name
Задайте отображаемое имя в меню 
NCM.
CCM Address
Введите адрес CCM для подключения 
(имя узла или IP-адрес).
CCM Port
Введите номер порта CCM для 
подключения.
User Name
Введите имя пользователя.
Password
Введите пароль.

CCM Certificate
Корневой сертификат CCM необходим 
для подключения к CCM или XDCAM air. 
Видеокамера содержит встроенный 
корневой сертификат CCM, который 
также можно обновить. Чтобы обновить 
корневой сертификат CCM, сохраните 
сертификат на карте памяти, затем 
импортируйте его с карты памяти.
ˎˎ Load 
Выберите Set на шаге 3, чтобы 
импортировать сертификат.

* Загружаемый сертификат должен быть в 
формате PEM и должен записываться в 
корневой каталог SD-карты с именем файла 
“CCM_certification.pem”.

ˎˎ Clear 
Выберите Set на шаге 3, чтобы удалить 
сертификат.
ˎˎ None 
Не загружать и не удалять сертификат.

 [Примечания]
ˎˎ Перед загрузкой сертификатов подключения 

к CCM и XDCAM air установите правильное 
время на часах видеокамеры.
ˎˎ При записи в формате XAVC-I 3840×2160P 

59.94/50P или XAVC-I 4096×2160P 59.94/50P 
пункт Load недоступен.
ˎˎ В состоянии с низким напряжением загрузить 

или удалить сертификаты подключения к CCM 
и XDCAM air невозможно.

CCM Certificate Status
Отображение состояния загрузки 
сертификата.
Camera Control
Включение и отключение управления 
камерой при подключении с помощью 
CCM.
Camera Setting
Включение и отключение операций с 
файлом ALL при подключении с 
помощью CCM.
Reset
Сброс настроек в пункте NCM Settings 
на значения по умолчанию.

3 После завершения выберите Set, чтобы 
применить настройки.
Обязательно выбирайте Set после 
изменения настроек. Если не выбрать 
Set, настройки не применяются.

4 Выберите Network Client Mode >NCM 
Settings Select в меню Network, затем 
выберите настройки NCM (NCM 
Settings1, NCM Settings2, NCM Settings3), 
указанные в шагах с 1 по 3.

Задание качества потоковой 
передачи

Для выполнения потоковой передачи 
в высоком качестве задайте параметру 
Network Client Mode >Streaming Quality 
(стр. 119) в меню Network значение High. 
Чтобы выполнять потоковую передачу 
в стандартном качестве задайте параметру 
Streaming Quality значение Normal.

[Примечания]
ˎˎ Параметру Streaming Quality нельзя задать 

значение High в следующих случаях.
 – Когда параметр Proxy Rec >Setting (стр. 92) 

в меню Project имеет значение On
 – Когда параметр 4K & HD (Sub) Rec >Setting 

(стр. 92) в меню Project имеет значение On
 – Когда параметру Focus >Face/Eye Detection AF 

(стр. 87) в меню Shooting не задано значение 
Off

ˎˎ Когда параметру Network Client Mode >Setting 
(стр. 118) в меню Network задано значение On, 
значение параметра Streaming Quality нельзя 
изменить.

Подключение в режиме 
сетевого клиента

1 Подключите видеокамеру к Интернету, 
как описано в разделе “Подключение к 
Интернету” (стр. 61).

2 Задайте для параметра Network Client 
Mode >Setting в меню Network значение 
On.
Включается режим сетевого клиента, и 
видеокамера подключается к Network 
RX Station или XDCAM air.
Потоковая трансляция начинается в 
ответ на операцию в Network RX Station. 
Подробные сведения о работе см. в 
руководствах по эксплуатации Network 
RX Station или в справке службы XDCAM 
air.
Задавать для параметра Setting 
значение On или Off можно также 
программируемой кнопкой (стр. 47), 
которой назначена функция Network 
Client Mode.

[Примечания]
ˎˎ Потоковую передачу невозможно запустить при 

указанных ниже настройках меню.
 – Когда параметр S&Q Motion >Setting в меню 

Shooting имеет значение On
 – Когда параметр Interval Rec >Setting в меню 

Project имеет значение On
 – Когда параметр Simul Rec >Setting в меню Project 

имеет значение On
ˎˎ После переключения в режим сетевого клиента 

мониторинг (стр. 68) недоступен.
ˎˎ Если переключиться в режим сетевого клиента во 

время мониторинга, мониторинг останавливается.
ˎˎ Передача файлов во время потоковой передачи 

в режиме сетевого клиента не поддерживается. 
Передача файлов поддерживается после 
остановки потоковой передачи.
ˎˎ Если запустить потоковую передачу в режиме 

сетевого клиента во время передачи файлов, 
передача файлов останавливается. Передача 
файлов возобновляется после остановки 
потоковой передачи.

Использование режима сетевого клиента
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ˎˎ User Name, Password и сертификаты не 
сохраняются в файле ALL, поэтому после загрузки 
файла ALL их необходимо настроить заново.
ˎˎ Если во время потоковой передачи в режиме 

сетевого клиента задать для параметра 
Setting значение Off, потоковая передача 
останавливается.
ˎˎ При потоковой передаче в режиме сетевого 

клиента невозможно изменить параметр NCM 
Settings Select и настройки NCM, выбранные с 
помощью параметра NCM Settings Select.
ˎˎ Во время потоковой передачи частота обновления 

информации на экране уменьшается, но это не 
влияет на работу.
ˎˎ Настройки записи невозможно изменить во время 

потоковой передачи в режиме сетевого клиента.
ˎˎ Настройки проводной ЛВС невозможно изменить 

во время потоковой передачи в режиме сетевого 
клиента.
ˎˎ При переключении на экран эскизов или экран 

воспроизведения во время потоковой передачи 
QoS изображение может на короткое время 
останавливаться.
ˎˎ Формат распространения, доступный для 

потоковой передачи, зависит от настройки Rec 
Format видеокамеры.

Передача файлов в режиме 
сетевого клиента

Файлы можно передавать на сервер, 
заданный в CCM, подсоединив Network 
RX Station, действующую как CCM, и 
видеокамеру в режиме сетевого клиента.

1 Выберите файл для отправки из CCM 
или другого источника.
ˎˎ Для передачи файла прокси 
Выполните шаги с 1 по 4 из раздела 
“Отправка файла прокси с карты 
памяти SD” (стр. 69).
ˎˎ Для передачи оригинального файла 
Выполните шаги с 1 по 4 из раздела 
“Отправка оригинального файла с 
карты памяти XQD” (стр. 69).

[Примечание]
“NCM: RX Server” можно также задать в качестве 
пункта назначения, когда видеокамера не находится 
в режиме сетевого клиента. В таком случае передача 
устанавливается в режим ожидания, и передача 
на сервер, указанный в CCM, начинается после 
подключения к CCM в режиме сетевого клиента.
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Использование дистанционного управления по веб-интерфейсу
Доступ к встроенному в видеокамеру веб-
интерфейсу дистанционного управления 
можно получить с планшета или 
компьютера по сетевому подключению.
Дистанционное управление по веб-
интерфейсу позволяет дистанционно 
управлять видеокамерой. Можно запускать 
и останавливать съемку или настраивать 
параметры съемки с подключенного 
устройства. Эта функция удобна для 
установки видеокамеры в удаленном месте, 
например в верхней точке крана и т. п.

Экран Camera Control

Экран Main

ˎˎ Состояние
ˎˎ Кнопка запуска и остановки съемки
ˎˎ Ползунок фильтра ND
ˎˎ Ползунок диафрагмы
ˎˎ Ползунок фокусировки
ˎˎ Ползунок масштабирования
ˎˎ Настройки съемки (режим съемки SDR 
или HDR (стр. 28)) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 
Gain, Gamma, Shutter Category, White 

Mode, Base Sensitivity, Auto ND Filter, Auto 
Iris, AGC, Color Bars, Focus Mode, Auto 
White
ˎˎ Настройки съемки (режим съемки Cine EI) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 
Exposure Index, Color Gamut/Gamma, 
Shutter Category, White Mode, Base ISO, 
Auto ND Filter, Auto Iris, AGC, Color Bars, 
Focus Mode, Monitor LUT, Auto White

Экран Playback

ˎˎ Состояние
ˎˎ Кнопки управления воспроизведением 
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Экран Cursor

ˎˎ Состояние
ˎˎ Кнопки управления курсором, 
отображение меню/состояния 
Вверх, Влево, Set, Вправо, Вниз, Cancel/
Back, Menu, User Menu, Thumbnail, Status

Экран Assign

ˎˎ Состояние
ˎˎ Отображение программируемых кнопок 
Программируемые кнопки 1–10, кнопка 
Focus Hold

Отображение дистанционного 
управления по веб-интерфейсу

1 Подключите устройство к видеокамере 
по сетевому подключению (стр. 57).

2 Запустите браузер на устройстве, затем 
откройте “http://IP-адрес 
видеокамеры/rm.html.”
Например, если используется IP-адрес 
192.168.122.1, введите в адресную строку 
“http://192.168.122.1/rm.html”.
IP-адрес видеокамеры можно 
проверить на экране Network Status 
(стр. 16).

3 Введите имя пользователя и пароль 
(Access Authentication >User Name и 
Password в меню Network).
Когда подключение будет установлено, 
на устройстве откроется экран веб-
интерфейса дистанционного 
управления.
Экран Wi-Fi Remote служит для 
управления видеокамерой.

Если перетащить переключать Lock 
вправо, кнопки будут недоступны.

[Примечания]
ˎˎ Экран дистанционного управления по веб-

интерфейсу может не соответствовать настройкам 
видеокамеры в следующих случаях. Если это 
произошло, перезагрузите окно браузера.
 – Если видеокамера перезапускается во время 

установления подключения
 – Если во время установления подключения 

нажимается какая-либо кнопка на видеокамере
 – Если устройство было подключено повторно
 – Если была использована кнопка “Назад” или 

“Вперед” браузера
ˎˎ Дистанционное управление по веб-интерфейсу 

может не работать при слабом беспроводном 
сигнале.

Устройства, поддерживающие 
дистанционное управление по 
веб-интерфейсу

Для настройки видеокамеры и управления 
ею можно использовать планшет или 
компьютер.
В следующей таблице приведены 
поддерживаемые устройства, ОС и 
браузеры.

Устройство ОС Браузер

Планшет Android 7/8 Chrome

iOS 12 Safari

Компьютер Windows 
7/8.1/10

Chrome

macOS 
10.13/10.14

Safari

Подробные сведения об устройствах, 
поддерживаемых с помощью приложения 
“Content Browser Mobile”, можно получить 
у представителя службы технического 
обслуживания компании Sony.

http://IP-адрес видеокамеры/rm.html
http://IP-адрес видеокамеры/rm.html
http://192.168.122.1/rm.html
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Меню дистанционного 
управления по веб-интерфейсу

При нажатии  в левом верхнем углу 
экрана открывается меню выбора 
экрана. Выберите Monitoring Settings для 
отображения экрана Monitoring Settings.
При нажатии  в левом верхнем углу 
экрана Monitoring Settings открывается 
меню настройки для таких задач, как 
передача файлов.

Пункты меню
ˎˎ Remote Control 
Camera Control
ˎˎ Monitoring 
Monitoring Settings
ˎˎ File Transfer 
Slot A 
Slot B 
Slot SD/MS 
Job List 
Upload Settings

Настройки мониторинга видео 
(Monitoring Settings)

При мониторинге на устройстве можно 
задать формат.

Size
Задание размера изображения и скорости 
потока данных видео для мониторинга.
ˎˎ 480×270(1Mbps)
ˎˎ 480×270(0.5Mbps)

Frame Rate
Отображение частоты кадров видео для 
мониторинга.

Настройки передачи файлов (Upload 
Settings)

Можно изменить настройки сервера для 
отправки файла прокси или оригинального 
файла, записанных видеокамерой.

Регистрация целевого сервера
Выберите сервер в списке Upload Server 
и нажмите Edit для отображения экрана 
настройки сервера, затем задайте все 
параметры для регистрации сервера.
Сервер можно также зарегистрировать с 
помощью пункта File Transfer (стр. 119) в 
меню Network.
При отправке файла настроенный здесь 
сервер будет отображаться в списке 
передачи файлов на экранах Slot A, Slot B и 
Slot SD/MS.

Экран Upload Server Edit

Нажмите OK, чтобы применить настройки. 
Нажмите Cancel, чтобы отменить настройки.
Service
Отображается тип сервера.
“FTP”: FTP-сервер
Display Name
Введите имя сервера для отображения в 
списке.
Host Name
Введите адрес сервера.
Port
Введите номер порта для подключения к 
серверу.
User Name
Введите имя пользователя.
Password
Введите пароль.

[Примечания]
ˎˎ По соображениям безопасности при открытии 

экрана Edit пароль очищается. Введите опять, если 
настройки сервера изменились.
ˎˎ С точки зрения безопасности рекомендуется 

задавать в качестве пароля достаточно длинную 
строку символов, чтобы его было трудно угадать 
другим людям; кроме того, рекомендуется хранить 
пароль в безопасном месте.

Display Password
Отображение или скрытие пароля.

Если задано значение Off, настроенный 
пароль не отображается. При вводе пароля 
все символы отображаются звездочками.
Если задано значение On, настроенный 
пароль отображается. При вводе пароля 
все символы отображаются.
Passive Mode
Включение и выключение пассивного 
режима.
Destination Directory
Введите каталог на целевом сервере.

[Примечание]
Если в целевой каталог введены символы, 
недопустимые на целевом сервере, файлы будут 
переданы в главный каталог пользователя. 
Недопустимые символы зависят от сервера.

Using Secure Protocol
Задает, требуется ли выполнять безопасную 
отправку по FTP. При задании значения ON 
отображается состояние сертификата.
Чтобы импортировать или очистить 
сертификат, нажмите Select Function и 
выберите задачу в отображаемом меню.
ˎˎ Load 
Загрузка сертификата CA.

* Загружаемый сертификат должен быть в 
формате PEM и должен записываться в 
корневой каталог SD-карты с именем файла 
“certification.pem”.

ˎˎ Clear 
Удаление сертификата CA.
ˎˎ None 
Не загружать и не удалять сертификат.

[Примечание]
Перед импортом сертификата CA установите 
правильное время на часах видеокамеры.

Изменение настроек зарегистрированного 
сервера
На экране Upload Settings выберите сервер, 
настройки которого требуется изменить, 
затем нажмите Edit. На отображенном 
экране внесите необходимые изменения 
в настройки.
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Сервер можно также задать с помощью 
пункта File Transfer (стр. 119) в меню 
Network.

Автоматическая отправка файла прокси
Auto Upload On/Off
Когда для параметра Auto Upload On/
Off задано значение On и видеокамера 
подключена к Интернету, после съемки 
видеокамера автоматически отправляет 
файл прокси в пункт назначения передачи, 
заданный с помощью параметра Default 
Upload Server.
Default Upload Server
Выберите целевой сервер передачи 
файлов по умолчанию.

Управление передачей файлов (File 
Transfer)

Можно передавать оригинальные файлы, 
записанные на карту памяти XQD, или 
файлы прокси, записанные на SD-карту, 
управлять передачей файлов и настраивать 
пункт назначения передачи файлов.

Передача файлов (Slot A, Slot B, Slot SD/MS)
Можно вывести на экран список клипов, 
записанных на носитель в гнезде A или B, 
а также список файлов прокси, записанных 
на носитель в гнезде для карт памяти 
UTILITY SD/MS.

Выбрав отображаемый файл, можно 
отправить его на сервер по Интернету.

Отправка файла прокси с карты памяти SD

1 Подключите устройство к видеокамере 
по ЛВС (стр. 57).

2 Запустите браузер на устройстве и 
откройте веб-интерфейс 
дистанционного управления (стр. 67).

3 Откройте экран списка файлов, чтобы 
выбрать файл.
Нажмите  >File Transfer >Slot SD/MS.
Открывается экран списка файлов для 
носителя в гнезде для карты памяти 
UTILITY SD/MS.

4 Выберите файл для отправки.
Нажмите файл, чтобы выбрать его. Для 
отмены нажмите файл еще раз.
Можно дважды нажать файл, чтобы 
запустить его воспроизведение и 
проверить содержимое (только карта 
памяти SD).

5 Нажмите Transfer.
Отображается сервер, заданный в 
параметре Default Upload Server в 
разделе “Регистрация целевого 
сервера” (стр. 68).
Для изменения сервера нажмите 
сервер, чтобы открыть список серверов, 
затем выберите нужный сервер.
Если требуется, введите имя каталога 
на сервере в поле Directory.

6 Нажмите Transfer.
Видеокамера начинает отправку 
выбранного файла.
Чтобы отменить отправку, нажмите 
Cancel.

Отправка оригинального файла с карты 
памяти XQD

[Совет]
Чтобы можно было просматривать информацию 
о файлах, находящихся на карте памяти XQD, крышка 
гнезда для карты памяти XQD должна быть закрыта.

1 Подключите устройство к видеокамере 
по ЛВС (стр. 57).

2 Запустите браузер на устройстве и 
откройте веб-интерфейс 
дистанционного управления (стр. 67).

3 Откройте экран списка файлов, чтобы 
выбрать файл.
Нажмите  >File Transfer >Slot A или 
Slot B.
Открывается экран списка файлов для 
носителя в гнезде A или B.
Пример: экран Slot A

4 Выберите файл для отправки.
Нажмите файл, чтобы выбрать его. Для 
отмены нажмите файл еще раз.

5 Нажмите Transfer.
Отображается сервер, заданный в 
параметре Default Upload Server в 
разделе “Регистрация целевого 
сервера” (стр. 68).
Для изменения сервера нажмите 
сервер, чтобы открыть список серверов, 
затем выберите нужный сервер.
Если требуется, введите имя каталога 
на сервере в поле Directory.

6 Нажмите Transfer.
Видеокамера начинает отправку 
выбранного файла.
Чтобы отменить отправку, нажмите 
Cancel.

Проверка передачи файлов (Job List)
Можно проверить список файлов для 
отправки, проверить отправляемый файл, 
отменить или запустить отправку файла и 
удалить файл из списка файлов.
Видеокамера поддерживает функцию 
возобновления передачи по FTP 
(возобновление отправки файла, передача 
которого была приостановлена).
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ˎˎ Total: ход выполнения отправки для всех 
файлов, заданных для отправки.
ˎˎ Status: ход выполнения отправки 
текущего передаваемого файла.
ˎˎ Remain Time: примерное оставшееся 
время отправки.
ˎˎ Transfer data rate: индикация скорости 
передачи.

Отмена или запуск отправки или удаление 
файла из списка файлов

1 Выберите файл.

2 Нажмите  в правом верхнем углу 
экрана и выберите пункт.
ˎˎ Abort selected: отмена отправки 
выбранного файла.
ˎˎ Delete from list: удаление выбранного 
файла из списка.
ˎˎ Start selected: запуск отправки 
выбранного файла.
ˎˎ Clear completed: удаление списка 
отправленных файлов.
ˎˎ Select All: выбор всех файлов в списке.
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Экран эскизов
Экран эскизов открывается при нажатии кнопки THUMBNAIL (стр. 7). На экране эскизов в виде эскизов (индексных изображений) отображаются клипы, хранящиеся на картах памяти 
XQD.
На экране эскизов можно выбрать клип и запустить его воспроизведение. Изображение может воспроизводиться в видоискателе или на внешнем мониторе.
При повторном нажатии кнопки THUMBNAIL экран эскизов будет закрыт и в видоискателе снова появится передаваемое камерой изображение.

[Примечание]
На экране эскизов отображаются только клипы, записанные в выбранном в данный момент формате. Если нужного клипа нет на экране, проверьте формат записи. На это следует обращать особое внимание перед 
форматированием (инициализацией) носителя.

Компоновка экрана

В нижней части экрана отображается информация о клипе, на который наведен курсор.

4 5

6

3

1

2

Индикатор текущей выбранной карты памяти XQD
(Если карта памяти защищена, отображается значок замка.)

Курсор (желтый)

Номер клипа/общее количество клипов

1. Эскиз (индексное изображение)
Отображает индексное изображение 
клипа. После записи клипа его первый 
кадр автоматически задается в качестве 
индексного изображения.
Информация о клипе/кадре отображается 
под эскизом. Для изменения отображаемой 
информации служит пункт Customize 

View (стр. 111) >Thumbnail Caption меню 
Thumbnail.

2. Название клипа
Отображает имя выбранного клипа.

3. Формат записи видео
Отображает формат файла выбранного 
клипа.

4. Информация об особой записи
Отображает режим записи, но только в том 
случае, если клип был записан в особом 
режиме.
В отношении клипов, записанных в режиме 
с замедлением/ускорением движения, 
справа отображается частота кадров.

5. Длительность клипа

6. Дата создания
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Воспроизведение клипов

Воспроизведение записанных 
клипов

Воспроизводить записанные клипы можно, 
когда видеокамера находится в режиме 
ожидания записи (Stby).

1 Вставьте карту памяти XQD, с которой 
требуется воспроизвести клип.

2 Нажмите кнопку THUMBNAIL.

3 С помощью кнопок со стрелками 
(стр. 7) или многофункционального 
диска (стр. 4) переместите курсор 
на эскиз клипа, который требуется 
воспроизвести.

4 Нажмите кнопку SET или 
многофункциональный диск.
Воспроизведение начнется с начала 
выбранного клипа.

Управлять воспроизведением можно с 
помощью следующих кнопок.
Нажмите кнопку SET или 

многофункциональный диск: 
Приостановка воспроизведения.  
Нажмите его еще раз, чтобы 
возобновить воспроизведение.

Нажмите кнопку с левой/правой стрелкой: 
Переход в начало клипа/начало 
следующего клипа.

Нажмите и удерживайте кнопку с левой/
правой стрелкой: 
Перемотка назад/вперед.  
Воспроизведение возобновится, когда 
кнопка будет отпущена.

Кнопка CANCEL/BACK: 
Остановка воспроизведения и возврат 
в режим ожидания записи.

[Примечания]
ˎˎ На границе между клипами изображение 

может прерываться или замирать. Управлять 
видеокамерой в течение такого периода нельзя.
ˎˎ После выбора клипа на экране эскизов и 

начала воспроизведения может наблюдаться 
кратковременный разрыв изображения в 
начале клипа. Чтобы начать воспроизведение 
без искажений с начала клипа, приостановите 
воспроизведение после его начала, нажмите 
кнопку с левой стрелкой для возврата к началу 
клипа, затем снова запустите воспроизведение.
ˎˎ Можно также использовать многофункциональный 

селектор (стр. 9).
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На экране эскизов для управления клипами 
и проверки их свойств служит меню 
Thumbnail.
Меню Thumbnail (стр. 110) открывается 
при нажатии кнопки MENU и выборе 
Thumbnail.

Операции меню Thumbnail

Кнопками со стрелками (стр. 7) или 
многофункциональным диском (стр. 4) 
выберите функцию, затем нажмите кнопку 
SET или многофункциональный диск.
Нажмите кнопку CANCEL/BACK (стр. 7), 
чтобы вернуться на предыдущий экран.

[Совет]
Можно также использовать многофункциональный 
селектор (стр. 9).

[Примечание]
В зависимости от состояния видеокамеры в момент 
отображения меню некоторые его пункты будут 
недоступны для выбора.

Пункты меню для операций с 
клипами

ˎˎ Display Clip Properties
ˎˎ Set Shot Mark
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Copy Clip
ˎˎ Copy Sub Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Set Index Picture
ˎˎ Thumbnail View
ˎˎ Filter Clips
ˎˎ Customize View

Подробные сведения о пунктах меню 
операций с клипами см. в разделе меню 
Thumbnail (стр. 110).

Отображение свойств клипа

Чтобы открыть экран свойств, выберите 
пункт Display Clip Properties (стр. 110) в 
меню Thumbnail.

Отображение экрана эскизов 
основных меток

Выберите пункт Thumbnail View (стр. 111) 
>Essence Mark Thumbnail в меню Thumbnail, 
после чего выберите тип основных меток, 
чтобы отобразить представление эскизов 
кадров с указанной основной меткой.
Для отображения всех клипов задайте для 
параметра Thumbnail View >Essence Mark 
Thumbnail в меню Thumbnail значение All.

Отображение экрана эскизов 
отфильтрованных клипов

Выберите пункт Filter Clips (стр. 111) в 
меню Thumbnail, после чего выберите тип 
флага клипа, чтобы вывести на экран только 
те клипы, у которых есть указанный флаг.
Для отображения всех клипов выберите All.

[Совет]
Можно также последовательно переключать 
фильтры с помощью кнопки DISPLAY.

Удаление клипов

Клипы можно удалять с карты памяти XQD.
Выберите пункт Delete Clip >Select Clip или 
All Clips в меню Thumbnail.
Select Clip: 

Удаление выбранных клипов. Можно 
выбрать несколько клипов.

All Clips: 
Удаление всех отображаемых на экране 
клипов.

Изменение информации, 
отображаемой на экране эскизов

Информацию о клипе/кадре, 
отображаемую под эскизом, можно 
изменить.
Выберите пункт Customize View >Thumbnail 
Caption в меню Thumbnail, а затем выберите 
информацию, которая будет отображаться.
Date Time: 

Отображение даты и времени создания 
клипа и его последнего изменения.

Time Code: 
Отображение временного кода.

Duration: 
Отображение длительности клипа.

Sequential Number: 
Отображение порядкового номера 
каждого эскиза.

Операции с клипами
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Конфигурация и иерархия меню настройки
Нажмите кнопку MENU, чтобы открыть меню 
настройки в видоискателе для задания 
различных параметров съемки, записи и 
воспроизведения (это меню также можно 
вывести на внешний монитор). Меню 
настройки состоит из следующих меню.

Конфигурация меню

Меню User
Содержит пункты меню, которые 
пользователь настраивает с помощью 
Edit User Menu.

Меню Edit User
Содержит пункты меню, 
предназначенные для изменения меню 
User.

Меню Shooting
Содержит настройки, относящиеся к 
съемке.

Меню Project
Содержит базовые настройки проекта.

Меню Paint
Содержит настройки, относящиеся к 
качеству изображения.

Меню TC/Media
Содержит настройки, относящиеся к 
временным кодам и носителю для 
записи.

Меню Monitoring
Содержит настройки, относящиеся к 
выводу видео и индикации в 
видоискателе.

Меню Audio
Содержит настройки, относящиеся к 
звуку.

Меню Thumbnail
Содержит настройки, относящиеся к 
экрану эскизов.

Меню Technical
Содержит настройки для технических 
параметров.

Меню Network
Содержит настройки, относящиеся к 
сети.

Меню Maintenance
Содержит настройки устройств, такие 
как часты и язык.

Иерархия меню настройки

User 
(Заводские 
настройки)

Base Setting

Rec Format

ISO/Gain/EI

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Picture Cache Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

Output Format

VF Setting

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Monitor 3D LUT

Noise Suppression

Flicker Reduce

SteadyShot

Auto Black Balance

Project Base Setting

Rec Format

Cine EI Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Planning Metadata

Paint HDR Paint Setting

Black

Gamma

Black Gamma

Knee

White Clip

Detail(4K/QFHD)

Detail(HD)

Skin Detail

Aperture

Matrix

Multi Matrix

Scene File

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Setting

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output
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Thumbnail Display Clip Properties

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Copy Clip

Copy Sub Clip

Transfer Clip

Transfer Clip (Proxy)

Set Index Picture

Thumbnail View

Filter Clips

Customize View

Technical Color Bars

Test Saw

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Handle Zoom

GPS

Menu Settings

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

Network Client Mode

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Операции меню настройки
Нажмите кнопку MENU, чтобы открыть меню 
настройки в видоискателе для задания 
различных параметров съемки, записи и 
воспроизведения (это меню также можно 
вывести на внешний монитор).

Элементы управления меню

Кнопка MENU (стр. 7)
Открывает и закрывает меню 
настройки на экране.

Кнопка ////SET (стр. 7)
Кнопками со стрелками перемещайте 
курсор вверх, вниз, влево и вправо для 
выбора пунктов меню или настроек.
Чтобы применить выбранный элемент, 
нажмите кнопку SET.

 [Совет]
Таким же образом можно также использовать 
многофункциональный селектор (стр. 9).

Многофункциональный диск (стр. 4)
Многофункциональный диск служит 
для перемещения курсора вверх и вниз 
с целью выбора элементов меню или 
настроек.
Чтобы применить выбранный элемент, 
нажмите многофункциональный диск.

Кнопка CANCEL/BACK (стр. 7)
Нажмите для возврата к предыдущему 
меню. Незавершенное изменение 
отменяется.

[Примечания]
ˎˎ Меню настройки недоступно в режиме увеличения 

области фокусировки (стр. 38).
ˎˎ В зависимости от состояния видеокамеры в 

момент отображения меню некоторые его пункты 
будут недоступны для выбора.
ˎˎ Сенсорные операции не поддерживаются.

Пункты меню настройки

Нажимая кнопки со стрелками или 
поворачивая многофункциональный диск, 
переместите курсор на нужный пункт 
меню, затем нажмите кнопку SET или 
многофункциональный диск, чтобы выбрать 
этот пункт.
ˎˎ В области выбора пунктов меню 
отображается до восьми строк. Если все 
доступные для пункта меню параметры 
не умещаются на экране, прокрутите 
список, перемещая курсор вверх/вниз.
ˎˎ Для вложенных пунктов с широким 
диапазоном возможных значений 
(например, от –99 до +99), область 
параметров не отображается. Текущее 
значение выделяется, что указывает на 
возможность изменения значения.
ˎˎ Если выбрать [Execute] для функции, эта 
функция будет выполнена.
ˎˎ Если выбрать пункт, перед выполнением 
которого требуется подтверждение, 
то меню будет временно скрыто и 
откроется сообщение о подтверждении. 
Ознакомьтесь с сообщением, после чего 
выберите выполнение функции или 
отмену.

Ввод строки символов

При выборе элемента, например, имени 
файла, для которого требуется ввести 
символы, открывается экран ввода 
символов.

1

2 3

1 Нажимая кнопки со стрелками или 
поворачивая многофункциональный 
диск, выберите тип символов, затем 
примените настройку.
ABC: буквенные символы в верхнем 
регистре
abc: буквенные символы в нижнем 
регистре
123: цифровые символы
!#$: особые символы

2 Выберите символ заданного типа, 
затем примените настройку.
Курсор переместится в следующее 
поле.

Space: ввод символа пробела в 
положении курсора.

/: перемещение положения 
курсора.

BS: удаление символа, расположенного 
слева от курсора (backspace).

3 После завершения выберите [Done] и 
примените настройку.

Строка символов будет подтверждена, 
а экран ввода символов закроется.

Блокировка и отмена 
блокировки меню

Меню настройки можно заблокировать, 
чтобы отображалось только меню User.
Настройки на экране состояния также 
нельзя изменить.

Блокировка меню

1 Нажав и удерживая 
многофункциональный диск, нажмите 
кнопку MENU.

2 Выберите Menu Settings >User Menu 
with Lock в меню Technical.

 [Примечание]
При нажатии только кнопки MENU для 
отображения обычного меню настройки в пункте 
Menu Settings меню Technical отображается 
пункт User Menu Only. Нажмите и удерживайте 
многофункциональный диск и нажмите кнопку 
MENU для отображения пункта User Menu with 
Lock.

3 Задайте значение On и нажмите кнопку 
SET или многофункциональный диск.
Экран видоискателя переключается на 
экран ввода цифрового пароля.

4 Введите произвольное число.
Введите 4-значное число в диапазоне 
от 0000 до 9999. Значение по 
умолчанию — 0000.
Введите цифру и нажмите кнопку SET 
или многофункциональный диск для 
перемещения курсора на следующую 
цифру.
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После ввода всех цифр переместите 
курсор на SET.

5 Нажмите кнопку SET или 
многофункциональный диск.
Ввод применен.
Отображается сообщение 
подтверждения, и экран переключается 
на экран меню User.

Отмена блокировки меню

1 Нажав и удерживая 
многофункциональный диск, нажмите 
кнопку MENU.

2 Выберите Menu Settings >User Menu 
with Lock в меню User.

 [Примечание]
При нажатии только кнопки MENU для 
отображения обычного меню настройки в пункте 
Menu Settings меню Technical отображается 
пункт User Menu Only. Нажмите и удерживайте 
многофункциональный диск и нажмите кнопку 
MENU для отображения пункта User Menu with 
Lock.

3 Задайте значение Off и нажмите кнопку 
SET или многофункциональный диск.
Экран видоискателя переключается на 
экран ввода цифрового пароля.

4 Введите цифровой пароль, который 
использовался для блокировки меню.
Введите цифру и нажмите кнопку SET 
или многофункциональный диск для 
перемещения курсора на следующую 
цифру.
После ввода всех цифр переместите 
курсор на Set.

5 Нажмите кнопку SET или 
многофункциональный диск.

Ввод применен.
Если введенный цифровой пароль 
соответствует цифровому паролю, 
использованному для блокировки 
меню, блокировка меню отменяется и 
отображается меню.

[Примечания]
ˎˎ Если введенный цифровой пароль 

не соответствует цифровому паролю, 
использованному для блокировки меню, 
блокировка меню не отменяется.
ˎˎ Рекомендуется записать цифровой пароль и 

держать его под рукой на случай, если вы забудете 
цифровой пароль. Если вы все-таки забудете 
цифровой пароль, обратитесь к представителю 
службы технического обслуживания компании 
Sony.
ˎˎ Если меню настройки заблокировано, а пункты 

меню настройки из приведенных ниже таблиц 
не зарегистрированы в меню User, эти функции 
не могут быть назначены программируемым 
кнопкам.
ˎˎ Если эти функции уже назначены 

программируемым кнопкам, при блокировке 
меню программируемая настройка принудительно 
отключается.

Пункт меню настройки Выбор 
программируемых 
кнопок

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Пункт меню настройки Выбор 
программируемых 
кнопок

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Пункт меню настройки Выбор 
программируемых 
кнопок

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >Network 
Client Mode >Setting

Network Client 
Mode

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Меню User
В этом разделе приводится описание предназначения и настроек каждого пункта меню.

User

Пункт Описание

Base Setting Пункт Project >Base Setting

Rec Format Пункт Project >Rec Format

ISO/Gain/EI Пункт Shooting >ISO/Gain/EI

Focus Пункт Shooting >Focus

S&Q Motion Пункт Shooting >S&Q Motion

Monitor LUT Пункт Shooting >Monitor LUT

Monitor LUT Setting Пункт Shooting >Monitor LUT Setting

Simul Rec Пункт Project >Simul Rec

4K & HD (Sub) Rec Пункт Project >4K & HD (Sub) Rec

Proxy Rec Пункт Project >Proxy Rec

Picture Cache Rec Пункт Project >Picture Cache Rec

Assignable Button Пункт Project >Assignable Button

Assignable Dial Пункт Project >Assignable Dial

Multi Function Dial Пункт Project >Multi Function Dial

All File Пункт Project >All File

Clip Name Format Пункт TC/Media >Clip Name Format

Format Media Пункт TC/Media >Format Media

Output Format Пункт Monitoring >Output Format

VF Setting Пункт Monitoring >VF Setting

Menu Settings Пункт Technical >Menu Settings

Edit User Menu Отображение экрана меню Edit User.

[Примечание]
С помощью меню Edit User можно добавлять пункты меню в меню User и удалять их из того меню. Можно 
настроить не более 20 пунктов. По умолчанию в видеокамере настроены 20 пунктов. Чтобы добавить пункт, 
сначала необходимо удалить существующий пункт с помощью команды Delete в меню Edit User, затем 
добавить пункт с помощью команды Add Item.
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Меню Edit User
Меню Edit User отображается на верхнем уровне, когда в меню User выбирается пункт Edit 
User Menu.

Edit User

Пункт Настройка подпункта Описание

Add Item
Добавление пункта в 
меню User

Добавление пункта в меню User.

Customize Reset
Сброс пунктов в меню 
User

Восстановление пунктов, которые 
содержатся в меню User по 
умолчанию.

Пункт меню, 
выбранный во время 
редактирования

Delete Удаление зарегистрированного 
пункта из меню User.

Move Изменение расположения 
зарегистрированных пунктов в 
меню User.

Edit Sub Item Изменение (регистрация/
удаление) зарегистрированных 
подпунктов в меню User.
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Меню Shooting
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

Mode ISO/dB Выбор режима настройки усиления.

ISO/Gain<H> Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение High:

ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение Low:

ISO 320 / ISO 400 / ISO 500 / ISO 640 / 
ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение High:

ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Задание предварительно 
установленного значения усиления 
<H>.

[Совет]
Динамический диапазон определяется 
значением гамма. Гамма-кривая в режиме 
HDR имеет тип HLG.

Гамма Динамический 
диапазон

STD / HG1 / HG2 /  
HG3 / HG4 / 
S-Cinetone

460%

HG7 / HG8 800%

S-Log3 / HLG 1300%

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

ISO/Gain<H> Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение Low:

ISO 500 / ISO 640 / ISO 800 / ISO 1000 
/ ISO 1250 / ISO 1600 / ISO 2000 /  
ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000

Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение High:

ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение Low:

ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Когда для параметра Mode установлено 
значение dB:

От –3dB до 27dB (12dB) (шаг 1dB)
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Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

ISO/Gain<M> (Такие же значения, как для ISO/
Gain<H>)
Значения по умолчанию указаны ниже.
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение High:

ISO 3200
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение Low:

ISO 640
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение High:

ISO 5000
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение Low:

ISO 1000
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение High:

ISO 8000
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение Low:

ISO 1600
Когда для параметра Mode установлено 
значение dB:

6dB

Задание предварительно 
установленного значения усиления 
<M>.

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

ISO/Gain<L> (Такие же значения, как для ISO/
Gain<H>)
Значения по умолчанию указаны ниже.
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение High:

ISO 1600
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение Low:

ISO 320
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение High:

ISO 2500
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение Low:

ISO 500
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение High:

ISO 4000
Когда для параметра Mode задано 
значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение Low:

ISO 800
Когда для параметра Mode установлено 
значение dB:

0dB

Задание предварительно 
установленного значения усиления 
<L>.
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Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

Exposure 
Index<H>

Когда для параметра Base ISO задано 
значение ISO 800:

200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Когда для параметра Base ISO задано 
значение ISO 4000:

1000EI / 4.0E
1250EI / 4.3E
1600EI / 4.7E
2000EI / 5.0E
2500EI / 5.3E
3200EI / 5.7E
4000EI / 6.0E
5000EI / 6.3E
6400EI / 6.7E
8000EI / 7.0E
10000EI / 7.3E
12800EI / 7.7E
16000EI / 8.0E

Установка значения индекса 
экспозиции <H>.
Доступно только в режиме Cine EI.

Exposure 
Index<M>

(Такие же значения, как для Exposure 
Index<H>)
Когда для параметра Base ISO задано 
значение ISO 800:

1000EI / 6.3E
Когда для параметра Base ISO задано 
значение ISO 4000:

5000EI / 6.3E

Установка значения индекса 
экспозиции <M>.

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание

Exposure 
Index<L>

(Такие же значения, как для Exposure 
Index<H>)
Когда для параметра Base ISO задано 
значение ISO 800:

800EI / 6.0E
Когда для параметра Base ISO задано 
значение ISO 4000:

4000EI / 6.0E

Установка значения индекса 
экспозиции <L>.

Shockless 
Gain

On / Off Включение или выключение функции 
плавного усиления.

Base 
Sensitivity

High / Low Задает базовую чувствительность для 
режима SDR/HDR.

Base ISO ISO 4000 / ISO 800 Задает базовую чувствительность ISO 
для режима Cine EI.

Shooting >ND Filter
Задание предварительно установленных значений для фильтра нейтральной плотности.

Пункт Настройка подпункта Описание

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 1 для 
фильтра нейтральной плотности.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 2 для 
фильтра нейтральной плотности.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 3 для 
фильтра нейтральной плотности.

Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

Mode Speed / Angle Выбор режима работы электронного 
затвора.
Служит для четкой съемки быстро 
движущихся объектов. Выбор режима 
для задания скорости затвора в 
секундах (Speed) или в виде угла 
раскрытия затвора (Angle).
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Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

Shutter 
Speed On/
Off

On / Off Задает, будет ли время экспозиции при 
выбранном режиме Speed следовать 
значению Shutter Speed или будет 
устанавливаться полная экспозиция.

Shutter 
Speed

64F – 1/8000
Возможные значения зависят от частоты 
кадров выбранного формата видео.
59.94P / 59.94i: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P / 50i: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Установка выдержки, когда параметру 
Mode задано значение Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /  
3F / 2F / 360.0° / 300.0° / 270.0° /  
240.0° / 216.0° / 210.0° / 180.0° / 172.8° / 
150.0° / 144.0° / 120.0° / 90.0° / 86.4° / 
72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Установка угла раскрытия затвора, 
когда параметру Mode задано 
значение Angle.

ECS On/Off On / Off Включение и выключение функции 
Extended Clear Scan.

Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

ECS 
Frequency

От 23.99 до 8000
Возможные значения зависят от частоты 
кадров выбранного формата видео.
Значения по умолчанию указаны ниже.
59.94P: 60.00
59.94i: 60.00
50P: 50.00
50i: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Установка частоты ECS, когда 
параметру Mode задано значение ECS.

Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 /  
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Установка уровня яркости для 
автоматически определяемой 
экспозиции.

Mode Backlight / Standard / Spotlight Задает режим работы автоматической 
настройки экспозиции.
Backlight: 

Режим фоновой подсветки (режим 
для сокращения затемнения 
объекта съемки, когда он освещен 
сзади)

Standard: 
Стандартный режим

Spotlight: 
Режим точечной подсветки (режим 
для сокращения областей 
усеченного белого, когда объект 
съемки освещен точечным 
источником)

Speed От –99 до +99 (±0) Задает скорость регулировки для 
автоматической настройки 
экспозиции.

AGC On / Off Включение и выключение функции AGC 
(Auto Gain Control — Автоматическая 
регулировка усиления).
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Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

AGC Limit Когда параметру ISO/Gain/EI >Mode 
задано значение dB:

3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 
21dB / 24dB / 27dB

Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение High:

ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 460%, а для параметра Base 
Sensitivity задано значение Low:

ISO 400 / ISO 500 / ISO 640 / ISO 800 / 
ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение High:

ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 800%, а для параметра 
Base Sensitivity задано значение Low:

ISO 640 / ISO 800 / ISO 1000 / ISO 1250 / 
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Установка максимального усиления 
функции AGC.

Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

AGC Limit Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение High:

ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Когда для параметра ISO/Gain/EI >Mode 
задано значение ISO с динамическим 
диапазоном 1300%, а для параметра 
Base Sensitivity задано значение Low:

ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

AGC Point Когда для параметра Lens >Iris Display 
в меню Technical задано значение 
F-Number или когда для параметра Iris 
Display задано значение Auto, а из 
установленного объектива невозможно 
получить сведения о значении T:

F2.8 / F4 / F5.6
Когда для параметра Lens >Iris Display 
в меню Technical задано значение Auto и 
из установленного объектива можно 
получить сведения о значении T:

T2.8 / T4 / T5.6

Задает диафрагменное число, на 
котором начинается работа функции 
AGC, когда функция AGC включена.

Auto Shutter On / Off Включение или выключение функции 
автоматического управления 
затвором.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Установка самой быстрой скорости 
затвора функции автоматического 
управления затвором.
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Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

A.SHT Point Когда для параметра Lens >Iris Display 
в меню Technical задано значение 
F-Number или когда для параметра Iris 
Display задано значение Auto, а из 
установленного объектива невозможно 
получить сведения о значении T:

F5.6 / F8 / F11 / F16
Когда для параметра Lens >Iris Display 
в меню Technical задано значение Auto и 
из установленного объектива можно 
получить сведения о значении T:

T5.6 / T8 / T11 / T16

Задает диафрагменное число, на 
котором начинает работать функция 
автоматического управления 
затвором.

Clip High 
light

On / Off Включение или выключение функции, 
которая игнорирует самые яркие 
области для обеспечения плавного 
отклика на высокую яркость.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Установка диапазона экспозиметра 
для автоматической регулировки 
экспозиции в соответствии с яркостью 
объекта съемки. (Недоступно при 
регулировке экспозиции вручную)

Detect 
Window 
Indication

On / Off Включение и выключение индикации 
диапазона экспозамера.

Average Peak 
Level Ratio

От –99 до +99 (±0) Задание отношения среднего и 
пикового значений видеосигнала, 
используемого для функции 
обнаружения Auto Exposure.

Custom 
Width

От 40 до 999 (500) Задание ширины диапазона 
экспозамера.

Custom 
Height

От 70 до 999 (500) Задание высоты диапазона 
экспозамера.

Custom H 
Position

От –479 до +479 (±0) Задание положения диапазона 
экспозамера по горизонтали.

Custom V 
Position

От –464 до +464 (±0) Задание положения диапазона 
экспозамера по вертикали.

Shooting >White
Задание настроек баланса белого.

Пункт Настройка подпункта Описание

Preset White От 2000K до 15000K (3200K) Установка предварительно заданного 
значения баланса белого.

Color Temp 
<A>

От 2000K до 15000K (3200K) Задание цветовой температуры 
баланса белого, сохраняемой 
в памяти A.

[Примечание]
Поскольку значение параметра Color Temp 
ограничивается величинами 2000K и 
15000K во время работы функции R/B Gain, 
правильное отображение значения Color 
Temp для значения R/B Gain может быть 
невозможно.

Tint<A> От –99 до +99 (±0) Задание значения баланса белого, 
сохраненного в памяти баланса белого A.

[Примечание]
Поскольку во время работы функции 
R/B Gain значение параметра Tint 
ограничивается величинами ±99, 
правильное отображение значения Tint для 
значения R/B Gain может быть невозможно.

R Gain <A> От –99.0 до +99.0 (±0.0) Задание усиления R баланса белого, 
сохраненное в памяти A.

B Gain <A> От –99.0 до +99.0 (±0.0) Задание усиления B баланса белого, 
сохраненное в памяти A.

Color Temp 
<B>

От 2000K до 15000K (3200K) Задание цветовой температуры 
баланса белого, сохраняемой 
в памяти B.

[Примечание]
Поскольку значение параметра Color Temp 
ограничивается величинами 2000K и 
15000K во время работы функции R/B Gain, 
правильное отображение значения Color 
Temp для значения R/B Gain может быть 
невозможно.

Tint<B> От –99 до +99 (±0) Задание значения баланса белого, 
сохраненного в памяти баланса белого B.

[Примечание]
Поскольку во время работы функции 
R/B Gain значение параметра Tint 
ограничивается величинами ±99, 
правильное отображение значения Tint для 
значения R/B Gain может быть невозможно.
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Shooting >White
Задание настроек баланса белого.

Пункт Настройка подпункта Описание

R Gain <B> От –99.0 до +99.0 (±0.0) Задание усиления R баланса белого, 
сохраненное в памяти B.

B Gain <B> От –99.0 до +99.0 (±0.0) Задание усиления B баланса белого, 
сохраненное в памяти B.

Shooting >White Setting
Регулировка настройки баланса белого.

Пункт Настройка подпункта Описание

Shockless 
White

Off / 1 / 2 / 3 Установка скорости отклика баланса 
белого при переключении режима 
баланса белого.
Off: мгновенное переключение.
1–3: чем больше число, тем медленнее 

выполняется переключение.

ATW Speed 1 / 2 / 3 / 4 / 5 Установка скорости реакции в режиме 
ATW.
1: самая быстрая скорость реакции

White 
Switch<B>

Memory / ATW Выбор режима регулировки баланса 
белого, который устанавливается при 
переводе переключателя WHT BAL в 
положение B.

Filter White 
Memory

On / Off Включение функции, которая задает 
область памяти баланса белого для 
каждого включения/выключения 
фильтра ND.
On: установка памяти баланса белого 

для каждого фильтра ND.

 [Совет]
В предустановленном режиме 
предусмотрено четыре настройки 
(CLEAR / 1 / 2 / 3). В переменном режиме 
предусмотрено две настройки (CLEAR / 
On).

Off: установка одного значения 
баланса белого из памяти для всех 
фильтров ND.

Shooting >Offset White
Задание настроек смещения баланса белого.

Пункт Настройка подпункта Описание

Offset White 
<A>

On / Off Указание необходимости добавлять 
(On) или не добавлять (Off) значение 
смещения к значению баланса белого 
из ячейки памяти A.

Offset Color 
Temp<A>

От –99 до +99 (±0) Задание смещения цветовой 
температуры, добавляемого к балансу 
белого из ячейки памяти A, когда 
параметру Offset White <A> задано 
значение On.

[Примечание]
Поскольку во время работы функции R/B 
Gain значение параметра Offset Color 
Temp ограничивается величинами ±99, 
правильное отображение значения Offset 
Color Temp для значения R/B Gain может 
быть невозможно.

Offset 
Tint<A>

От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого из 
ячейки памяти A, когда параметру 
Offset White <A> задано значение On.

[Примечание]
Поскольку во время работы функции 
R/B Gain значение параметра Offset 
Tint ограничивается величинами ±99, 
правильное отображение значения Offset 
Tint для значения R/B Gain может быть 
невозможно.

Offset White 
<B>

On / Off Указание необходимости добавлять 
(On) или не добавлять (Off) значение 
смещения к значению баланса белого 
из ячейки памяти B.

Offset Color 
Temp<B>

От –99 до +99 (±0) Задание смещения цветовой 
температуры, добавляемого к балансу 
белого из ячейки памяти B, когда 
параметру Offset White <B> задано 
значение On.

[Примечание]
Поскольку во время работы функции R/B 
Gain значение параметра Offset Color 
Temp ограничивается величинами ±99, 
правильное отображение значения Offset 
Color Temp для значения R/B Gain может 
быть невозможно.
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Shooting >Offset White
Задание настроек смещения баланса белого.

Пункт Настройка подпункта Описание

Offset 
Tint<B>

От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого из 
ячейки памяти B, когда параметру 
Offset White <B> задано значение On.

[Примечание]
Поскольку во время работы функции 
R/B Gain значение параметра Offset 
Tint ограничивается величинами ±99, 
правильное отображение значения Offset 
Tint для значения R/B Gain может быть 
невозможно.

Offset White 
<ATW>

On / Off Указание необходимости добавлять 
(On) или не добавлять (Off) значение 
смещения к значению баланса белого 
ATW.

Offset Color 
Temp<ATW>

От –99 до +99 (±0) Задание смещения цветовой 
температуры, добавляемого к балансу 
белого ATW, когда параметру Offset 
White <ATW> задано значение On.

Offset 
Tint<ATW>

От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого ATW, 
когда параметру Offset White <ATW> 
задано значение On.

Shooting >Focus
Задание настроек фокусировки.

Пункт Настройка подпункта Описание

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Задание скорости изменения 
фокусировки в случае изменения 
объекта во время автоматической 
фокусировки.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Задание чувствительности изменения 
фокусировки на объект во время 
автоматической фокусировки.

Shooting >Focus
Задание настроек фокусировки.

Пункт Настройка подпункта Описание

Focus Area Wide / Zone / Flexible Spot Установка целевой области для 
автоматической фокусировки и 
автоматической фокусировки при 
нажатой кнопке (AF) (стр. 35).
Wide: 

При фокусировке производит 
поиск объекта по широкому углу 
изображения.

Zone: 
Автоматический поиск точки 
фокусировки в указанной зоне.

Flexible Spot: 
Производит фокусировку на 
указанное положение 
изображения.

Focus Area 
(AF-S)

Flexible Spot Установка целевой области для 
автоматической фокусировки одним 
движением (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Включение/отключение функции AF 
с обнаружением лиц или глаз.

Push AF 
Mode

AF / Single-shot AF(AF-S) Задание режима автофокусировки при 
нажатой кнопке.

AF Assist On / Off Если этому параметру задано 
значение “On”, пользователь может 
временно переопределять автофокус 
и задавать фокус вручную.

Shooting >S&Q Motion
Задание настроек режима замедления/ускорения движения (стр. 48).

Пункт Настройка подпункта Описание

Setting On / Off Включение и выключение режима записи 
с замедлением/ускорением движения.
Когда установлено значение On, 
следующие функции отключены.

 ˎ Автоматическая установка 
диафрагмы

 ˎ Автоматическая фокусировка

Frame Rate 1fps – 60fps / 100fps / 120fps / 150fps / 
180fps

Установка частоты кадров для съемки 
с замедлением/ускорением движения.

[Примечание]
Возможные значения зависят от выбранной 
частоты системы, кодека и формата видео.
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Shooting >Monitor LUT
Задание настроек таблицы соответствия монитора. Доступно только при съемке в режиме 
Cine EI.

Пункт Настройка подпункта Описание

Category LUT / User 3D LUT Выбор категории таблицы 
соответствия монитора.

LUT Select 709(800%) / HG8009G40 / HG8009G33 / 
S-Log3 / s709

Выбор типа таблицы соответствия 
монитора.
709(800%): 

Сигнал с базисной кривой ITU-R709 
с расширенным динамическим 
диапазоном до 800%.

HG8009G40: 
Сигнал, использующий гипергамму 
с динамическим диапазоном 
в 800%, ограничением белого 
в 109% и 18% видео выводом серой 
карты в 40%.

HG8009G33: 
Сигнал, использующий гипергамму 
с динамическим диапазоном 
в 800%, ограничением белого 
в 109% и 18% видео выводом серой 
карты в 33%.

S-Log3: 
Логарифмический сигнал 
с динамическим диапазоном 
в 1300%, который имитирует 
характеристики пленки, близкий 
к логарифмической кривой Cineon.

s709: 
Цвет Cinema, эквивалентный 
709(800%).

[Примечание]
Настройка возможна только в том случае, 
если для параметра Category задано 
значение LUT.

User 3D LUT 
Select

Имя файла (от 01 до 16) 
пользовательских файлов 3D LUT, 
хранящихся во внутренней памяти

Выбор пользовательского файла 3D 
LUT.

[Примечание]
Настройка возможна только в том случае, 
если для параметра Category задано 
значение User 3D LUT.

Shooting >Monitor LUT Setting
Регулировка настроек таблицы соответствия монитора. Доступно только при съемке в 
режиме Cine EI.

Пункт Настройка подпункта Описание

Internal Rec MLUT On / MLUT Off Выбор возможности применения 
таблицы соответствия монитора к 
основному видео, записываемому на 
карты памяти XQD.

Monitor Out MLUT On / MLUT Off Выбор возможности применения 
таблицы соответствия монитора к 
записанному видео и выходу видео, 
отличным от основного видео, 
записанного на карты памяти XQD.

HD(Sub) Rec/
Proxy

Только отображение Показывает, применяется ли таблица 
соответствия монитора к видео HD 
(Sub) и записываемом видео прокси во 
время записи 4K & HD (Sub).

SDI1 Только отображение Показывает, применяется ли таблица 
соответствия монитора к видеовыходу 
SDI1.

SDI2 Только отображение Показывает, применяется ли таблица 
соответствия монитора к видеовыходу 
SDI2.

HDMI Только отображение Показывает, применяется ли таблица 
соответствия монитора к видеовыходу 
HDMI.

VF/Streaming Только отображение Показывает, применяется ли таблица 
соответствия монитора к 
видоискателю и потоковой передаче 
видео.

Shooting >Monitor 3D LUT
Задает параметры пользовательской таблицы соответствия 3D LUT.

Пункт Настройка подпункта Описание

Load SD Card Загрузка данных пользовательской 
таблицы соответствия 3D LUT с  
SD-карты.

Reset Сброс настройки данных 
пользовательской таблицы 
соответствия 3D LUT.

Reset All Execute / Cancel Сброс всех настроек данных 
пользовательской таблицы 
соответствия 3D LUT.
Execute: выполнение функции.
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Shooting >Noise Suppression
Задание настроек шумоподавления.

Пункт Настройка подпункта Описание

Setting 
(SDR/HDR)

On / Off Включение или выключение функции 
подавления шума в режимах SDR и 
HDR.

Level 
(SDR/HDR)

Low / Mid / High Задание уровня подавления шумов 
в режимах SDR и HDR.

Setting 
(Cine EI)

On / Off Включение или выключение функции 
подавления шума в режиме Cine EI.

Level 
(Cine EI)

Low / Mid / High Задание уровня подавления шума в 
режиме Cine EI.

Shooting >Flicker Reduce
Задание настроек коррекции мерцания.

Пункт Настройка подпункта Описание

Mode Auto / On / Off Установка режима коррекции 
мерцания.

Frequency 50Hz / 60Hz Установка частоты источника питания, 
от которого работает освещение, 
вызывающее мерцание.

Shooting >SteadyShot
Задание настроек стабилизации изображения.

Пункт Настройка подпункта Описание

Setting Active / Standard / Off Включение или выключение функции 
стабилизации изображения.

[Примечание]
Возможно при установке совместимого 
объектива.

Shooting >Auto Black Balance
Задание настроек автоматического баланса черного.

Пункт Настройка подпункта Описание

Auto Black 
Balance

Execute / Cancel Выполнение функции автоматического 
баланса черного.

[Примечания]
ˎˎ Запустите функцию автоматического 

баланса черного с установленной 
крышкой объектива.
ˎˎ Эту функцию нельзя выполнить во время 

записи или отображения цветовых полос.
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Меню Project
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Project >Base Setting
Задание базовых настроек.

Пункт Настройка подпункта Описание

Shooting 
Mode

SDR / HDR / Cine EI Установка режима съемки (стр. 28).

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Выбор частоты системы.

Imager Scan 
Mode

FF 6K / FFcrop 5K / S35 4K / FF 2K / S35 2K Задание сочетания способа 
считывания датчика изображения (все 
пикселы/группирование пикселов) и 
настройки размера датчика 
изображения.

Codec RAW / RAW & XAVC-I / RAW & XAVC-L / 
RAW & MPEG HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422

Установка режима записи/
воспроизведения.

[Примечание]
Настройки RAW отображаются только при 
установленном блоке расширения.

RAW Output 
Format

Доступные настройки зависят от 
параметров Frequency, Imager Scan 
Mode и Codec (стр. 56).

Задает формат записи для внешнего 
устройства записи RAW.

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format Доступные настройки зависят от 
параметров Frequency и Codec.

Установка формата записи.

Frequency Codec Варианты 
выбора

59.94 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50
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Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format 50 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50

29.97 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format 25 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

24 RAW –

XAVC-I 4096×2160P

23.98 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50
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Project >Cine EI Setting
Задание настроек режима Cine EI.

Пункт Настройка подпункта Описание

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Задание цветового пространства в 
режиме Cine EI.
S-Gamut3/SLog3: 

Задание для цветового 
пространства в режиме Cine EI 
значения S-Gamut3.

S-Gamut3.Cine/SLog3: 
Задание для цветового 
пространства в режиме Cine EI 
значения S-Gamut3.Cine.

Project >Simul Rec
Задание настроек режима одновременной записи (стр. 51).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
одновременной записи и установка 
целевого носителя для записи.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Назначение кнопок записи, 
используемых для выбора носителей 
записи.

Project >4K & HD (Sub) Rec
Задание настроек режима записи 4K & HD (Sub).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
записи 4K & HD (Sub).

Project >Proxy Rec
Задание настроек режима записи прокси.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
записи прокси.

Project >Proxy Rec
Задание настроек режима записи прокси.

Пункт Настройка подпункта Описание

Proxy Format 1920×1080(9Mbps) / 1280×720(9Mbps) / 
1280×720(6Mbps) / 640×360(3Mbps)

Задание размера изображения для 
файла прокси.
Если задано значение 
1920×1080(9Mbps) и частота системы 
равна 23.98, для записи используется 
прогрессивная развертка. Для 
значений частоты системы, отличных 
от 23.98, для записи используется 
чересстрочная развертка.
Для настроек, отличных от 
1920×1080(9Mbps), для записи всегда 
используется прогрессивная 
развертка, независимо от частоты 
системы.

Audio 
Channel

CH1/CH2 / CH3/CH4 Выбор аудиоканала для записи данных 
прокси.

Project >Interval Rec
Задание настроек режима съемки с интервалом (стр. 49).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
съемки с интервалом. (При задании 
этому режиму значения On всем 
остальным особым режимам задается 
значение Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /  
20 / 30 / 40 / 50 (сек)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (мин)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ч)

Задание интервала между съемкой в 
режиме Interval Rec (когда параметру 
Interval Rec задано значение On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Возможные значения зависят от частоты 
кадров выбранного формата видео.
50P/59.94P: 

2frames / 6frames / 12frames
23.98P/25P/29.97P/50i/59.94i: 

1frame / 3frames / 6frames / 9frames

Задание количества кадров, которое 
будет записано за один дубль в 
режиме Interval Rec (когда параметру 
Interval Rec задано значение On).
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Project >Interval Rec
Задание настроек режима съемки с интервалом (стр. 49).

Пункт Настройка подпункта Описание

Pre-Lighting Off / 2sec / 5sec / 10sec Задание времени (в секундах), за 
которое лампа для видеосъемки будет 
включаться перед началом съемки в 
режиме Interval Rec.

[Совет]
Этот параметр доступен только при 
использовании компонента HVL-LBPC 
(приобретается дополнительно).

Project >Picture Cache Rec
Задание настроек режима записи в кэш изображения (стр. 50).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
записи в кэш изображения.

Cache Rec 
Time

Настройки зависят от настройки 
формата записи.

Задание времени накопления 
изображений в кэш-памяти 
изображения (время записи кэша 
изображения).

Project >SDI/HDMI Rec Control
Задание настроек управления записью через выходы SDI/HDMI.

Пункт Настройка подпункта Описание

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Задание управления запуском и 
остановкой записи на внешнем устройстве 
с помощью выходного сигнала SDI/HDMI.
Off: 

Дистанционное управление не 
используется.

SDI/HDMI Remote I/F: 
Запуск/остановка записи на 
внешнее подключенное устройство, 
когда в видеокамеру не вставлен 
носитель для записи. Без 
синхронизации по точности кадров 
с носителем из видеокамеры.

Parallel Rec: 
Запуск/остановка записи на внешнее 
подключенное устройство, когда 
в видеокамеру вставлен носитель 
для записи. С синхронизацией по 
точности кадров с носителем из 
видеокамеры.

Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <10>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset White 
Select / ATW / ATW Hold / AF Speed/
Sens. / Focus Setting / Focus Area / Focus 
Area(AF-S) / Face/Eye Detection AF / Push 
AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Last Clip Del. / Shot 
Mark1 / Shot Mark2 / Clip Flag OK / Clip 
Flag NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Thumbnail / 
Touch Operation / Handle Zoom / NFC / 
Network Client Mode / Auto Upload 
(Proxy) / Direct Menu / User Menu / Menu

Назначение функций 
программируемым кнопкам.
Base ISO/Sensitivity: 

Переключение базовой 
чувствительности датчика 
изображения.

AGC: 
Включение или выключение 
функции AGC.

Push AGC: 
Включение функции AGC на время, 
пока нажата кнопка.

ND Filter Position: 
Переключение фильтров 
нейтральной плотности.

Auto ND Filter: 
Включение или выключение функции 
автоматического фильтра ND.

Push Auto ND: 
Включение функции 
автоматического фильтра ND на 
время, пока нажата кнопка.

Auto Iris: 
Включение или выключение 
функции диафрагмы.

Push Auto Iris: 
Включение автоматической 
регулировки диафрагмы на время, 
пока нажата кнопка.

Auto Shutter: 
Включение или выключение 
функции автоматического затвора.

Auto Exposure Level: 
Отображение или закрытие 
прямого меню Auto Exposure Level.

Backlight: 
Переключение между режимами 
Backlight и Standard.

Spotlight: 
Переключение между режимами 
Spotlight и Standard.
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Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <10>, 
Focus Hold 
Button

Preset White Select: 
Переключение значения стандартного 
режима баланса белого..

ATW: 
Включение или выключение 
функции ATW.

ATW Hold: 
Приостановка работы функции ATW

AF Speed/Sens.: 
Переключение настройки скорости 
изменения AF и настройки 
чувствительность к смене объекта 
AF.

Focus Setting: 
Задание области фокусировки.

Focus Area: 
Задание области фокусировки для 
AF и AF при нажатии кнопки.

Focus Area(AF-S): 
Задание области фокусировки для 
AF при нажатии кнопки (AF-S).

Face/Eye Detection AF: 
Переключение настроек AF 
с обнаружением лиц и глаз.

Push AF Mode: 
Переключение настройки режима 
Push AF.

Push AF/Push MF: 
В режиме фокусировки MF режим 
AF включается при нажатой кнопке. 
В режиме фокусировки AF режим 
MF включается при нажатой 
кнопке.

Focus Hold: 
В режиме фокусировки AF фокус 
фиксируется при нажатой кнопке.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Включение или выключение 
функции увеличения области 
фокусировки.

Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <10>, 
Focus Hold 
Button

S&Q Motion: 
Включение и выключение режима 
записи с замедлением/ускорением 
движения. 
При нажатии и удерживании 
производится установка частоты 
кадров при записи.

SteadyShot: 
Переключение между Active, 
Standard и Off.

Rec: 
Запуск или остановка записи.

Picture Cache Rec: 
Включение или выключение 
режима записи в кэш 
изображения.

Rec Review: 
Включение или выключение 
функции Rec Review.

Last Clip Del.: 
Выполнение функции удаления 
последнего клипа (для повторной 
съемки).

Shot Mark1: 
Выполнение функции Add Shot 
Mark1.

Shot Mark2: 
Выполнение функции Add Shot 
Mark2.

Clip Flag OK: 
Запуск функции Add OK. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.

Clip Flag NG: 
Выполнение функции Add NG. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.

Clip Flag Keep: 
Выполнение функции Add Keep. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.
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Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <10>, 
Focus Hold 
Button

Color Bars: 
Включение или выключение 
цветовых полос.

Tally [Front]: 
Включение или выключение 
функции включения или мигания 
индикатора записи/съемки 
(переднего).

DURATION/TC/U-BIT: 
Переключение между Time Code, 
Users Bit и Duration.

Display: 
Включение или выключение 
экранной индикации.

Lens Info: 
Переключение индикатора 
глубины поля резкости.

Video Signal Monitor: 
Переключение монитора 
видеосигнала (например, 
монитора формы сигнала).

Marker: 
Включение или выключение 
функции маркера.

VF Adjust: 
Отображение полос уровня для 
регулировки яркости экрана 
видоискателя.

VF Mode: 
Переключение изображения 
в видоискателе между цветным и 
черно-белым.

Gamma Display Assist: 
Переключение функции помощи 
в отображении гамма-кривой.

Peaking: 
Включение или выключение 
функции контурной коррекции.

Zebra: 
Включение или выключение 
функции Zebra.

Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <10>, 
Focus Hold 
Button

Thumbnail: 
Отображение или закрытие экрана 
эскизов.

Touch Operation: 
Включение и выключение 
сенсорного управления.

Handle Zoom: 
Переключение работы органов 
управления масштабированием на 
рукоятке.

NFC: 
Выполнение функции NFC.

Network Client Mode: 
Включение или выключение 
режима сетевого клиента.

Auto Upload (Proxy): 
Включение или выключение 
автоматической передачи файлов 
прокси.

Direct Menu: 
Отображение или закрытие 
прямого меню.

User Menu: 
Отображение или закрытие меню 
User.

Menu: 
Отображение или закрытие меню 
настройки.
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Project >Assignable Dial
Назначение функций для программируемого диска и задание направления вращения.

Пункт Настройка подпункта Описание

Assignable 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Audio Input Level

Назначение функций 
программируемому диску.
ISO/Gain/EI: 

Регулировка усиления или EI.
ND Filter: 

Регулировка фильтра ND.
IRIS: 

Регулировка диафрагмы.
Audio Input Level: 

Регулировка уровня записи звука.

Assignable 
Dial Direction

Normal / Opposite Задание направления вращения 
программируемого диска.
Normal: вращение в обычном 

направлении.
Opposite: вращение в обратном 

направлении.

Project >Multi Function Dial
Назначение функций многофункциональному диску.

Пункт Настройка подпункта Описание

Default 
Function

Off / IRIS / ISO/Gain/EI / Audio Input Level Назначение функции по умолчанию 
многофункциональному диску.
IRIS: 

Регулировка диафрагмы.
ISO/Gain/EI: 

Регулировка усиления или EI.
Audio Input Level: 

Регулировка уровня записи звука.

Project >User File
Задание настроек, относящихся к операциям с файлами пользовательских настроек.

Пункт Настройка подпункта Описание

Load Utility 
SD/MS

Execute / Cancel Загрузка настроек пользовательского 
файла с SD-карты.
Execute: выполнение функции.

Save Utility 
SD/MS

Execute / Cancel Сохранение настроек 
пользовательского файла на SD-карте.
Execute: выполнение функции.

File ID Отображение экрана для отображения 
или изменения идентификатора файла 
для пользовательских файлов.

Load 
Customize 
Data

On / Off Задание того, следует ли загружать 
сведения о настроенном меню User 
при выполнении команды Load Utility 
SD/MS.

Load White 
Data

On / Off Задание того, следует ли загружать 
сведения о балансе белого при 
выполнении команды Load Utility SD/
MS.

Project >All File
Задание настроек, относящихся к файлам ALL.

Пункт Настройка подпункта Описание

Load Utility 
SD/MS

Execute / Cancel Загрузка файла ALL
Execute: выполнение функции.

Save Utility 
SD/MS

Execute / Cancel Сохранение файла ALL.
Execute: выполнение функции.

File ID Назначение имени файлу.

Load Network 
Data

On / Off Задание того, следует ли загружать 
сведения о настройках меню Network 
при выполнении команды Load Utility 
SD/MS.
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Project >Planning Metadata
Задание настроек, относящихся к операциям с метаданными планирования.

Пункт Настройка подпункта Описание

Load 
Media(A) или 
Load 
Media(B)

Execute / Cancel Загрузка метаданных планирования с 
карты памяти в гнезде A или B.
Выберите Execute для отображения 
списка файлов метаданных 
планирования, хранящихся на карте 
памяти в гнезде A или B. Выберите 
файл с помощью команды Load, затем 
выберите Execute для загрузки файла.

[Примечания]
ˎˎ  В списке файлов отображается не более 

64 файлов. Даже если полное число 
файлов метаданных планирования равно 
64 или менее, но каталог, в котором они 
находятся на карте памяти (XDROOT/
General/Sony/Planning), содержит 512 или 
более файлов, могут отображаться не все 
файлы метаданных планирования.
ˎˎ  После начала загрузки не извлекайте 

карту памяти, пока не появится 
сообщение о завершении операции.

Project >Planning Metadata
Задание настроек, относящихся к операциям с метаданными планирования.

Пункт Настройка подпункта Описание

Properties Execute / Cancel Выберите пункт Execute для 
отображения свойств метаданных 
планирования, загруженных в 
видеокамеру.
File Name: 

Имя файла
Assign ID: 

Назначенный идентификатор
Created: 

Время и дата создания файла
Modified: 

Время и дата последнего 
изменения файла

Modified by: 
Имя пользователя, изменившего 
файл

Title1: 
Название Title1, указанное в файле 
(название клипа в формате ASCII)

Title2:  
Название Title2, указанное в файле 
(название клипа в формате UTF-8)

Material Group: 
Количество групп материалов 
(групп клипов, записанных 
с одними и теми же метаданными 
планирования)

Shot Mark0–9: 
Названия, определенные для 
меток 0–9

Clear 
Memory

Execute / Cancel Выберите пункт Execute для очистки 
метаданных планирования, 
загруженных в память видеокамеры.

Clip Name 
Display

Title1(ASCII) / Title2(UTF-8) Задание режима отображения 
названия клипа, указанного в 
метаданных планирования.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Paint >HDR Paint Setting
Задание параметров широкого динамического диапазона HDR (High Dynamic Range).

Пункт Настройка подпункта Описание

HLG Look Natural / Live Задание типа HLG, когда для 
параметра Shooting Mode задано 
значение HDR.
Natural: 

Характеристика, соответствующая 
ITU-R BT.2100(HLG).

Live: 
Характеристика, соответствующая 
ITU-R BT.2100(HLG), 
обеспечивающая улучшенное 
воспроизведение HDR.

[Примечание]
При использовании настройки Live 
возможно увеличение уровня шумов.

HDR Black 
Offset

От –95 до +103 (±0) Задание смещения уровня черного 
в режиме HDR относительно настройки 
SDR (Master Black), когда для 
параметра Shooting Mode задано 
значение HDR.

HDR Knee On / Off Включение и выключение функции 
коррекции излома сигнала HDR, когда 
для параметра Shooting Mode задано 
значение HDR.

HDR Knee 
Point

От –99 до +99 (±0) Задает точку излома для сигналов 
HDR, когда для параметра HDR Knee 
задано значение On.

HDR Knee 
Slope

От –99 до +99 (±0) Задает наклон излома для сигналов 
HDR, когда для параметра HDR Knee 
задано значение On.

Paint >Black
Задание настроек черного.

Пункт Настройка подпункта Описание

Master Black От –99.0 до +99.0 (±0.0) Установка контрольного уровня 
черного цвета.

R Black От –99.0 до +99.0 (±0.0) Установка уровня R черного цвета.

B Black От –99.0 до +99.0 (±0.0) Установка уровня B черного цвета.

Paint >Gamma
Задание настроек коррекции гаммы.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
коррекции гаммы.

Step Gamma От 0.35 до 0.45 до 0.90 Указание значения коррекции гаммы с 
дискретностью 0,05.

Master 
Gamma

От –99 до +99 (±0) Установка контрольного уровня гаммы.

R Gamma От –99 до +99 (±0) Установка уровня R гаммы.

G Gamma От –99 до +99 (±0) Установка уровня G гаммы.

B Gamma От –99 до +99 (±0) Установка уровня B гаммы.

Gamma 
Category

Original / STD / HG / S-Log3 Задания оригинальной гамма-кривой 
(Original), стандартной гамма-кривой 
(STD), гипергаммы (HG) или S-Log3.

Gamma 
Select

Когда параметру Gamma Category 
установлено значение STD:

STD1 DVW / STD2 ×4.5 / STD3 ×3.5 / 
STD4 240M / STD5 R709 / STD6 ×5.0

Когда параметру Gamma Category 
установлено значение HG:

HG1 3250G36 / HG2 4600G30 / HG3 
3259G40 / HG4 4609G33 / HG7 
8009G40 / HG8 8009G33

Когда параметру Gamma Category 
установлено значение S-Log3:

S-Log3
Когда для параметра Gamma Category 
задано значение Original:

S-Cinetone

Выбор таблицы гаммы, используемой 
для коррекции гаммы.
Подробнее о гипергамме и S-Log3 см. 
в приведенной ниже таблице.

Имя Динамический 
диапазон

Ограничение 
белого

18% видео 
выводом 
серой карты 
(20% ввода 
видео)

HG1 3250G36 325% 100% 36%

HG2 4600G30 460% 100% 30%

HG3 3259G40 325% 109% 40%

HG4 4609G33 460% 109% 33%

HG7 8009G40 800% 109% 40%

HG8 8009G33 800% 109% 33%

S-Log3 1300% – 41%

Меню Paint
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Paint >Black Gamma
Задание настроек коррекции гаммы черного цвета.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
коррекции гаммы черного цвета.
(Доступно, когда для параметра 
Gamma >Gamma Category установлено 
значение STD)

[Примечание]
Функции Black Gamma и Knee >Knee 
Saturation нельзя использовать 
одновременно.

Range Low / L.Mid / H.Mid Выбор эффективного диапазона 
коррекции гаммы черного цвета.

Master Black 
Gamma

От –99 до +99 (±0) Установка контрольного уровня гаммы 
черного цвета.

Paint >Knee
Задание настроек коррекции точки излома.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
коррекции колена.
(Доступно, когда для параметра 
Gamma >Gamma Category установлено 
значение STD)

Auto Knee On / Off Включение или выключение функции 
автоматического излома.

Point От 75% до 109% (90%) Установка точки колена.

Slope От –99 до +99 (±0) Установка наклона колена.

Knee 
Saturation

On / Off Включение/выключение регулировки 
насыщенности колена (регулирует 
окрашивание выше точки колена).

[Примечание]
Функции Black Gamma и Knee >Knee 
Saturation нельзя использовать 
одновременно.

Knee 
Saturation 
Level

От –99 до +99 (±0) Установка уровня для регулировки 
окрашивания выше точки колена 
(насыщенность колена).

Paint >White Clip
Задание настроек регулировки ограничения белого.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
регулирования ограничения белого.
(Доступно, когда для параметра 
Gamma >Gamma Category установлено 
значение STD)

[Примечание]
Этот параметр принимает значение On, 
когда видеокамера выключена. Для 
постоянного отключения выберите для 
параметра Level значение 109%.

Level От 90.0% до 109.0% Указание уровня ограничителя белого 
цвета.

Paint >Detail(4K/QFHD)
Задание настроек регулирования деталей (4K/QFHD).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
регулирования деталей.

Level От –99 до +99 (±0) Установка уровня деталей.

H/V Ratio От –99 до +99 (±0) Установка коэффициента 
выравнивания между уровнями 
деталей H и V.

Crispening От –99 до +99 (±0) Установка уровня обострения 
перепадов.

Frequency От –99 до +99 (±0) Установка центральной частоты 
деталей (толщины деталей).
Чем тоньше детали, тем выше 
центральная частота, а чем толще, тем 
ниже центральная частота.

Knee 
Aperture

On / Off Включение или выключение функции 
коррекции диафрагмы колена.

Knee 
Aperture 
Level

От –99 до +99 (±0) Установка уровня диафрагмы колена.

White Limit От –99 до +99 (±0) Установка значения ограничителя 
белых деталей.

Black Limit От –99 до +99 (±0) Установка значения ограничителя 
черных деталей.
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Paint >Detail(4K/QFHD)
Задание настроек регулирования деталей (4K/QFHD).

Пункт Настройка подпункта Описание

V Detail 
Creation

NAM / Y / G / G+R Задание источнику сигнала для 
создания деталей V значения NAM (G 
или R в зависимости от того, какое 
значение выше), Y, G или G+R.

Paint >Detail(HD)
Задание настроек регулирования деталей (HD).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
регулирования деталей.

Level От –99 до +99 (±0) Установка уровня деталей.

H/V Ratio От –99 до +99 (±0) Установка коэффициента 
выравнивания между уровнями 
деталей H и V.

Crispening От –99 до +99 (±0) Установка уровня обострения 
перепадов.

Frequency От –99 до +99 (±0) Установка центральной частоты 
деталей (толщины деталей).
Чем тоньше детали, тем выше 
центральная частота, а чем толще, тем 
ниже центральная частота.

Knee 
Aperture

On / Off Включение или выключение функции 
коррекции диафрагмы колена.

Knee 
Aperture 
Level

От –99 до +99 (±0) Установка уровня диафрагмы колена.

White Limit От –99 до +99 (±0) Установка значения ограничителя 
белых деталей.

Black Limit От –99 до +99 (±0) Установка значения ограничителя 
черных деталей.

V Detail 
Creation

NAM / Y / G / G+R Задание источнику сигнала для 
создания деталей V значения NAM (G 
или R в зависимости от того, какое 
значение выше), Y, G или G+R.

Paint >Skin Detail
Задание настроек коррекции деталей телесного тона.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
коррекции деталей телесного тона.

Paint >Skin Detail
Задание настроек коррекции деталей телесного тона.

Пункт Настройка подпункта Описание

Area 
Detection

Execute / Cancel Обнаружение цвета, используемого 
для коррекции деталей телесного 
тона.
Execute: выполнение функции.

Area 
Indication

On / Off Включение или выключение функции, 
которая отображает узор зебры 
в области целевого цвета для 
коррекции деталей телесного тона.

Level От –99 до +99 (±0) Установка уровня деталей телесного 
тона.

Saturation От –99 до +99 (±0) Установка насыщенности цвета, 
который является целью для 
коррекции деталей телесного тона.

Hue От 0 до 359 Установка оттенка цвета, который 
является целью для коррекции 
деталей телесного тона.

Width От 0 до 90 (40) Установка диапазона для оттенка 
цвета, который является целью для 
коррекции деталей телесного тона.

Paint >Aperture
Задание настроек коррекции диафрагмы.

Пункт Настройка подпункта Описание

Setting On / Off Включение/выключение коррекции 
диафрагмы (обработка, позволяющая 
улучшить разрешение путем 
добавления высокочастотного сигнала 
диафрагмы в видеосигнал для 
коррекции ухудшения, вызванного 
высокочастотными характеристиками).

Level От –99 до +99 (±0) Установка уровня коррекции 
диафрагмы.

Paint >Matrix
Задание настроек матричной коррекции.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
матричной коррекции.

Adaptive 
Matrix

On / Off Включение или выключение функции 
адаптивной матрицы.
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Paint >Matrix
Задание настроек матричной коррекции.

Пункт Настройка подпункта Описание

Preset Matrix On / Off Включение или выключение функции 
предустановки матрицы.

Preset Select S-Cinetone / Standard / FL Light /  
Cinema / BT.709 / BT.2020

Выбор предустановленной матрицы.

User Matrix On / Off Включение или выключение функции 
пользовательской матричной 
коррекции.

User Matrix 
Level

От –99 до +99 (±0) Регулировка насыщенности цвета 
всего изображения.

User Matrix 
Phase

От –99 до +99 (±0) Регулировка оттенка цвета (фазы) 
всего изображения.

User Matrix 
R-G

От –99 до +99 (±0) Задание определенной пользователем 
матрицы R-G.

User Matrix 
R-B

От –99 до +99 (±0) Задание определенной пользователем 
матрицы R-B.

User Matrix 
G-R

От –99 до +99 (±0) Задание определенной пользователем 
матрицы G-R.

User Matrix 
G-B

От –99 до +99 (±0) Задание определенной пользователем 
матрицы G-B.

User Matrix 
B-R

От –99 до +99 (±0) Задание определенной пользователем 
матрицы B-R.

User Matrix 
B-G

От –99 до +99 (±0) Задание определенной пользователем 
матрицы B-G.

Paint >Multi Matrix
Задание настроек мультиматричной коррекции.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
мультиматричной коррекции.

Area 
Indication

On / Off Включение или выключение функции 
обозначения области.

Color 
Detection

Execute / Cancel Обнаружение цвета, используемого 
для мультиматричной коррекции.

Reset Execute / Cancel Сброс оттенка и насыщенности для 
каждого цвета оси на значения по 
умолчанию.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Выбор оси.

Paint >Multi Matrix
Задание настроек мультиматричной коррекции.

Пункт Настройка подпункта Описание

Hue От –99 до +99 (±0) Выбор оттенка цвета, используемого 
для мультиматричной коррекции.

Saturation От –99 до +99 (±0) Выбор насыщенности цвета, 
используемого для мультиматричной 
коррекции.

Paint >Scene File
Задание настроек, относящихся к файлам сцен.

Пункт Настройка подпункта Описание

Recall 
Internal 
Memory

Загрузка файла сцен из внутренней 
памяти.

Store Internal 
Memory

Execute / Cancel Сохранение файла сцен во 
внутреннюю память.
Execute: выполнение функции.

Load Utility 
SD/MS

Execute / Cancel Загрузка файла сцен с карты памяти 
SD.
Execute: выполнение функции.

Save Utility 
SD/MS

Execute / Cancel Сохранение файла сцен на карту 
памяти SD.
Execute: выполнение функции.

File ID Назначение имени файлу.

Scene White 
Data

On / Off Задание возможности применять 
данные баланса белого при загрузке 
файла сцен.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

TC/Media >Timecode
Задание настроек временного кода.

Пункт Настройка подпункта Описание

Mode Preset / Regen / Clock Установка режима отсчета временного 
кода.
Preset: 

Начало отсчета от предварительно 
заданного значения.

Regen: 
Начало отсчета от временного кода 
конца предыдущего клипа.

Clock: 
Использование внутренних часов 
в качестве временного кода.

Run Rec Run / Free Run Rec Run: отсчет ведется только при 
записи.

Free Run: отсчет ведется всегда, 
независимо от режима работы 
видеокамеры.

Setting Установка произвольного значения 
временного кода.
SET: установка значения.

Reset Execute / Cancel Сброс временного кода до значения 
00:00:00:00.
Execute: выполнение функции.

TC Format DF / NDF Установка формата временного кода.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Задание настроек отображения данных времени.

Пункт Настройка подпункта Описание

Display Select Timecode / Users Bit / Duration Переключение отображения данных 
времени.

TC/Media >Users Bit
Задание настроек, относящихся к битам пользователя.

Пункт Настройка подпункта Описание

Mode Fix / Time Установка режима битов пользователя.
Fix: использование в битах 

пользователя произвольного 
фиксированного значения.

Time: Использует текущее время в 
битах пользователя.

Setting Установка произвольного значения 
для битов пользователя.

TC/Media >HDMI TC Out
Задание настроек, относящихся к выводу временного кода при использовании разъема 
HDMI.

Пункт Настройка подпункта Описание

Setting On / Off Установка возможности передачи 
временного кода на устройства для 
других целей через выход HDMI.

TC/Media >Clip Name Format
Задание настроек, связанных с именами клипов и их удалением.

Пункт Настройка подпункта Описание

Auto Naming Title / Plan Выбор формата именования клипов.
Title: 

Задание именования, указанного 
в параметре Title Prefix.

Plan: 
Использование названия клипа, 
указанного в метаданных 
планирования, при наличии. Если в 
метаданных планирования 
название не указано, оно задается 
параметром Title Prefix.

Меню TC/Media
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TC/Media >Clip Name Format
Задание настроек, связанных с именами клипов и их удалением.

Пункт Настройка подпункта Описание

Title Prefix nnn_ (nnn последние 3 цифры 
порядкового номера)
(Отображается не более 7 цифр)

Задание части названия (от 4 до 46 
символов) в имени клипа.
Открывает экран ввода строки 
символов.

Структура экрана ввода строки 
символов
Область выбора символов (3 строки): 

Выбор символов для вставки 
в положении курсора в области 
Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Область операций с курсором 
(1 строка): 
Space: вставка пробела 
в положении курсора.  
: перемещение курсора влево.  
: перемещение курсора вправо.  
BS: удаление символа, 
расположенного слева от 
положения курсора.

Область Title Prefix (1 строка): 
Область ввода названия.

Задание названия
1. С помощью кнопок со стрелками 

выберите символ для вставки в 
положение курсора в области Title 
Prefix из области выбора символов, 
затем нажмите кнопку SET. 
(Вставляется выбранный символ, и 
курсор перемещается вправо.)

2. Повторяйте шаг 1 для задания 
названия. (При необходимости 
используйте BS.)

3. После задания названия выберите 
пункт Done, чтобы закрыть экран 
ввода символов.

TC/Media >Clip Name Format
Задание настроек, связанных с именами клипов и их удалением.

Пункт Настройка подпункта Описание

Number Set Если для параметра Auto Naming задано 
значение Title: 
0001–9999

Если для параметра Auto Naming задано 
значение Plan: 
00001–99999

Задание 4-значного цифрового 
суффикса имени клипа.
Задание 5-значного номера, если 
используется файл метаданных 
планирования.

TC/Media >Update Media
Обновление файла управления на картах памяти.

Пункт Настройка подпункта Описание

Media(A) Execute / Cancel Обновление файла управления на 
карте памяти XQD, вставленной в 
гнездо A.
Execute: выполнение функции.

Media(B) Execute / Cancel Обновление файла управления на 
карте памяти XQD, вставленной в 
гнездо B.
Execute: выполнение функции.

TC/Media >Format Media
Инициализация карт памяти.

Пункт Настройка подпункта Описание

Media(A) Execute / Cancel Инициализация карты памяти XQD, 
вставленной к гнездо A.
Execute: выполнение функции.

Media(B) Execute / Cancel Инициализация карты памяти XQD, 
вставленной в гнездо B.
Execute: выполнение функции.

Utility SD/MS Execute / Cancel Инициализация UTILITY SD-карты.
Execute: выполнение функции.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Monitoring >Output On/Off
Задание настроек видеовыхода.

Пункт Настройка подпункта Описание

SDI1 On / Off Включение или выключение выхода 
SDI1.

SDI2 On / Off Включение или выключение выхода 
SDI2.

HDMI On / Off Включение или выключение выхода 
HDMI.

Monitoring >Output Format
Задание настроек выходного формата.

Пункт Настройка подпункта Описание

SDI1 Подробное описание настроек см. в 
разделе “Форматы и ограничения для 
выходов” (стр. 129).

Установка разрешения выходов SDI и 
HDMI.

[Примечание]
Иногда задать значение параметра Output 
Format в режиме Picture Cache Rec бывает 
невозможно. В этом случае временно 
задайте параметру Picture Cache Rec 
значение Off, после чего измените эту 
настройку.

SDI2

HDMI

REF

Monitoring >Output Setting
Задание настроек режима преобразования выходного сигнала.

Пункт Настройка подпункта Описание

RAW to HD 
Conv.

Edge Crop / Letter Box Задание режима преобразования для 
выходного видеосигнала HD формата 
17:9.

Monitoring >Output Display
Задание настроек выходного сигнала.

Пункт Настройка подпункта Описание

Setting On / Off Выбор возможности наложения меню 
и состояния на выходные сигналы SDI 
и HDMI.

Monitoring >Output Display
Задание настроек выходного сигнала.

Пункт Настройка подпункта Описание

SDI1 Настройки зависят от значения 
параметра Output Format. Подробное 
описание см. на “Форматы и 
ограничения для выходов” (стр. 129).

Показывает, внедряются ли сведения о 
меню и состоянии в выходной сигнал 
SDI1.

SDI2 Показывает, внедряются ли сведения о 
меню и состоянии в выходной сигнал 
SDI2.

HDMI Показывает, внедряются ли сведения о 
меню и состоянии в выходной сигнал 
HDMI.

Monitoring >Display On/Off
Задание настроек отображаемых элементов.

Пункт Настройка подпункта Описание

Network 
Status

On / Off Выбор элементов для отображения на 
экране видоискателя.

File Transfer 
Status

On / Off

NCM/
Streaming 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Меню Monitoring
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Monitoring >Display On/Off
Задание настроек отображаемых элементов.

Пункт Настройка подпункта Описание

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

GPS On / Off

SteadyShot On / Off

Gamma/LUT On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Monitoring >Display On/Off
Задание настроек отображаемых элементов.

Пункт Настройка подпункта Описание

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Задание настроек отображения маркеров.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение 
отображения всех маркеров.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Выбор цвета сигнала маркера.

Center 
Marker

1 / 2 / 3 / 4 / Off Выбор центрального маркера.

Safety Zone On / Off Включение или выключение маркера 
зоны гарантированного отображения.

Safety Area 80% / 90% / 92.5% / 95% Выбор размера маркера зоны 
гарантированного отображения (в 
процентах от общего размера экрана).

Aspect 
Marker

Line / Mask / Off Выбор типа маркера формата 
изображения.

Aspect Mask От 0 до 15 (12) Задает уровень видеосигнала за 
пределами маркера.

Aspect Safety 
Zone

On / Off Включение или выключение маркера 
зоны гарантированного отображения 
формата изображения.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Выбор размера маркера зоны 
гарантированного отображения 
формата изображения (в процентах от 
общего размера экрана).

Aspect Select 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 /  
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1

Установка режима при отображении 
маркера формата изображения.

Guide Frame On / Off Включение или выключение 
отображения опорной рамки.



6. Отображение меню и настройки: Меню Monitoring106

Monitoring >Marker
Задание настроек отображения маркеров.

Пункт Настройка подпункта Описание

100% Marker On / Off Включение или выключение 100% 
маркера.

User Box On / Off Включение или выключение 
отображения маркера поля 
пользователя.

User Box 
Width

От 3 до 479 (240) Установка ширины маркера поля 
пользователя (расстояние от центра до 
левого и правого краев).

User Box 
Height

От 3 до 269 (135) Установка высоты маркера поля 
пользователя (расстояние от центра до 
верхнего и нижнего краев).

User Box H 
Position

От –476 до +476 (0) Задание положения центра маркера 
поля пользователя по горизонтали.

User Box V 
Position

От –266 до +266 (0) Задание положения центра маркера 
поля пользователя по вертикали.

Monitoring >VF Setting
Задание настроек видоискателя.

Пункт Настройка подпункта Описание

Contrast От –99 до +99 (±0) Настройка контрастности (разницы 
между светлыми и темными 
областями) изображения в 
видоискателе.

Brightness От –99 до +99 (±0) Регулировка яркости изображения в 
видоискателе.

Color Mode Color / B&W Выбор режима отображения 
видоискателя в режиме E-E/записи.

Monitoring >Gamma Display Assist
Задание настроек помощи в отображении гамма.

Пункт Настройка подпункта Описание

Setting В режиме SDR или Cine EI:
On / Off

В режиме HDR:
On / Off

Включение или выключение функции 
Gamma Display Assist.

Monitoring >Peaking
Задание настроек контурной коррекции.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
контурной коррекции.

Type Normal / Color Выбор типа контурной коррекции.
Normal: обычная контурная коррекция
Color: цветная контурная коррекция

Normal 
Peaking 
Frequency

Normal / High Выбор частоты контурной коррекции.

Normal 
Peaking Level

От 0 до 99 (50) Установка уровня обычной контурной 
коррекции.

Color B&W / Red / Yellow / Blue Выбор цвета сигнала цветной 
контурной коррекции.

Color Peaking 
Level

От 0 до 99 (50) Установка уровня цветной контурной 
коррекции.

Monitoring >Zebra
Задание настроек узора зебры.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
узора зебры.

Zebra Select 1 / 2 / Both Выбор типа узора зебры (Zebra 1, Zebra 
2, Both).

Zebra1 Level От 0% до 107% (70%) Установка уровня отображения Zebra 1.

Zebra1 
Aperture 
Level

От 1% до 20% (10%) Установка уровня диафрагмы Zebra 1.

Zebra2 Level От 0% до 109% (100%) Установка уровня отображения Zebra 
2.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).
См. раздел “Блок-схемы” (стр. 146).

Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

CH1 MI SHOE 
Input Select

Shoe CH1 / Wireless Задание функции внешнего входа, 
когда переключатель выбора CH1 
INPUT (стр. 7) установлен 
в положение MI SHOE.

[Примечание]
Пункт “Wireless” отображается только при 
установленном блоке расширения.

CH2 EXT 
Input Select

INPUT1 / INPUT2 Переключение внешнего источника 
входного сигнала для записи в канал 2.

CH2 MI SHOE 
Input Select

Shoe CH2 / Wireless Задание функции внешнего входа, 
когда переключатель выбора CH2 
INPUT (стр. 7) установлен 
в положение MI SHOE.

[Примечание]
Пункт “Wireless” отображается только при 
установленном блоке расширения.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 / 
Wireless

Переключение источника входного 
сигнала для записи в канал 3.

[Примечание]
Пункт “Wireless” можно выбрать только при 
установленном блоке расширения.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2 / Wireless

Переключение источника входного 
сигнала для записи в канал 4.

[Примечание]
Пункт “Wireless” можно выбрать только при 
установленном блоке расширения.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Установка эталонного уровня записи 
для входного сигнала микрофона XLR 
из канала INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Установка эталонного уровня записи 
для входного сигнала микрофона XLR 
из канала INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Выбор опорного входного уровня, 
когда переключатель INPUT1/INPUT2 
установлен в положение LINE.

Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Выбор уровня записи опорного 
звукового сигнала 1 кГц.

CH1 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 1.

CH2 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 2.

CH3 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 3.

CH4 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 4.

CH3 Level 
Control

Auto / Manual Выбор автоматической регулировки 
входного уровня звука или ручной 
регулировки для записи канала 3.

[Примечание]
Если для параметров CH3 Input Select и 
CH4 Input Select установлено значение 
Internal MIC, канал CH4 переключается в 
автоматический/ручной режим совместно с 
этой настройкой.

CH4 Level 
Control

Auto / Manual Выбор автоматической регулировки 
входного уровня звука или ручной 
регулировки для записи канала 4.

[Примечание]
Если для параметров CH3 Input Select и 
CH4 Input Select установлено значение 
Internal MIC, канал CH4 переключается в 
автоматический/ручной режим совместно с 
настройкой CH3 Level Control.

Audio Input 
Level

От 0 до 99 Установка уровня основного входного 
аудиосигнала.
Можно использовать в качестве 
основного уровня громкости, в 
соответствии с настройками CH1 Level 
– CH4 Level.

Меню Audio
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Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Выбор характеристик ограничителя 
для больших входных сигналов при 
регулировке уровня аудиосигнала 
вручную.

CH1&2 AGC 
Mode

Mono / Stereo Установка автоматического режима 
регулировки уровня для записи канала 
1 и канала 2. Если задано значение 
Stereo, функция AGC 
синхронизирована между каналами.

CH3&4 AGC 
Mode

Mono / Stereo Установка автоматического режима 
регулировки уровня для записи канала 
3 и канала 4. Если задано значение 
Stereo, функция AGC 
синхронизирована между каналами.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Выбор характеристик AGC.

1kHz Tone on 
Color Bars

On / Off Включение или выключение опорного 
тонального сигнала частотой 1 кГц при 
отображении цветовых полос.

[Примечание]
Когда для этого параметра установлено 
значение On, тональный сигнал частотой 
1 кГц включается для записи в канал 3 и 4 
даже в том случае, если для параметров CH3 
Input Select и CH4 Input Select установлено 
значение Off.

CH1 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 46)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 1.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH1), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 146).

Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

CH2 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 46)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 2.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH2), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 146).

CH3 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 46)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 3.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH3), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 147).

CH4 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 46)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 4.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH4), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 147).

Audio >Audio Output
Задание настроек аудиовыхода.

Пункт Настройка подпункта Описание

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 /  
CH2 / CH3 / CH4

Выбор вывода аудиоканала на гнездо 
для наушников или на встроенный 
динамик.

[Примечание]
Если звук нескольких каналов настроен 
для одновременного вывода, выходной 
уровень каждого канала уменьшается для 
предотвращения ограничения.
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Audio >Audio Output
Задание настроек аудиовыхода.

Пункт Настройка подпункта Описание

Headphone 
Out

Mono / Stereo Выбор типа выходного аудиосигнала, 
подаваемого на гнездо для 
наушников: монофонический 
(значение Mono) или 
стереофонический (значение Stereo).

Alarm Level От 0 до 7 (4) Регулировка громкости аварийных 
сигналов.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Установка сочетания аудиоканалов на 
выходе HDMI.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Thumbnail

Пункт Настройка подпункта Описание

Display Clip 
Properties

Отображение экрана свойств клипа.

Thumbnail >Set Shot Mark
Задание настроек съемочных меток.

Пункт Настройка подпункта Описание

Delete Shot 
Mark1

Удаление съемочной метки 1.

Delete Shot 
Mark2

Удаление съемочной метки 2.

Thumbnail >Set Clip Flag
Задание настроек флагов клипов.

Пункт Настройка подпункта Описание

Add OK Добавление флага OK.

Add NG Добавление флага NG.

Add KEEP Добавление флага Keep.

Delete Clip 
Flag

Удаление всех флагов.

Thumbnail >Lock/Unlock Clip
Задание настроек защиты клипов.

Пункт Настройка подпункта Описание

Select Clip Выбор клипа и установка/снятие его 
блокировки.

Lock All Clips Блокировка всех клипов.

Unlock All 
Clips

Снятие блокировки всех клипов.

Thumbnail >Delete Clip
Удаление клипов.

Пункт Настройка подпункта Описание

Select Clip Удаление выбранных клипов.

All Clips Удаление всех клипов.

Thumbnail >Copy Clip
Копирование клипов.

Пункт Настройка подпункта Описание

Select Clip Копирование выбранных клипов.

All Clips Копирование всех клипов.

Thumbnail >Copy Sub Clip
Копирование дополнительных клипов.

Пункт Настройка подпункта Описание

All Clips Копирование всех дополнительных 
клипов, записанных в режиме записи 
4K & HD (Sub), на другой носитель в 
качестве основных клипов.

Thumbnail >Transfer Clip
Передача клипов.

[Примечание]
Настройка Transfer Clip невозможна, если не задан параметр Access Authentication >Password в меню 
Network.

Пункт Настройка подпункта Описание

Select Clip Передача выбранных клипов.

All Clips Передача всех клипов.

[Примечание]
Можно передать не более 200 клипов.

Thumbnail >Transfer Clip (Proxy)
Передача клипов прокси.

[Примечание]
Настройка Transfer Clip (Proxy) невозможна, если не задан параметр Access Authentication >Password 
в меню Network.

Пункт Настройка подпункта Описание

Select Clip Передача клипов прокси, 
соответствующих выбранным клипам.

All Clips Передача клипов прокси, 
соответствующих всем клипам.

[Примечание]
Можно передать не более 200 клипов.

Thumbnail >Set Index Picture
Установка индексного изображения клипа.

Пункт Настройка подпункта Описание

Set Index 
Picture

Установка индексного изображения 
клипа.

Меню Thumbnail
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Thumbnail >Thumbnail View
Задание настроек формата отображения экрана эскизов.

Пункт Настройка подпункта Описание

Essence Mark 
Thumbnail

All / Rec Start / Shot Mark1 / Shot Mark2 / 
Shot Mark3 / Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / Shot Mark8 / 
Shot Mark9 / Shot Mark0

Отображение эскизов кадров с 
основными метками.

Clip 
Thumbnail

Отображение эскизов записанных 
клипов.

Thumbnail >Filter Clips
Задание настроек клипов для отображения.

Пункт Настройка подпункта Описание

OK Отображение только клипов, имеющих 
флаг OK.

NG Отображение только клипов, имеющих 
флаг NG.

KEEP Отображение только клипов, имеющих 
флаг Keep.

None Отображение только клипов, которым 
не заданы никакие флаги.

All Отображение всех клипов, независимо 
от наличия каких-либо флагов.

Thumbnail >Customize View
Переключение вида экрана эскизов.

Пункт Настройка подпункта Описание

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Переключение информации, 
отображаемой под эскизами.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Technical >Color Bars
Задание настроек цветных полос.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение цветовых 
полос.

[Примечание]
Невозможно задать значение On, если 
параметр S&Q Motion >Setting (стр. 87) 
в меню Shooting имеет значение On.

Type ARIB / 100% / 75% / SMPTE Выбор типа цветовой полосы.

Technical >Test Saw
Задание настроек тестового сигнала.

Пункт Настройка подпункта Описание

Test Saw On / Off Включение или выключение сигнала 
теста.

Technical >ND Dial
Задание настроек, относящихся к операциям с диска ND VARIABLE.

Пункт Настройка подпункта Описание

CLEAR with 
Dial

On / Off Задание того, требуется ли включить 
переключение состояния ND (CLEAR 
 On) с помощью диска ND VARIABLE.

Technical >Tally
Задание настроек индикатора записи/съемки.

Пункт Настройка подпункта Описание

Front On / Off Включение и выключение индикатора 
записи/съемки (переднего).

Rear On / Off Включение и выключение индикатора 
записи/съемки (заднего).

Technical >HOLD Switch Setting
Задание настроек переключателя Hold.

Пункт Настройка подпункта Описание

with Rec 
Button

On / Off Установка возможности блокировать 
кнопку записи.

with Hand 
Grip Remote

On / Off Задает блокировку работы пульта 
управления на рукоятке.

Technical >Touch Operation
Задание настроек, относящихся к сенсорному управлению.

Пункт Настройка подпункта Описание

Setting On / Off Включение и выключение сенсорного 
управления.

Technical >Rec Review
Задание настроек просмотра записи.

Пункт Настройка подпункта Описание

Setting 3sec / 10sec / Clip Выбор времени воспроизведения 
только что записанного клипа для 
функции просмотра записи.

Technical >Handle Zoom
Задание настроек масштабирования с помощью органа управления, расположенного на 
рукоятке.

Пункт Настройка подпункта Описание

Setting Off / Low / High / Variable Установка скорости рычага 
масштабирования, расположенного на 
рукоятке.

High От 1 до 8 (8) Задание скорости масштабирования 
для рычага масштабирования на 
рукоятке, когда выбрана скорость 
масштабирования на рукоятке High.

Low От 1 до 8 (3) Задание скорости масштабирования 
для рычага масштабирования на 
рукоятке, когда выбрана скорость 
масштабирования на рукоятке Low.

[Примечание]
Если для скорости масштабирования задано 
низкое значение, возможно неравномерное 
масштабирование.

Technical >GPS
Задание настроек GPS.

Пункт Настройка подпункта Описание

GPS On / Off Включение или выключение функции 
GPS.

[Примечание]
Модуль GPS, встроен в рукоятку.

Меню Technical
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Technical >Menu Settings
Задание настроек, относящихся к меню.

Пункт Настройка подпункта Описание

User Menu 
Only

On / Off Задание отображения только меню 
User (On) или списка меню (Off), когда 
на видеокамере отображается меню.

User Menu 
with Lock

On / Off Задание блокировки отображения 
меню, чтобы отображалось только 
меню User.

[Примечание]
При обычной операции отображения меню 
этот пункт не отображается. Подробную 
информацию об операции отображения 
меню см. на стр. 76.

Technical >Fan Control
Задание настроек режима управления вентилятором.

Пункт Настройка подпункта Описание

Setting Auto / Minimum / Off in Rec Установка режима управления 
вентилятором видеокамеры.

[Примечание]
Даже при выборе Off in Rec вентилятор 
работает, если температура внутри 
видеокамеры поднимается выше 
определенного уровня.

Technical >Lens
Задание настроек, относящихся к объективам.

Пункт Настройка подпункта Описание

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Установка направления вращения 
кольца масштабирования.

[Примечание]
Доступно только при использовании 
объектива с байонетом E, который 
поддерживает переключение направления 
вращения кольца масштабирования.

Shading 
Compensation

Auto / Off Включение/выключение 
автоматической компенсации 
затенения.

[Примечание]
Компенсация затенения не применяется, 
если для режима Imager Scan Mode задано 
значение S35.

Technical >Lens
Задание настроек, относящихся к объективам.

Пункт Настройка подпункта Описание

Chroma 
Aberration 
Comp.

Auto / Off Включение или выключение 
автоматической компенсации 
хроматической аберрации.

[Примечание]
Компенсация хроматической аберрации не 
применяется, если для режима Imager Scan 
Mode задано значение S35.

Distortion 
Comp.

Auto / Off Включение/выключение 
автоматической компенсации 
искажения.

[Примечание]
Компенсация искажений не применяется, 
если для режима Imager Scan Mode задано 
значение S35.

Distance 
Display

Meter / Feet Задание единиц отображения для 
информации об объективе и 
положения фокусировки.

Zoom 
Position 
Display

Focal Length / Number / Bar Задание формата отображения 
положения масштабирования.

Iris Display Auto / F-Number Задание единиц измерения для 
индикации диафрагмы.
Auto: 

Отображение значения T, если 
информацию о значении T можно 
получить из установленного 
объектива. В противном случае 
отображается значение F.

F-Number: 
Всегда отображается значение F.
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Technical >Video Light Set
Задает способ освещения лампой для видеосъемки. Этот параметр доступен только при 
использовании компонента HVL-LBPC (приобретается дополнительно).

Пункт Настройка подпункта Описание

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Установка способа управления 
освещением, которое обеспечивается 
лампой для видеосъемки, 
присоединенной к многоцелевому 
разъему.
Power Link: 

Включение или выключение лампы 
для видеосъемки при включении 
или выключении видеокамеры.

Rec Link: 
Включение или выключение лампы 
для видеосъемки при запуске/
остановке записи.

Rec Link + Stby: 
Включение лампы для 
видеосъемки или перевод ее 
в состояние ожидания при 
запуске/остановке записи.

Technical >APR
Выполнение APR.

Пункт Настройка подпункта Описание

APR Execute / Cancel Запуск APR (Automatic Pixel Restoration 
— Автоматическое восстановление 
пикселей) для автоматической 
регулировки датчика изображения.
Execute: выполнение функции.

[Примечание]
Перед выполнением функции APR всегда 
закрывайте объектив крышкой.

Technical >Camera Battery Alarm
Задание настроек аварийных сигналов о низком напряжении аккумулятора.

Пункт Настройка подпункта Описание

Low Battery 5% / 10% / 15% / … / 45% / 50% Установка уровня оставшегося заряда 
аккумулятора (с дискретностью 5%), по 
достижении которого выдается 
аварийный сигнал о низком 
напряжении.

Technical >Camera Battery Alarm
Задание настроек аварийных сигналов о низком напряжении аккумулятора.

Пункт Настройка подпункта Описание

Battery 
Empty

От 3% до 7% Установка уровня оставшегося заряда 
аккумулятора, при котором выдается 
аварийный сигнал о том, что 
аккумулятор разряжен.

Technical >Camera DC IN Alarm
Задание настроек аварийных сигналов о входном напряжении.

Пункт Настройка подпункта Описание

DC Low 
Voltage1

От 16.0V до 19.0V (16.5V) Установка значения напряжения, при 
котором подается аварийный сигнал о 
низком напряжении на разъеме.

DC Low 
Voltage2

От 15.5V до 18.5V Установка значения напряжения, при 
котором подается аварийный сигнал о 
недостаточном напряжении на 
разъеме.

Technical >Ext. Unit Battery Alarm
Задание настроек аккумулятора XDCA-FX9.

Пункт Настройка подпункта Описание

Near End:Info 
Battery

От 5% до 100% Установка уровня оставшегося заряда 
литиевой батареи (с дискретностью 
5%), по достижении которого выдается 
аварийный сигнал о низком 
напряжении.

End:Info 
Battery

От 0% до 5% Установка уровня оставшегося заряда 
батареи, по достижении которого 
выдается аварийный сигнал о 
разрядке литиевой батареи и 
закрывается доступ к носителям.

Near 
End:Sony 
Battery

От 11.5V до 17.0V Установка уровня оставшегося заряда 
батареи, по достижении которого 
выдается аварийный сигнал о низком 
напряжении для не литиевых батарей.

End:Sony 
Battery

От 11.0V до 14.0V Установка уровня оставшегося заряда 
батареи, по достижении которого 
выдается аварийный сигнал о 
разрядке не литиевых батарей и 
закрывается доступ к носителям.
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Technical >Ext. Unit Battery Alarm
Задание настроек аккумулятора XDCA-FX9.

Пункт Настройка подпункта Описание

Near 
End:Other 
Battery

От 11.5V до 17.0V (11.8V) Установка уровня оставшегося заряда 
батареи, по достижении которого 
выдается аварийный сигнал о низком 
напряжении для батарей Anton/Bauer.

End:Other 
Battery

От 11.0V до 14.0V Установка уровня оставшегося заряда 
батареи, по достижении которого 
выдается аварийный сигнал о 
разрядке батарей Anton/Bauer и 
закрывается доступ к носителям.

Detected 
Battery

Отображение типа источника питания, 
подключенного к XDCA-FX9.
Если к устройству XDCA-FX9 подключен 
аккумулятор, отображается “Info 
Battery”, “Sony Battery” или “Other 
Battery”. Если подключен источник 
питания постоянного тока, 
отображается “DC IN”.
Если питание подается от 
аккумулятора или источника питания 
постоянного тока, подключенного к 
видеокамере, отображается “---”.

Technical >Ext. Unit DC IN Alarm
Задание настроек аварийных сигналов о низком напряжении устройства XDCA-FX9.

Пункт Настройка подпункта Описание

DC Low 
Voltage1

От 11.5V до 17.0V Установка значения напряжения, при 
котором подается аварийный сигнал о 
низком напряжении на разъеме.

DC Low 
Voltage2

От 11.0V до 14.0V Установка значения напряжения, при 
котором подается аварийный сигнал о 
недостаточном напряжении на 
разъеме.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Network >Access Authentication
Задание настроек, относящихся к аутентификации.

Пункт Настройка подпункта Описание

User Name Задание имени пользователя для 
аутентификации доступа.

Password Задание пароля для аутентификации 
доступа.

Network >Wireless LAN
Задание настроек, относящихся к соединениям по беспроводной ЛВС.

Пункт Настройка подпункта Описание

Setting Access Point Mode / Station Mode / Off Выбор режима работы для 
подключения по беспроводной ЛВС.

WPS Execute / Cancel Установление подключения с 
помощью функции WPS (Wi-Fi Protected 
Setup).
Execute: выполнение функции.

NFC Execute / Cancel Установление подключения с 
помощью функции NFC (Near Field 
Communication).
Execute: выполнение функции.

MAC Address Отображение MAC-адреса интерфейса 
беспроводной ЛВС видеокамеры.

Network >AP Mode Settings
Задание настроек, относящихся к подключениям в режиме точки доступа.

Пункт Настройка подпункта Описание

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Задание канала беспроводной 
локальной сети.
Вариант Auto(5GHz) доступен только на 
модели PXW-FX9V/VK.

Camera SSID 
& Password

Отображение SSID сети и пароля 
видеокамеры.

Regenerate 
Password

Execute / Cancel Создание нового пароля.
Execute: выполнение функции.

IP Address Отображение IP-адреса видеокамеры 
в режиме точки доступа.

Subnet Mask Отображение маска подсети 
видеокамеры в режиме точки доступа.

Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Camera 
Remote 
Control

Enable / Disable Задает, требуется ли включить 
дистанционное управление с 
устройства, подключенного к 
видеокамере по беспроводной ЛВС в 
режиме станции.

Connected 
Network

Отображение подключенной 
беспроводной ЛВС (точки доступа).

SSID Отображение SSID для точки доступа, к 
которой производится подключение.

Security Отображение типа безопасности для 
точки доступа, к которой производится 
подключение.

Password Отображение пароля для точки 
доступа, к которой производится 
подключение.
Если для параметра Security задано 

значение WEP или WPA: *******
Если для параметра Security задано 

значение None: (пусто)

DHCP Показывает, включена или выключена 
функция DHCP.

IP Address Отображение IP-адреса видеокамеры, 
если для параметра DHCP задано 
значение Off.

Subnet Mask Отображение маски подсети 
видеокамеры, если для параметра 
DHCP задано значение Off.

Gateway Отображение шлюза по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto Показывает, включено или выключено 
получение DNS.

Primary DNS Server Отображение основного сервера DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.

Secondary DNS Server Отображение дополнительного 
сервера DNS видеокамеры, если для 
параметра DNS Auto задано значение 
Off.

Меню Network
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Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Scan 
Networks

Обнаружение беспроводных ЛВС 
(точек доступа) и отображение списка.
Выберите из списка точку для 
подключения.

SSID Отображение SSID для точки доступа, к 
которой производится подключение.

Security Отображение типа безопасности для 
точки доступа, к которой производится 
подключение.

Password Введите пароль для точки доступа, к 
которой производится подключение.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.

Secondary DNS Server Введите дополнительный сервер DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.

Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Manual 
Register

Регистрация настроек для 
подключения к точке доступа вручную.

SSID Введите SSID для точки доступа, к 
которой производится подключение.

Security 
None / WEP / WPA

Задайте тип безопасности для точки 
доступа, к которой производится 
подключение. Выберите WPA, если 
целевая точка доступа имеет тип 
безопасности WPA или WPA2.

Password Введите пароль для точки доступа, к 
которой производится подключение.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS, если 
для параметра DNS Auto задано 
значение Off.

Secondary DNS Server Введите дополнительный сервер DNS, 
если для параметра DNS Auto задано 
значение Off.
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Network >Wired LAN
Задание настроек, относящихся к соединениям по проводной ЛВС.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
проводной ЛВС.

Camera 
Remote 
Control

Enable / Disable Задает, требуется ли включить 
дистанционное управление с 
устройства, подключенного к 
видеокамере по проводной ЛВС.

Detail 
Settings

Настройка свойств соединения по 
проводной ЛВС.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS, если 
для параметра DNS Auto задано 
значение Off.

Secondary DNS Server Введите дополнительный сервер DNS, 
если для параметра DNS Auto задано 
значение Off.

Network >Modem
Задание настроек, относящихся к модемам.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение 
подключения по модему.

Modem1 
Device Name

Отображение имени устройства для 
модема 1.

Modem1 IP 
Address

Отображение IP-адреса модема 1.

Modem1 
Subnet Mask

Отображение маски подсети для 
модема 1.

Modem2 
Device Name

Отображение имени устройства для 
модема 2.

Modem2 IP 
Address

Отображение IP-адреса модема 2.

Modem2 
Subnet Mask

Отображение маски подсети для 
модема 2.

Network >Network Client Mode
Задание настроек, относящихся к режиму сетевого клиента.

Пункт Настройка подпункта Описание

Setting On / Off Запуск (On) или остановка (Off) режима 
сетевого клиента.

NCM Settings 
Select

Выбор предустановленных настроек 
(NCM Settings1/NCM Settings2/NCM 
Settings3), содержащих заранее 
заданные настройки подключения в 
режиме сетевого клиента.



6. Отображение меню и настройки: Меню Network119

Network >Network Client Mode
Задание настроек, относящихся к режиму сетевого клиента.

Пункт Настройка подпункта Описание

NCM 
Settings1

Display Name Задание отображаемого имени в меню 
NCM Settings.

CCM Address Задание адреса пункта назначения 
CCM для подключения.
Имя узла или IP-адрес

CCM Port (1–65535 (8443)) Задание номера порта пункта 
назначения CCM для подключения.

User Name Задание имени пользователя для 
аутентификации подключения CCM.

Password Задание пароля аутентификации 
подключения CCM.

CCM Certificate 
Load / Clear / None

Загрузка сертификата при 
подключении к CCM или XDCAM air, и 
очистка настроек.

CCM Certificate Status 
Loaded / Default

Отображение состояния загрузки 
сертификата при подключении к CCM 
или XDCAM air.

Camera Control 
Enable / Disable

Включение или выключение 
управления камерой из CCM, когда 
подключен CCM, или с XDCAM air.

Camera Setting 
Always / Onetime / Off

Включение или выключение операций 
All File из CCM, когда подключен CCM, 
или с XDCAM air.
Always: 

Операции All File из CCM или 
XDCAM air включены постоянно.

Onetime: 
Операции All File из CCM или 
XDCAM air включены только 
однократно.

Off: 
Отключение операций All File из 
CCM или XDCAM air.

Reset 
Execute / Cancel

Сброс настроек в пункте NCM Settings 
на значения по умолчанию. Execute: 
выполнение функции.

NCM 
Settings2

То же, что и NCM Settings1.

NCM 
Settings3

То же, что и NCM Settings1.

Network >Network Client Mode
Задание настроек, относящихся к режиму сетевого клиента.

Пункт Настройка подпункта Описание

Streaming 
Quality

Normal / High Задание качества потоковой передачи.

[Примечание]
Эта настройка также сбрасывается при 
выполнении команды All Reset >Reset 
without Network (стр. 121) в меню 
Maintenance.

Network >File Transfer
Задание настроек, относящихся к передаче файлов.

Пункт Настройка подпункта Описание

Auto Upload 
(Proxy)

On / Off Включение или выключение 
автоматической передачи файлов 
прокси.

Default 
Upload 
Server

Выбор сервера для отправки файлов. 
Выбранный здесь сервер становится 
пунктом назначения автоматической 
отправки для файлов прокси, а также 
пунктом назначения отправки для 
файлов с экрана эскизов.
Отображение отображаемого имени, 
настроенного в пунктах Server Settings 
(NCM) и Server Settings 1–3.

Clear 
Completed 
Jobs

Execute / Cancel Удаление завершенных заданий 
передачи из списка.
Execute: выполнение функции.

Clear All Jobs Execute / Cancel Удаление всех заданий передачи из 
списка.
Execute: выполнение функции.

View Job List Отображение списка заданий 
передачи.

Server 
Settings 
(NCM)

Отображение отображаемого имени 
сервера NCM и службы (CCM).

Display Name Отображение отображаемого имени 
сервера NCM.

Service Отображение службы.
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Network >File Transfer
Задание настроек, относящихся к передаче файлов.

Пункт Настройка подпункта Описание

Server 
Settings1

Display Name Задание имени, отображаемого в 
меню настройки пункта назначения 
передачи.

Service 
FTP

Отображение типа сервера.

Host Name Задание имени узла сервера 
назначения передачи.

Port (1–65535 (21)) Задание номера порта сервера 
назначения передачи.

User Name Задание имени пользователя для 
аутентификации подключения сервера 
назначения передачи.

Password Задание пароля аутентификации для 
подключения сервера назначения 
передачи.

Passive Mode 
On / Off

Включение или выключение режима 
PASV.

Destination Directory Введите имя целевого каталога 
передачи.

Using Secure Protocol 
On / Off

Задает, требуется ли использовать (On) 
или не использовать (Off) безопасную 
передачу по FTP (FTPS в явном 
режиме: FTPES).

Root Certificate 
Load / Clear / None

Загрузка корневого сертификата для 
безопасной передачи по FTP и очистка 
настроек.

Root Certificate Status 
Loaded / No Certificate

Отображение состояния загрузки 
корневого сертификата для 
безопасной передачи по FTP.

Reset 
Execute / Cancel

Сброс настроек в пункте Server Settings 
на значения по умолчанию.
Execute: выполнение функции.

Server 
Settings2

То же, что и Server Settings1.

Server 
Settings3

То же, что и Server Settings1.

Network >Network Reset
Сброс сетевых настроек.

Пункт Настройка подпункта Описание

Reset Execute / Cancel Сброс сетевых настроек.
Execute: выполнение функции.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Maintenance >Language
Установка языка интерфейса.

Пункт Настройка подпункта Описание

Select Установка языка интерфейса.
SET: установка языка.

Maintenance >Clock Set
Задание настроек внутренних часов.

Пункт Настройка подпункта Описание

Time Zone От UTC – 12:00 до UTC + 14:00 Установка разницы относительно 
времени UTC с дискретностью 30 
минут.

Date Mode YYMMDD / MMDDYY / DDMMYY Выбор формата отображения дат.
YYMMDD: год, месяц, день
MMDDYY: месяц, день, год
DDMMYY: день, месяц, год

12H/24H 12H / 24H Выбор формата отображения часов.
12H: 12-часовой режим
24H: 24-часовой режим

Date Установка текущей даты.
SET: установка значения.

Time Установка текущего времени.
SET: установка значения.

Maintenance >All Reset
Сброс настроек на заводские значения по умолчанию.

Пункт Настройка подпункта Описание

Reset Execute / Cancel Сброс всех настроек к значениям по 
умолчанию.
Execute: выполнение функции.

Reset without 
Network

Execute / Cancel Сброс настроек меню на заводские 
значения по умолчанию, кроме 
настроек меню Network.

[Примечание]
Network Client Mode >Streaming Quality 
(стр. 119) в меню Network сбрасывается на 
заводскую настройку по умолчанию.

Maintenance >Hours Meter
Отображение общего времени работы.

Пункт Настройка подпункта Описание

Hours 
(System)

Отображение общего количества 
часов использования (невозможно 
сбросить).

Hours (Reset) Отображение общего количества 
часов использования (можно 
сбросить).

Reset Execute / Cancel Сброс параметра Hours (Reset) на 0.
Execute: выполнение функции.

Maintenance >Version
Отображение сведений о версии.

Пункт Настройка подпункта Описание

Version 
Number

Vx.xx Отображение версии программного 
обеспечения видеокамеры.

Ext. Unit 
Version 
Number

Vx.xx Отображение версии программного 
обеспечения устройства XDCA-FX9.

Version Up Execute / Cancel Обновление видеокамеры.*

Execute: выполнение функции.
* Эта функция обновляет программное 

обеспечение видеокамеры.

Lens Version 
Number

Vxx Отображение номера версии 
программного обеспечения объектива 
с байонетом E.

Меню Maintenance
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Данные конфигурации

Параметры меню настройки можно 
сохранять во внутренней памяти 
видеокамеры, на SD-картах и носителях 
“Memory Stick”. Это позволяет быстро 
восстановить набор настроек меню, 
соответствующий текущей ситуации.
Данные конфигурации сохраняются в 
следующих категориях.

Файлы User
В файлах User сохраняются пункты 
настройки и данные персональной 
настройки меню User.
На SD-карте или носителе “Memory Stick” 
можно сохранить до 64 файлов.
Загрузив этот файл в памяти видеокамеры, 
можно задать персональную настройку 
меню User.

Файлы ALL (все настройки)
Файлы ALL сохраняют данные 
конфигурации всех меню. На SD-карте или 
носителе “Memory Stick” можно сохранить 
до 64 файлов.

[Примечание]
Данные, относящиеся к конкретному устройству 
(затенение, выходные уровни и другие данные, 
которые требуют регулировки для конкретного 
устройства) на сохраняются.

Файлы сцен
В файлах сцен сохраняются настройки 
для пунктов окраски, заданные для 
сцен. Можно сохранить до 5 файлов во 
встроенной памяти видеокамеры и до 64 
файлов на SD-карте или носителе “Memory 
Stick”.

Сохранение файла User/файла 
ALL

1 Установите карту памяти SD или 
носитель “Memory Stick” в гнездо для 
карт памяти UTILITY SD/MS (стр. 8) 
этикеткой вправо.

2 Для файла User выберите User File 
(стр. 96) >Save Utility SD/MS >Execute 
в меню Project.
Для файла ALL выберите All File >Save 
Utility SD/MS (стр. 96) >Execute в 
меню Project.
Открывается экран пункта назначения 
для сохранения файла.

3 Выберите строку “No File” на экране 
выбора целевого каталога для 
сохранения файла.
При выборе строки с записью File ID 
выбранный файл будет перезаписан.
File ID создается автоматически, но его 
можно изменить.

4 На экране подтверждения выберите 
Execute.

Загрузка файла User/файла ALL

1 Установите карту памяти SD или 
носитель “Memory Stick” с требуемым 
файлом в гнездо для карт памяти 
UTILITY SD/MS (стр. 8) этикеткой 
вправо.

2 Для файла User выберите User File 
(стр. 96) >Load Utility SD/MS >Execute 
в меню Project.
Для файла ALL выберите All File >Load 
Utility SD/MS (стр. 96) >Execute в 
меню Project.
Отображается экран списка файлов.

3 Выберите файл для загрузки.
Открывается экран подтверждения.

4 Выберите Execute.

[Примечания]
ˎˎ После загрузки данных конфигурации устройство 

автоматически перезагружается.
ˎˎ Когда для параметра All File >Load Network Data 

в меню Project задано значение Off, загружаются 
все настройки из файла ALL, кроме настроек меню 
Network.

Сохранение файла сцен

Сохранение во встроенной памяти

1 Выберите Scene File >Store Internal 
Memory >Execute в меню Paint 
(стр. 101).
Отображается экран списка файлов 
сцен.
Если для параметра File ID задан пункт 
назначения “Standard”, сохраняются 
стандартные заранее заданные 
настройки.

2 Выберите целевой каталог для 
сохранения.
Файл сцены сохраняется, 
перезаписывая любой существующий 
файл в выбранном пункте назначения.

3 На экране подтверждения выберите 
Execute.

Сохранение на SD-карте или носителе 
“Memory Stick”

1 Установите карту памяти SD или 
носитель “Memory Stick” в гнездо для 
карт памяти UTILITY SD/MS (стр. 8) 
этикеткой вправо.

2 Выберите Scene File >Save Utility SD/MS 
>Execute в меню Paint (стр. 101).
Открывается экран пункта назначения 
для сохранения файла сцены.

3 Выберите строку “No File” на экране 
выбора целевого каталога для 
сохранения файла.

Сохранение и загрузка данных конфигурации



6. Отображение меню и настройки: Сохранение и загрузка данных конфигурации123

При выборе строки с записью File ID 
выбранный файл будет перезаписан.
File ID создается автоматически, но его 
можно изменить.

4 На экране подтверждения выберите 
Execute.

Загрузка файла сцены

Загрузка из внутренней памяти

1 Выберите Scene File >Recall Internal 
Memory >Execute в меню Paint 
(стр. 101).
Отображается экран списка файлов 
сцен.

2 Выберите файл для загрузки.
Открывается экран подтверждения.

3 Выберите Execute.

 [Совет]
Файлы сцен можно загружать также с помощью 
прямого меню (стр. 47).

Загрузка с SD-карты или носителя 
“Memory Stick”

1 Установите карту памяти SD или 
носитель “Memory Stick” с требуемым 
файлом сцены в гнездо для карт 
памяти UTILITY SD/MS (стр. 8) 
этикеткой вправо.

2 Выберите Scene File >Load Utility SD/MS 
>Execute в меню Paint (стр. 101).

Отображается экран списка файлов 
сцен.

3 Выберите файл для загрузки.
Открывается экран подтверждения.

4 Выберите Execute.

Изменение идентификатора 
файла

1 Для файла User выберите User File >File 
ID в меню Project (стр. 96).
Для файла ALL выберите All File >File ID 
в меню Project (стр. 96).
Для файла сцены выберите User File 
>File ID в меню Paint (стр. 101).
Открывается экран редактирования 
идентификатора файла.

2 Кнопками со стрелками (стр. 7) или 
многофункциональным диском 
(стр. 4) выберите символ, затем 
нажмите кнопку SET (стр. 7) или 
многофункциональный диск.

3 Повторяйте шаг 2 по мере 
необходимости.

4 Завершив ввод символов, выберите 
Done.
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Подключение внешних мониторов и устройств записи
Для показа на внешнем мониторе 
записанного изображения, которое 
воспроизводит видеокамера, выберите 
выходной сигнал видеокамеры и 
подключите ее к монитору с помощью 
соответствующего кабеля.
К видеокамере также можно подключать 
записывающие устройства, например 
видеомагнитофон, для записи ее 
выходного сигнала.
На внешний монитор можно вывести ту 
же информацию, которая отображается 
в видоискателе, например информацию 
о состоянии и меню. Задайте параметру 
Output Display (стр. 104) в меню Monitoring 
значение On для сигнала соответствующего 
типа, который будет выводиться на 
монитор.

Разъем SDI OUT (тип BNC)

Включение и выключение выхода, а также 
задание выходного формата производится 
в меню Monitoring (стр. 104).
Для подключения используйте имеющийся 
в продаже коаксиальный кабель на 75 Ом.

[Примечание]
Перед включением видеокамеры удостоверьтесь в 
том, что подключение между прибором и внешним 
устройством заземлено.

(Рекомендуется включать видеокамеру и 
внешнее устройство после подсоединения 
коаксиального кабеля на 75 Ом.)
Если внешнее устройство необходимо 
подключить к видеокамере, когда она 
включена, подсоедините коаксиальный 
кабель на 75 Ом сначала к внешнему 
устройству, и только затем подсоедините 
его к видеокамере.

Запуск записи одновременно на 
видеокамере и внешнем устройстве

Включив выход SDI, задайте параметру 
SDI/HDMI Rec Control (стр. 93) >Setting в 
меню Project значение SDI/HDMI Remote I/F 
или Parallel Rec, чтобы обеспечить выдачу 
сигнала запуска записи REC на внешнее 
устройство, подсоединенное к разъему 
SDI OUT. Это обеспечит синхронную запись 
изображения с видеокамеры на внешнем 
устройстве.

[Примечания]
ˎˎ Если подключенное устройство не поддерживает 

сигналы запуска записи REC, использовать его в 
этом режиме невозможно.
ˎˎ Когда кнопке START/STOP и ручке START/STOP 

записи назначено управление различными 
носителями, сигнал запуска записи REC выводится 
в соответствии с работой гнезда A.

Разъем HDMI OUT (разъем типа 
A)

Включение и выключение выхода, а также 
задание выходного формата производится 
в меню Monitoring (стр. 104).
Для подключения используется имеющийся 
в продаже высокоскоростной кабель HDMI.
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Внешняя синхронизация
При съемке с помощью нескольких 
видеокамер их можно синхронизировать 
по определенному опорному сигналу или 
временному коду через разъем внешней 
синхронизации видеокамер.

Синхронизация фаз 
видеосигналов (внешняя 
синхронизация)

Чтобы включить внешнюю синхронизацию, 
установите переключатель выбора IN/
OUT (стр. 8) видеокамеры в положение 
IN и подайте опорный сигнал на разъем 
GENLOCK IN/REF OUT (стр. 8).
Доступные опорные сигналы зависят от 
частоты системы выбранного формата 
записи.

Частота системы 
формата записи

Допустимые опорные 
сигналы

59.94P 1920×1080 59.94i 
720×486 59.94i 
1280×720 59.94P

50P 1920×1080 50i 
720×576 50i 
1280×720 50P

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i(24PsF)

23.98P 1920×1080 47.95i (23.98PsF)

59.94i 1920×1080 59.94i 
720×486 59.94i

50i 1920×1080 50i 
720×576 50i

[Примечания]
ˎˎ Если опорный сигнал нестабилен, обеспечить 

внешнюю синхронизацию не удастся.
ˎˎ Поднесущая не синхронизируется.

Привязка временного кода к 
другим устройствам

Переведите устройство, подающее 
временной код, в режим, в котором 
поддерживается выдача временного кода 
(например Free Run или Clock).

1 Настройте пункт Timecode (стр. 102) в 
меню TC/Media следующим образом.
Mode: Preset
Run: Free Run

2 Нажмите программируемую кнопку 
(стр. 47), которой назначена функция 
DURATION/TC/UBIT, чтобы отобразить 
временной код на экране.

3 Убедитесь, что переключатель выбора 
IN/OUT (стр. 8) установлен в 
положение IN, затем подайте опорный 
видеосигнал HD или SD на разъем 
GENLOCK IN/REF OUT и опорный 
временной код на разъем TC IN/OUT.

Генератор временного кода видеокамеры 
привязывается к опорному временному 
коду, и на экране появляются символы “EXT-
LK”.
После того, как пройдет примерно десять 
секунд после привязки временного кода, 
состояние, сформированное привязкой к 
внешнему сигналу, будет поддерживаться 
даже в случае отключения внешнего 
источника опорного сигнала временного 
кода.

[Примечания]
ˎˎ Соотношение фаз подаваемого опорного 

временного кода и опорного видеосигнала 
должно соответствовать стандарту временных 
кодов SMPTE.
ˎˎ При работе в режиме привязки к внешнему 

сигналу временной код мгновенно привязывается 
к внешнему источнику, и значение внешнего 
временного кода появляется в области 
отображения данных. Однако не начинайте запись 
сразу же. Перед записью следует подождать 
несколько секунд, пока генератор временного 
кода не стабилизируется.
ˎˎ Если частота кадров опорного видеосигнала 

и частота кадров, заданная в видеокамере, не 
совпадают, установить привязку не удастся, а 
видеокамера не будет работать надлежащим 
образом. В этом случае привязка временного кода 
видеокамеры ко внешнему временному коду не 
будет установлена.
ˎˎ В случае отключения источника внешнего 

временного кода в видеокамере временной код 
может смещаться на один кадр в час относительно 
опорного временного кода.

Отключение внешней привязки

Измените значение параметра Timecode 
в меню TC/Media или выключите 
видеокамеру.
Внешняя синхронизация также отключается 
при изменении частоты системы или при 
начале съемки в специальном режиме 
(Slow & Quick Motion или Interval Rec).

Синхронизация временного 
кода другого устройства с 
временным кодом 
видеокамеры

Переведите устройство, подающее 
временной код, в режим, в котором 
поддерживается выдача временного кода 
(например Free Run или Clock).

1 Задайте временной код видеокамеры с 
помощью пункта Timecode (стр. 102) 
меню TC/Media.

2 Убедитесь, что переключатель выбора 
IN/OUT (стр. 8) установлен 
в положение OUT, и подключите 
разъемы TC IN/OUT и GENLOCK IN/REF 
OUT к входам сигнала временного кода 
и опорного сигнала, соответственно, на 
устройстве, которое требуется 
синхронизировать.
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Монтаж клипов и управление ими на компьютере

Подключение с помощью 
кабеля USB

Использование устройства чтения 
карт XQD (не входит в комплект 
поставки)

Подключите устройство чтения карт 
XQD с помощью кабеля USB и вставьте 
карту памяти в гнездо. Карта памяти 
будет распознана компьютером как 
внешний носитель. На поддерживаемых 
компьютерах можно импортировать клипы 
на высокой скорости с использованием 
режима накопителя видеокамеры.

Использование режима накопителя

Подключите видеокамеру с помощью 
кабеля USB и установите карту памяти в 
гнездо A или B для карт XQD. Карта памяти 
распознается компьютером как внешний 
носитель.

1 Снимите пульт управления на рукоятке 
с видеокамеры и подсоедините разъем 
USB/многоцелевой разъем (стр. 4) к 
компьютеру с помощью кабеля USB.

2 Установите переключатель POWER 
видеокамеры в положение ON.
На экране видоискателя появится 
сообщение с вопросом о том, включить 
ли подключение USB.

 [Примечание]
Сообщение о подтверждении подключения 
USB не отображается, когда на экране имеется 
другое сообщение о подтверждении или ходе 
выполнения. Например, когда производится 
форматирование или восстановление карты 
памяти XQD.

Сообщение о подтверждении появится 
по завершении форматирования или 
восстановления. Сообщение о подтверждении 
подключения USB также не появляется, когда 
отображается экран свойств клипа. Сообщение 
будет отображено по завершении обработки или 
после возврата на экран эскизов.

3 Поворачивая многофункциональный 
диск, выберите Execute.

4 При использовании ОС Windows 
откройте окно “Мой компьютер”. Карта 
памяти в нем должна быть обозначена 
как съемный диск.
При использовании Macintosh 
удостоверьтесь в том, что на рабочем 
столе появилась папка (редактируемая) 
“NO NAME” или “Untitled”.

[Примечания]
ˎˎ Если индикатор доступа горит красным, не 

выполняйте следующие операции.
 – Выключение питания. Отсоединение кабеля 

питания
 – Извлечение карты памяти XQD
 – Отсоединение кабеля USB

ˎˎ Выполнение этой операции на всех компьютерах 
не гарантируется.

Использование систем 
нелинейного монтажа

В системе нелинейного монтажа требуется 
наличие ПО для монтажа (не входит в 
комплект поставки), которое поддерживает 
форматы, записываемые видеокамерой.
Перед редактированием видео сохраните 
нужные вам клипы на жесткий диск 
компьютера с помощью специального 
программного приложения.
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Предупреждения
При образовании конденсата

Если устройство принесли с холода 
в теплое помещение или если резко 
повысилась температура окружающей 
среды, на внешней поверхности 
устройства и/или внутри устройства 
может образоваться влага. Эта явление 
называется конденсацией. В случае 
возникновения конденсации выключите 
устройство и дождитесь исчезновения 
влаги перед использованием устройства. 
Использование влажного устройства может 
привести к его повреждению.

ЖК-экраны

ЖК-панель, установленная на данном 
устройстве, произведена по высокоточной 
технологии, что позволяет достичь не 
менее 99,99 % рабочих пикселей. Несмотря 
на это крайне малая часть пикселей может 
быть “битыми”: постоянно выключенные 
(черные), включенные (красный, зеленый 
или синий) или мигающие. Кроме того, эти 
“битые” пиксели могут внезапно появиться 
после длительного использования. Это 
связано с физическими характеристиками 
жидкокристаллических экранов. Это 
не является неисправностью. Обратите 
внимание: эти проблемы не влияют на 
записанные данные.

Влияние на датчик изображения 
КМОП камеры

[Примечание]
Следующие возможные явления в изображениях 
специфичны для датчиков изображений. Они не 
означают неисправность.

Белые точки
Несмотря на то, что датчики изображения 
производятся с использованием 
высокопрецизионных технологий, в редких 

случаях на экране могут возникать белые 
точки, вызванные космическими лучами и 
т. п.
Это объясняется принципом создания 
датчиков изображения и не является 
неисправностью.
Белые точки большей частью возникают в 
следующих случаях:
ˎˎ при высокой температуре окружающей 
среды;
ˎˎ при повышении чувствительности.

Дрожание
При съемке при освещении 
флуоресцентным светом, натриевыми 
лампами, ртутными лампами или 
светодиодами может дрожать изображение 
на экране или могут изменяться цвета.

Расходные материалы

ˎˎ Вентилятор и батарея являются 
расходными деталями, которые 
необходимо периодически заменять.  
При работе при комнатной температуре 
замену необходимо проводить через 
каждые 5 лет. Однако данный цикл 
является только рекомендуемым и 
не подразумевает гарантированную 
работу этих деталей в течение этого 
времени. Для получения дополнительной 
информации о замене деталей 
обратитесь в сервисный центр Sony или к 
поставщику.
ˎˎ Средний срок службы адаптера 
переменного тока и электролитического 
конденсатора составляет около 5 
лет при нормальной температуре 
работы и нормальном использовании 
(8 часов в день, 25 дней в месяц). 
Если использование превышает 
указанную выше нормальную частоту 
использования, продолжительность 
работы может соответственно 
уменьшиться.

ˎˎ Клемма батареи данного устройства 
(разъем для аккумуляторных блоков и 
адаптеров переменного тока) является 
расходуемой деталью.  
Питание может не подаваться на 
устройство надлежащим образом, если 
штырьки клеммы батареи изогнуты или 
деформированы вследствие удара или 
вибраций, либо если они ржавеют из-за 
длительного использования на открытом 
воздухе.  
Рекомендуется проводить периодические 
осмотры для обеспечения должной 
работы устройства и увеличения 
срока его службы. Для получения 
дополнительных сведений об осмотрах 
обратитесь к представителю службы 
технического обслуживания или отдела 
продаж компании Sony.

О встроенном элементе питания

В видеокамере имеется встроенный 
элемент питания для хранения данных 
о дате, времени и других данных даже 
в случае выключения видеокамеры. 
Встроенный аккумулятор зарядится через 
24 часа, если устройство подключено 
к электрической розетке с помощью 
адаптера переменного тока или если 
установлен полностью заряженный 
основной аккумулятор, независимо от того, 
включена ли видеокамера. Аккумулятор 
полностью разрядится примерно за 3 
месяца, если не подключен адаптер 
переменного тока или видеокамера 
используется без аккумулятора. 
Используйте видеокамеру после зарядки 
элемента питания. Однако даже если этот 
заряжаемый элемент питания не заряжен, 
на работу видеокамеры это не повлияет, 
если при работе не требуется записывать 
дату и время.

Автоматическая регулировка датчика 
изображения

Если функция APR не выполнялась в 
течение заданного времени после 
установки времени и даты, отображается 
сообщение, предлагающее выполнить 
функцию APR.

Места использования и хранения

Хранить на ровной поверхности в хорошо 
проветриваемом месте.
Не следует использовать или хранить 
устройство в следующих местах.
ˎˎ При чрезмерно высокой или низкой 
температуре (диапазон рабочей 
температуры: от 0 °C до 40 °С) 
Помните, что летом в теплом климате 
температура в автомобиле с закрытыми 
окнами может превышать 50 °C.
ˎˎ В сырых и запыленных местах
ˎˎ В местах, где устройство может оказаться 
под дождем
ˎˎ В местах, где присутствует сильная 
вибрация
ˎˎ Вблизи сильных магнитных полей
ˎˎ Около радио или телевизионных 
передатчиков, формирующих сильные 
электромагнитные поля
ˎˎ Под прямым солнечным светом или 
вблизи нагревательных приборов 
в течение длительного времени

Во избежание электромагнитных 
помех от портативных 
коммуникационных устройств

Использование портативных телефонов 
и других коммуникационных устройств 
рядом с этой камерой может привести 
к неполадкам и помехам аудио- и 
видеосигналов. Рекомендуется отключать 
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питание портативных коммуникационных 
устройств рядом с этой камерой.

Примечание в отношении лазерных 
лучей

Лазерные лучи могут повредить 
светочувствительные матрицы КМОП. При 
съемке эпизода, в котором присутствуют 
лазерные лучи, не допускайте направления 
лазерного луча на объектив устройства. 
В частности, мощные лазерные лучи, 
испускаемые устройствами медицинского 
или иного назначения, могут вызвать 
повреждения вследствие отражения или 
рассеивания света.

Предупреждения по мерам 
безопасности

ˎˎ Используйте под защитой надежного 
брандмауэра. Не подключайте устройство 
к сети, в которой возможно подключение 
к устройствам, не являющимися 
доверенными.
ˎˎ Если доступен протокол FTPS, 
используйте его. При использовании 
обычного протокола FTP содержимое, 
имена пользователей и пароли не 
шифруются.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ 
ТО НИ БЫЛО УЩЕРБ, ВОЗНИКШИЙ 
ВСЛЕДСТВИЕ НЕСОБЛЮДЕНИЯ 
МЕР ПРЕДОСТОРОЖНОСТИ ПРИ 
ИСПОЛЬЗОВАНИИ УСТРОЙСТВ 
ПЕРЕДАЧИ ДАННЫХ, НЕИЗБЕЖНЫХ 
УТЕЧЕК ИНФОРМАЦИИ, СВЯЗАННЫХ СО 
СПЕЦИФИКАЦИЯМИ ПЕРЕДАЧИ ДАННЫХ, 
ИЛИ ПРОБЛЕМ БЕЗОПАСНОСТИ ЛЮБОГО 
РОДА.
ˎˎ В зависимости от операционной среды 
возможен несанкционированный доступ 
посторонних лиц к устройству. При 

подключении устройства к сети убедитесь 
в том, что сеть надежно защищена.
ˎˎ Передаваемое содержимое может быть 
непреднамеренно перехвачено третьими 
лицами, находящимися в зоне действия 
сигнала. Используя беспроводную 
локальную сеть, принимайте 
необходимые меры для обеспечения 
безопасности передачи содержимого.
ˎˎ При использовании устройства, 
подключенного к сети, в целях 
безопасности рекомендуется 
изменить заводские настройки по 
умолчанию для ограничения доступа 
(стр. 116). Особенно следует проявлять 
осторожность при подключении к 
открытой сети.  
Также, с точки зрения безопасности, 
рекомендуется задавать пароль, 
состоящий из строки символов 
достаточной длины, который сложно 
угадать, и хранить его в безопасном 
месте.
ˎˎ Во время установки настроек и после ее 
завершения не заходите на какие-либо 
веб-сайты через веб-браузер.  
Поскольку состояние входа сохраняется 
в браузере, по завершении настроек 
закройте веб-браузер, чтобы 
предотвратить несанкционированный 
доступ посторонних лиц к устройству и 
воздействие вредоносного программного 
обеспечения.
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Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 
1920×1080P (Level A)).

[Примечания]
ˎˎ Разрешение формата вывода ограничено настройками Rec Format >Frequency, Video Format и другими 

настройками в меню Project (стр. 90).
ˎˎ Воспроизводимое изображение не выводится, если разрешение вывода видео выше разрешения 

изображения.

Форматы выходного сигнала на разъеме SDI OUT/HDMI OUT

Частота системы 
(Rec Format 
>Frequency в 
меню Project)

Видеоформат 
(Rec Format 
>Video Format в 
меню Project)

Формат вывода (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Частота системы 
(Rec Format 
>Frequency в 
меню Project)

Видеоформат 
(Rec Format 
>Video Format в 
меню Project)

Формат вывода (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 1920×1080P /  
только RAW1)

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i

– – 720×480P/ 
720×576P

29.97 / 25 4096×2160P 4096×2160P – 4096×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

3840×2160P 3840×2160P – 3840×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

1920×1080P /  
только RAW1)

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

24 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

только RAW1) 1920×1080P 1920×1080P 1920×1080P

23.98 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 1920×1080P 1920×1080P

1920×1080P /  
только RAW1)

1920×1080P 1920×1080P 1920×1080P

1) Без внутренней записи

Форматы и ограничения для выходов
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Ограничения таблицы соответствия монитора

Функция Monitor LUT доступна в режиме Cine EI для записи с разрешением 4096×2160 или 
3840×2160.
Если для параметра Monitor LUT Setting >Monitor Out в меню Shooting задано значение 
MLUT On и разрешение вывода изображения составляет 1920×1080, таблица соответствия 
монитора применяется к выводимому изображению.
Если разрешение вывода изображения равно 4096×2160 или 3840×2160, записанное 
изображение выводится без изменений.

Ограничения в отношении вывода на дисплей

Меню и состояние, внедренные в каждый выходной сигнал (SDI1, SDI2, HDMI), определяются 
выходным разрешением, заданным параметром Output Format, а также настройкой Output 
Display >Setting из меню Monitoring.

Разрешение 
выхода

Output Display 
>Setting

Output Display 
>SDI1

Output Display 
>SDI2

Output Display 
>HDMI

4K On On – (выход выключен) On

Off Off – (выход выключен) Off

HD On Off On On

Off Off Off Off
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Подготовка источника питания

Признак неисправности Причина Действия по устранению

Видеокамера не 
включается.

Не установлен аккумулятор 
или не подается питание 
на разъем DC IN.

Установите аккумулятор (стр. 19) 
или подключите питание от сети 
переменного тока с помощью 
адаптера переменного тока 
(стр. 20).

Аккумулятор полностью 
разряжен.

Замените аккумулятор полностью 
заряженным (стр. 19).

Во время работы питание 
отключается.

Аккумулятор полностью 
разрядился.

Замените аккумулятор полностью 
заряженным (стр. 19).

Аккумулятор очень быстро 
разряжается.

Очень низкая температура 
окружающей среды.

Это связано с характеристиками 
аккумулятора и не является 
дефектом.

Аккумулятор недостаточно 
заряжен.

Зарядите аккумулятор (стр. 19).
Если аккумулятор быстро 
разряжается даже после полной 
зарядки, вероятно, закончился срок 
его службы. Замените аккумулятор 
новым.

Запись/воспроизведение

Признак неисправности Причина Действия по устранению

При нажатии кнопки 
записи запись не 
начинается.

Карта памяти XQD 
полностью заполнена.

Замените карту памяти XQD картой с 
достаточным свободным 
пространством.

Карта памяти XQD требует 
восстановления.

Выполните восстановление карты 
памяти XQD (стр. 31).

Запись звука невозможна. Диски AUDIO LEVEL (CH1/
CH2/CH3/CH4) установлены 
на минимальный уровень.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2/CH3/
CH4) (стр. 45).

Звук записывается с 
искажениями.

Слишком высокий уровень 
записи звука.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2/CH3/
CH4) (стр. 45).

Признак неисправности Причина Действия по устранению

В записанном звуке 
слишком много шумов.

Слишком низкий уровень 
записи звука.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2/CH3/
CH4) (стр. 45).
Если выбран внешний микрофон, 
также настройте параметр INPUT MIC 
Reference в пункте Audio Input меню 
Audio (стр. 107).

Клипы не воспроизводятся. Клип редактируется. Воспроизведение клипов 
невозможно, если изменены имена 
файлов или папок или если клип 
используется на компьютере. Это не 
является признаком неисправности.

Клип записывается на 
другом устройстве.

Клипы, записанные на других 
устройствах, могут не 
воспроизводиться или отображаться 
с неправильным размером. Это не 
является признаком неисправности.

Внешние устройства

Признак неисправности Действия по устранению

Компьютер не распознает 
видеокамеру.

Отсоедините кабель USB от компьютера, затем снова надежно 
подсоедините его.

Отсоедините кабель USB от компьютера, перезагрузите 
компьютер и снова выполните все шаги в правильном 
порядке.

Не удается загрузить клипы в 
компьютер.

Отсоедините кабель USB от компьютера, перезагрузите 
видеокамеру, затем снова подсоедините ее.

Для загрузки клипов в компьютер на него должно быть 
установлено прикладное программное обеспечение 
(стр. 126).

Устранение неисправностей
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Подключение по беспроводной ЛВС

[Примечание]
Препятствия и электромагнитные помехи между видеокамерой и точкой доступа беспроводной ЛВС или 
оконечного устройства, а также окружающая обстановка (например, материал стен) могут сократить диапазон 
связи или полностью исключить подключения. При возникновении таких проблем проверьте состояние 
подключения/связи после перемещения видеокамеры в другое место или уменьшения расстояния между 
видеокамерой и точкой доступа/оконечным устройством.

Признак неисправности Действия по устранению

Оконечное устройство не 
может получить доступ к 
видеокамере.

 ˎ Проверьте подключение по беспроводной ЛВС (IP-адрес и т. 
п.).

 ˎ Настройки связи между точкой доступа и клиентом могут 
быть недействительными. Подробные сведения см. в 
инструкции по эксплуатации точки доступа.

Невозможно выполнить вход в 
видеокамеру.

Проверьте заданные имя пользователя и пароль.

Не отображается веб-
интерфейс дистанционного 
управления.

Проверьте настройку IP-адреса.

Подключение к Интернету

Признак неисправности Действия по устранению

Не удается выполнить 
отправку файлов.

Неправильные имя пользователя и пароль сервера.
Введите правильные имя пользователя и пароль.

Отправка файлов недоступна. Плохие условия приема сигнала 3G/4G.
Переместитесь в другое место и повторите попытку.

При использовании фильтра ND

Признак неисправности Действия по устранению

Фильтр ND не перемещается. Фильтр ND можно вручную переместить в положение Clear с 
помощью приведенной ниже процедуры.

1 Установите переключатель POWER видеокамеры в выключенное положение.

2 Снимите круглую крышку на нижней стороне.

3 Вставьте в отверстие отвертку и поворачивайте ее против часовой стрелки.
ˎˎ Фильтр нейтральной плотности перемещается в положение Clear при повороте 
против часовой стрелки. Продолжайте поворачивать, пока не достигните положения 
Clear.
ˎˎ Используйте отвертку диаметром 2,4 мм или менее. Отвертка вставляется на глубину 
приблизительно 3,0 см.

Отверстие для отвертки
(при снятой крышке)

4 Установите переключатель ND PRESET/VARIABLE (стр. 6) в положение PRESET и 
установите кнопки вверх/вниз ND FILTER POSITION (стр. 6) в положение CLEAR.

[Примечания]
ˎˎ Не используйте приведенную выше процедуру во время обычной работы. Используйте эту процедуру 

только в том случае, если фильтр нейтральной плотности не двигается. Если использовать эту процедуру во 
время обычной работы, можно повредить фильтр нейтральной плотности.
ˎˎ После использования приведенной выше процедуры обратитесь в сервисный центр Sony для ремонта 

видеокамеры.
ˎˎ Если после выполнения приведенной выше процедуры по-прежнему отображается сообщение об ошибке, 

все равно можно снимать.
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Если в видеокамере возникает ситуация, приводящая к появлению уведомления, 
предупреждения или состояния, которое требует подтверждения, в видоискателе 
отображается сообщение, индикатор записи/съемки начинает мигать и подается звуковой 
сигнал.
Звуковой сигнал подается через встроенный динамик и наушники, подключенные к 
разъему для наушников.

Сообщения об ошибках

Видеокамера перестанет работать, когда на экране отображаются следующие сообщения.

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

E + код ошибки Непрерывный Быстрое 
мигание

Указывает на нештатное состояние в 
видеокамере. Запись останавливается, если в 
видоискателе отображается REC.
Выключите видеокамеру и проверьте все 
подключенные устройства, кабели и носители. 
Если после включения видеокамеры 
сообщение об ошибке снова появится, 
обратитесь к представителю службы 
технического обслуживания компании Sony.
(Если видеокамера не выключается, когда 
переключатель POWER переведен в 
положение OFF, извлеките аккумулятор или 
отсоедините шнур питания от разъема DC IN.)
Ошибка может не отображаться или звуковой 
сигнал может не подаваться в зависимости от 
состояния видеокамеры.

Предупредительные сообщения

Если на экране отображаются следующие сообщения, выполните приведенные 
инструкции.

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

Battery Near End Прерывистый Мигает Заряд аккумулятора заканчивается.
Подзарядите его как можно скорее.

Battery End Непрерывный Быстрое 
мигание

Аккумуляторный блок разряжен. Запись 
отключена.
Выключите видеокамеру и замените 
аккумуляторный блок.

Temperature High Прерывистый Мигает Высокая внутренняя температура.
Выключите видеокамеру и дайте ей остыть 
перед тем, как продолжить работу.

Voltage Low Прерывистый Мигает Напряжение на входе DC IN слишком низкое 
(уровень 1). Проверьте источник питания.

Insufficient Voltage Непрерывный Быстрое 
мигание

Напряжение на входе DC IN слишком низкое 
(уровень 2). Запись отключена.
Подключите другой источник питания.

Media Near Full Прерывистый Мигает На карте памяти XQD остается мало 
свободного места.
Замените ее как можно скорее.

Media Full Непрерывный Быстрое 
мигание

Клипы нельзя записывать или копировать, 
поскольку на карте памяти XQD не осталось 
свободного места.
Замените ее немедленно.

Clips Near Full Прерывистый Мигает Количество дополнительных клипов, которые 
можно записать на карту памяти XQD, мало.
Замените ее как можно скорее.

Clips Full Непрерывный Быстрое 
мигание

Достигнуто максимальное количество клипов, 
которые можно записать на карту памяти XQD.
Запись или копирование дополнительных 
клипов невозможно. Замените ее немедленно.

Last Clip Recording Прерывистый Мигает Текущий записываемый клип является 
последним клипом, который может быть 
записан, так как достигнуто максимальное 
количество клипов.
Подготовьте новую карту памяти XQD.

Media(A)1) Near Full Прерывистый Мигает При использовании функции Simul Rec

Media(A)1) Full Непрерывный Быстрое 
мигание

При использовании функции Simul Rec

Media(A)1) Clips Near 
Full

Прерывистый Мигает При использовании функции Simul Rec

Media(A)1) Clips Full Непрерывный Быстрое 
мигание

При использовании функции Simul Rec

Предупреждения относительно эксплуатации



8. Приложение: Предупреждения относительно эксплуатации134

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

Media(A)1) Last Clip 
Rec

Прерывистый Мигает При использовании функции Simul Rec

1) “(B)” отображается для карты в гнезде B.

Уведомления и сообщения о работе прибора

В центре экрана могут отображаться следующие уведомления и сообщения о работе 
прибора. Для устранения причины уведомления выполните приведенные инструкции.

Сообщение на дисплее Причина и решение

Battery Error
Please Change Battery

Обнаружена неполадка аккумуляторного блока.
Замените его на работоспособный аккумуляторный блок.

Backup Battery End
Please Change

Оставшегося заряда резервной батареи недостаточно.
Зарядите резервную батарею.

Unknown Media (A) 1)

Please Change
Вставлена разбитая на разделы карта памяти или карта 
памяти, которая не поддерживается видеокамерой.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить.

Cannot Use Media (A) 1)

Unsupported File System
Вставлена карта памяти с другой файловой системой или 
неформатированная карта памяти.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить или отформатировать с помощью 
видеокамеры.

Media Needs to be Restored На карте памяти возникла ошибка. Необходимо выполнить 
восстановление карты.
Восстановите карту памяти.

Media Error
Cannot Record to Media (A) 1)

Возможно, карта памяти повреждена и ее больше нельзя 
использовать для записи.
Воспроизведение возможно, поэтому рекомендуется сделать 
копию данных и заменить карту памяти.

Media Error
Cannot Use Media (A) 1)

Возможно, карта памяти повреждена и ее больше нельзя 
использовать для записи или воспроизведения.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить.

Media (A) 1) Error
Recording Halted
Playback Halted

Запись и воспроизведение были остановлены, потому что при 
использовании карты памяти возникла ошибка.
Если проблема сохранится, замените карту памяти.

Сообщение на дисплее Причина и решение

Media Reached Rewriting Limit
Change Media (A) 1)

Срок службы карты памяти закончился.
Сделайте резервную копию и замените карту памяти 
немедленно. Если продолжить использование карты, то запись 
и воспроизведение будут возможны.
Для получения более подробных сведений см. инструкцию по 
эксплуатации карты памяти.

Copy All Sub Clips
NG: Reached Clip Number Limit
NG: Same File Already Exists
NG: Not Enough Capacity

Не удалось скопировать все дополнительные клипы с 
помощью функции Copy All Sub Clips по отображаемой 
причине.

 ˎ Достигнуто максимальное количество клипов.
 ˎ Имеется файл с таким же именем.
 ˎ Недостаточно места для копирования.

Замените носитель.

The specified address is invalid. Указан недопустимый адрес.
Проверьте правильность настройки.

Cannot Use Specified Port 
Number

Указан недопустимый номер порта.
Проверьте правильность настройки.

Fan Stopped Встроенный вентилятор остановился.
Не используйте перегретую видеокамеру, отключите питание 
и свяжитесь с представителем службы технического 
обслуживания компании Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera 
Position
Please save All File again

Настройка формата именования клипов была сброшена из-за 
того, что был загружен недопустимый файл ALL.
Задайте нужные настройки формата и попытайтесь снова 
сохранить файл ALL.

Lens I/F Error(xx:xx) При установленном объективе с байонетом E обнаружена 
ошибка связи в интерфейсе объектива.
Проверьте состояние соединения с объективом с байонетом E.
Если неполадка сохраняется, обратитесь к представителю 
службы технического обслуживания компании Sony и 
сообщите ему код ошибки (пять символов в скобках).

This Multi Term. acc is not 
supported by the device and 
cannot be used.
Please verify the compatibility.

Обнаружен несовместимый аксессуар.
Единственный аксессуар для многофункционального разъема, 
который поддерживается данным устройством, — это 
входящий в комплект поставки пульт управления на рукоятке.

Failed Эта ошибка может отображаться, если не удается получить 
адрес, когда для параметра DHCP задано значение On.
Проверьте настройки сервера DHCP.

Cannot add auto upload job of 
Proxy file because maximum 
number of upload jobs was 
reached.

Достигнуто максимальное количество заданий передачи.
Удалите ненужные задания. Кроме того, может быть 
неправильной настройка пункта назначения автоматической 
отправки для файлов прокси. Проверьте правильность 
настройки.
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Сообщение на дисплее Причина и решение

<SSID>Not found. Не удается найти сеть (точку доступа) с указанным 
идентификатором <SSID>.
Проверьте правильность настройки.

<SSID>Authentication Failed Не удалось выполнить аутентификацию подключения к сети 
(точке доступа) с указанным идентификатором <SSID>.
Проверьте правильность пароля и других настроек.

An IP address conflict has 
occurred. Please check the 
network settings.

Имеется конфликт в сетевых адресах беспроводной ЛВС, 
проводной ЛВС, модема или между модемами.
Измените адрес вручную или измените настройки для 
сетевого маршрутизатора.

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

IP-адрес режима точки доступа беспроводной ЛВС был 
изменен из-за конфликта в сетевых адресах режима точки 
доступа беспроводной ЛВС, проводной ЛВС или модема.
Проверьте настройку IP-адреса.

1) “(B)” отображается для карты в гнезде B.
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Пункты, задаваемые в меню настройки

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Да Да

ISO/Gain<H> Да Да

ISO/Gain<M> Да Да

ISO/Gain<L> Да Да

Exposure Index<H> Да Да

Exposure Index<M> Да Да

Exposure Index<L> Да Да

Shockless Gain Да Да

Base Sensitivity Да Да

Base ISO Да Да

ND Filter Preset1 Да Да

Preset2 Да Да

Preset3 Да Да

Shutter Mode Да Да

Shutter Speed On/Off Да Да

Shutter Speed Да Да

Shutter Angle Да Да

ECS On/Off Да Да

ECS Frequency Да Да

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Да Да

Mode Да Да

Speed Да Да

AGC Да Да

AGC Limit Да Да

AGC Point Да Да

Auto Shutter Да Да

A.SHT Limit Да Да

A.SHT Point Да Да

Clip High light Да Нет

Detect Window Да Нет

Detect Window Indication Да Да

Average Peak Level Ratio Да Нет

Custom Width Да Нет

Custom Height Да Нет

Custom H Position Да Нет

Custom V Position Да Нет

White Preset White Да Нет

Color Temp <A> Да Да*1

Tint<A> Да Да*1

R Gain <A> Да Да*1

B Gain <A> Да Да*1

Color Temp <B> Да Да*1

Tint<B> Да Да*1

R Gain <B> Да Да*1

B Gain <B> Да Да*1

White Setting Shockless White Да Нет

ATW Speed Да Нет

White Switch<B> Да Да

Filter White Memory Да Нет

Элементы, сохраненные в файлы
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Да Нет

Offset Color Temp<A> Да Нет

Offset Tint<A> Да Нет

Offset White <B> Да Нет

Offset Color Temp<B> Да Нет

Offset Tint<B> Да Нет

Offset White<ATW> Да Нет

Offset Color Temp<ATW> Да Нет

Offset Tint<ATW> Да Нет

Focus AF Transition Speed Да Нет

AF Subj. Shift Sens. Да Нет

Focus Area Да Нет

Focus Area (AF-S) Да Нет

Face/Eye Detection AF Да Нет

Push AF Mode Да Нет

AF Assist Да Нет

S&Q Motion Setting Да Нет

Frame Rate Да Нет

Monitor LUT Category Да Нет

LUT Select Да Нет

User 3D LUT Select Да Нет

Monitor LUT Setting Internal Rec Да Нет

Monitor Out Да Нет

HD(Sub) Rec/Proxy – –

SDI1 – –

SDI2 – –

HDMI – –

VF/Streaming – –

Monitor 3D LUT Load SD Card – –

Reset – –

Reset All – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Noise Suppression Setting(SDR/HDR) Да Да

Level(SDR/HDR) Да Да

Setting(Cine EI) Да Нет

Level(Cine EI) Да Нет

Flicker Reduce Mode Да Нет

Frequency Да Нет

SteadyShot Setting Да Нет

Auto Black Balance Auto Black Balance – –

Project Base Setting Shooting Mode Да Нет

Rec Format Frequency Да Нет

Imager Scan Mode Да Нет

Codec Да Нет

RAW Output Format Да Нет

Video Format Да Нет

Cine EI Setting Color Gamut Да Нет

Simul Rec Setting Да Нет

Rec Button Set Да Нет

4K & HD (Sub) Rec Setting Да Нет

Proxy Rec Setting Да Нет

Proxy Format Да Нет

Audio Channel Да Нет

Interval Rec Setting Нет Нет

Interval Time Да Нет

Number of Frames Да Нет

Pre-Lighting Да Нет

Picture Cache Rec Setting Да Нет

Cache Rec Time Да Нет

SDI/HDMI Rec Control Setting Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Button <1> Да Нет

<2> Да Нет

<3> Да Нет

<4> Да Нет

<5> Да Нет

<6> Да Нет

<7> Да Нет

<8> Да Нет

<9> Да Нет

<10> Да Нет

Focus Hold Button Да Нет

Assignable Dial Assignable Dial Да Нет

Assignable Dial Direction Да Нет

Multi Function Dial Default Function Да Нет

User File Load Utility SD/MS – –

Save Utility SD/MS – –

File ID Нет Нет

Load Customize Data Да Нет

Load White Data Да Нет

All File Load Utility SD/MS – –

Save Utility SD/MS – –

File ID Да Нет

Load Network Data Нет Нет

Planning Metadata Load Media(A) – –

Load Media(B) – –

Properties – –

Clear Memory – –

Clip Name Display Да Нет

Paint HDR Paint Setting HLG Look Да Да

HDR Black Offset Да Да

HDR Knee Да Да

HDR Knee Point Да Да

HDR Knee Slope Да Да

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Black Master Black Да Да

R Black Да Да

B Black Да Да

Gamma Setting Да Да

Step Gamma Да Да

Master Gamma Да Да

R Gamma Да Да

G Gamma Да Да

B Gamma Да Да

Gamma Category Да Да

Gamma Select Да Да

Black Gamma Setting Да Да

Range Да Да

Master Black Gamma Да Да

Knee Setting Да Да

Auto Knee Да Да

Point Да Да

Slope Да Да

Knee Saturation Да Да

Knee Saturation Level Да Да

White Clip Setting Нет Да

Level Да Да

Detail(4K/QFHD) Setting Да Да

Level Да Да

H/V Ratio Да Да

Crispening Да Да

Frequency Да Да

Knee Aperture Да Да

Knee Aperture Level Да Да

White Limit Да Да

Black Limit Да Да

V Detail Creation Да Да
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Detail(HD) Setting Да Да

Level Да Да

H/V Ratio Да Да

Crispening Да Да

Frequency Да Да

Knee Aperture Да Да

Knee Aperture Level Да Да

White Limit Да Да

Black Limit Да Да

V Detail Creation Да Да

Skin Detail Setting Да Да

Area Detection – –

Area Indication Нет Нет

Level Да Да

Saturation Да Да

Hue Да Да

Width Да Да

Aperture Setting Да Да

Level Да Да

Matrix Setting Да Да

Adaptive Matrix Да Да

Preset Matrix Да Да

Preset Select Да Да

User Matrix Да Да

User Matrix Level Да Да

User Matrix Phase Да Да

User Matrix R-G Да Да

User Matrix R-B Да Да

User Matrix G-R Да Да

User Matrix G-B Да Да

User Matrix B-R Да Да

User Matrix B-G Да Да

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Multi Matrix Setting Да Да

Area Indication Нет Нет

Color Detection – –

Reset – –

Axis Нет Нет

Hue Да Да

Saturation Да Да

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load Utility SD/MS – –

Save Utility SD/MS – –

File ID Нет Да

Scene White Data Да Нет

TC/Media Timecode Mode Да Нет

Run Да Нет

Setting Нет Нет

Reset – –

TC Format Да Нет

TC Display Display Select Да Нет

Users Bit Mode Да Нет

Setting Нет Нет

HDMI TC Out Setting Да Нет

Clip Name Format Auto Naming Да Нет

Title Prefix Да Нет

Number Set Нет Нет

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD/MS – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Output On/Off SDI1 Да Нет

SDI2 Да Нет

HDMI Да Нет

Output Format SDI1 Да Нет

SDI2 Да Нет

HDMI Да Нет

REF Нет Нет

Output Setting RAW to HD Conv. Да Нет

Output Display Setting Да Нет

SDI1 Да Нет

SDI2 Да Нет

HDMI Да Нет

Display On/Off Network Status Да Нет

File Transfer Status Да Нет

NCM/Streaming Status Да Нет

Rec/Play Status Да Нет

RAW Output Control Status Да Нет

Tally Да Нет

Battery Remain Да Нет

Focus Mode Да Нет

Focus Position Да Нет

Focus Area Indicator Да Нет

Focus Area Ind.(AF-S) Да Нет

Face/Eye Detection Frame Да Нет

Lens Info Да Нет

Imager Scan Mode Да Нет

Rec Format Да Нет

Frame Rate Да Нет

Zoom Position Да Нет

UWP RF Level Да Нет

GPS Да Нет

SteadyShot Да Нет

Gamma/LUT Да Нет

SDI/HDMI Rec Control Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Gamma Display Assist Да Нет

Proxy Status Да Нет

Base ISO/Sensitivity Да Нет

Media Status Да Нет

Video Signal Monitor Да Нет

Clip Name Да Нет

White Balance Да Нет

Scene File Да Нет

Focus Indicator Да Нет

Auto Exposure Mode Да Нет

Auto Exposure Level Да Нет

Timecode Да Нет

ND Filter Да Нет

Iris Да Нет

ISO/Gain/EI Да Нет

Shutter Да Нет

Level Gauge Да Нет

Audio Level Meter Да Нет

Video Level Warning Да Нет

Clip Number Да Нет

Notice Message Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Marker Setting Да Нет

Color Да Нет

Center Marker Да Нет

Safety Zone Да Нет

Safety Area Да Нет

Aspect Marker Да Нет

Aspect Mask Да Нет

Aspect Safety Zone Да Нет

Aspect Safety Area Да Нет

Aspect Select Да Нет

Guide Frame Да Нет

100% Marker Да Нет

User Box Да Нет

User Box Width Да Нет

User Box Height Да Нет

User Box H Position Да Нет

User Box V Position Да Нет

VF Setting Contrast Да Нет

Brightness Да Нет

Color Mode Да Нет

Gamma Display Assist Setting Да Нет

Peaking Setting Да Нет

Type Да Нет

Normal Peaking Frequency Да Нет

Normal Peaking Level Да Нет

Color Да Нет

Color Peaking Level Да Нет

Zebra Setting Да Нет

Zebra Select Да Нет

Zebra1 Level Да Нет

Zebra1 Aperture Level Да Нет

Zebra2 Level Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 MI SHOE Input Select Да Нет

CH2 EXT Input Select Да Нет

CH2 MI SHOE Input Select Да Нет

CH3 Input Select Да Нет

CH4 Input Select Да Нет

INPUT1 MIC Reference Да Нет

INPUT2 MIC Reference Да Нет

Line Input Reference Да Нет

Reference Level Да Нет

CH1 Wind Filter Да Нет

CH2 Wind Filter Да Нет

CH3 Wind Filter Да Нет

CH4 Wind Filter Да Нет

CH3 Level Control Да Нет

CH4 Level Control Да Нет

Audio Input Level Да Нет

Limiter Mode Да Нет

CH1&2 AGC Mode Да Нет

CH3&4 AGC Mode Да Нет

AGC Spec Да Нет

1kHz Tone on Color Bars Да Нет

CH1 Level Да Нет

CH2 Level Да Нет

CH3 Level Да Нет

CH4 Level Да Нет

Audio Output Monitor CH Да Нет

Headphone Out Да Нет

Alarm Level Да Нет

HDMI Output CH Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Shot Mark Delete Shot Mark1 – –

Delete Shot Mark2 – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Copy Clip Select Clip – –

All Clips – –

Copy Sub Clip All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Set Index Picture – –

Thumbnail View Essence Mark Thumbnail – –

Clip Thumbnail – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting Нет Нет

Type Да Нет

Test Saw Test Saw Да Нет

ND Dial CLEAR with Dial Да Нет

Tally Front Да Нет

Rear Да Нет

HOLD Switch Setting with Rec Button Да Нет

with Hand Grip Remote Да Нет

Touch Operation Setting Да Нет

Rec Review Setting Да Нет

Handle Zoom Setting Да Нет

High Да Нет

Low Да Нет

GPS GPS Да Нет

Menu Settings User Menu Only Да Нет

User Menu with Lock Нет Нет

Fan Control Setting Да Нет

Lens Zoom Ring Direction Да Нет

Shading Compensation Да Нет

Chroma Aberration Comp. Да Нет

Distortion Comp. Да Нет

Distance Display Да Нет

Zoom Position Display Да Нет

Iris Display Да Нет

Video Light Set Video Light Set Да Нет

APR APR – –

Camera Battery Alarm Low Battery Да Нет

Battery Empty Да Нет

Camera DC IN Alarm DC Low Voltage1 Да Нет

DC Low Voltage2 Да Нет



8. Приложение: Элементы, сохраненные в файлы143

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Ext. Unit Battery Alarm Near End:Info Battery Да Нет

End:Info Battery Да Нет

Near End:Sony Battery Да Нет

End:Sony Battery Да Нет

Near End:Other Battery Да Нет

End:Other Battery Да Нет

Detected Battery Нет Нет

Ext. Unit DC IN Alarm DC Low Voltage1 Да Нет

DC Low Voltage2 Да Нет

Network Access Authentication User Name Нет Нет

Password Нет Нет

Wireless LAN Setting Да Нет

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Да Нет

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Да Нет

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Нет Нет

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет

Manual Register

SSID Да Нет

Security Да Нет

Password Нет Нет

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет



8. Приложение: Элементы, сохраненные в файлы144

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Да Нет

Camera Remote Control Да Нет

Detail Settings

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет

Modem Setting Да Нет

Modem1 Device Name – –

Modem1 IP Address – –

Modem1 Subnet Mask – –

Modem2 Device Name – –

Modem2 IP Address – –

Modem2 Subnet Mask – –

Network Client Mode Setting Да Нет

NCM Settings Select Да Нет

NCM Settings1/NCM Settings2/NCM Settings3

Display Name Да Нет

CCM Address Да Нет

CCM Port Да Нет

User Name Нет Нет

Password Нет Нет

CCM Certificate – –

CCM Certificate Status – –

Camera Control Да Нет

Camera Setting Нет Нет

Reset – –

Streaming Quality Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network File Transfer Auto Upload (Proxy) Да Нет

Default Upload Server Да Нет

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings(NCM) – –

Server Settings1/Server Settings2/Server Settings3

Display Name Да Нет

Service Да Нет

Host Name Да Нет

Port Да Нет

User Name Нет Нет

Password Нет Нет

Passive Mode Да Нет

Destination Directory Да Нет

Using Secure Protocol Да Нет

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

Maintenance Language Select Да Нет

Clock Set Time Zone Да Нет

Date Mode Да Нет

12H/24H Да Нет

Date Нет Нет

Time Нет Нет

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Ext. Unit Version Number – –

Version Up – –

Lens Version Number – –

*1 Не загружается, если для параметра Scene File >Scene White Data в меню Paint задано значение Off.



8. Приложение: Элементы, сохраненные в файлы145

Пункты, настраиваемые программируемыми кнопками

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

Выбор программируемых кнопок All File Scene File

ND Filter Position Да Да

Auto Iris Да Да

ATW Да Да*1

Focus Setting Да Нет

Display Да Нет

VF Adjust Да Нет

*1 Не загружается, если для параметра Scene File >Scene White Data в меню Paint задано значение Off.

Пункты, настраиваемые программируемым диском

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

Выбор для программируемого 
диска

All File Scene File

IRIS Да Да

ND Filter Да Да

Audio Input Level Да Нет
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См. соответствующие пункты в разделах “Настройка записываемого звука” (стр. 45) и “Меню Audio” (стр. 107).

Audio Input (CH1&CH2)

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

CH1

[CH2 EXT Input Select]
INPUT1
INPUT2

<CH1 INPUT SELECT>
EXT
INT
MI SHOE

<CH2 INPUT SELECT>
EXT
INT
MI SHOE

[CH2 MI SHOE Input
Select]
Shoe CH2
Wireless

[CH1 MI SHOE Input Select]
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

* Задается значение Manual, когда звук подается от адаптера XLR.

Блок-схемы
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Audio Input (CH3&CH4)

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

<CH3 INPUT LEVEL>
0 ~ 10

CH4

<CH4 INPUT LEVEL>
0 ~ 10

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2
Wireless

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

[CH3 Level]
Audio Input Level
Side
Level + Side
Through

[CH4 Level]
Audio Input Level
Side
Level + Side
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
* Задается значение Manual, когда звук подается от адаптера XLR.
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Audio Output

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

<VOLUME>
0 ~ 50

L

R

[Alarm Level]
0 ~ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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С помощью видеокамеры можно обновлять 
программное обеспечение объективов с 
байонетом E.
Список объективов, для которых возможно 
обновление, и соответствующего 
программного обеспечения см. на веб-
сайте для объективов.

Проверка версии

1 Установите объектив с байонетом E на 
видеокамеру (стр. 24).

2 Выберите пункт Version в меню 
Maintenance для отображения номера 
версии объектива Lens Version Number 
(стр. 121).
Номер версии программного 
обеспечения объектива с байонетом E 
отображается сбоку.

Обновление программного 
обеспечения

Перевод видеокамеры в режим накопителя 
(стр. 126).
Обновите программное обеспечение в 
соответствии с процедурой, прилагаемой к 
программному обеспечению объектива.

Обновление программного обеспечения объектива с байонетом E
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Лицензия на портфель патентов 
для визуальных элементов 
MPEG-4

ДАННОЕ ИЗДЕЛИЕ ЛИЦЕНЗИРОВАНО 
В СООТВЕТСТВИИ С ЛИЦЕНЗИЕЙ НА 
ПОРТФЕЛЬ ПАТЕНТОВ НА ВИЗУАЛЬНЫЕ 
ЭЛЕМЕНТЫ MPEG-4 ДЛЯ ПЕРСОНАЛЬНОГО 
И НЕКОММЕРЧЕСКОГО ИСПОЛЬЗОВАНИЯ 
ПОТРЕБИТЕЛЕМ ДЛЯ
(i) КОДИРОВАНИЯ ВИДЕО В СООТВЕТСТВИИ 

СО СТАНДАРТОМ ВИЗУАЛЬНЫХ 
ЭЛЕМЕНТОВ MPEG-4 (“ВИДЕО MPEG-4”) 
И/ИЛИ

(ii) ДЕКОДИРОВАНИЯ ВИДЕО MPEG-4, 
КОТОРОЕ БЫЛО ЗАКОДИРОВАНО 
ПОТРЕБИТЕЛЕМ ДЛЯ СВОИХ ЛИЧНЫХ И 
НЕКОММЕРЧЕСКИХ НУЖД И/ИЛИ БЫЛО 
ПОЛУЧЕНО ОТ ВИДЕОПРОВАЙДЕРА, 
ИМЕЮЩЕГО ЛИЦЕНЗИЮ MPEG LA НА 
ПРЕДОСТАВЛЕНИЕ ВИДЕО AVC.

НИ ДЛЯ КАКИХ ДРУГИХ СПОСОБОВ 
ПРИМЕНЕНИЯ ЛИЦЕНЗИЯ НЕ 
ПРЕДОСТАВЛЯЕТСЯ И ЕЕ ДЕЙСТВИЕ НЕ 
ПОДРАЗУМЕВАЕТСЯ. ЗА ДОПОЛНИТЕЛЬНОЙ 
ИНФОРМАЦИЕЙ, В ТОМ ЧИСЛЕ 
СВЯЗАННОЙ С РЕКЛАМНЫМ, ВНУТРЕННИМ 
И КОММЕРЧЕСКИМ ПРИМЕНЕНИЕМ И 
ЛИЦЕНЗИРОВАНИЕМ, ОБРАЩАЙТЕСЬ В 
КОМПАНИЮ MPEG LA, LLC. СМ. HTTP://
WWW.MPEGLA.COM

Получение программного 
обеспечения в соответствии с 
лицензией GPL/LGPL

В этом изделии используется программное 
обеспечение, на которое распространяется 
действие лицензии GPL/LGPL. Настоящим 
уведомляем вас о том, что в соответствии 
с условиями лицензии GPL/LGPL у вас 
есть право на доступ, изменение и 
распространение исходного кода этих 
программ.
Исходный код опубликован в Интернете. 
Перейдите по следующему URL-адресу и 
выполните инструкции по загрузке.
https://oss.sony.net/Products/Linux/

Мы просим вас не обращаться к нам по 
поводу содержимого исходного кода.

Лицензии (на английском языке) записаны 
во внутреннюю память изделия.
Чтобы прочитать лицензии, хранящиеся 
в папке “PMHOME” - “LICENSE”, подключите 
изделие к компьютеру в режиме 
накопителя.

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ 
КОНЕЧНОГО ПОЛЬЗОВАТЕЛЯ

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 

works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 

Лицензии

HTTP://WWW.MPEGLA.COM
HTTP://WWW.MPEGLA.COM
https://oss.sony.net/Products/Linux/
www.sony.com/linux
www.sony.com/linux
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EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 

but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 

CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 

DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
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partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 

update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 

terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Лицензии на ПО с открытым 
исходным кодом

На основе лицензионных договоров, 
заключенных между корпорацией 
Sony и владельцами авторских прав на 
программное обеспечение, в этом продукте 
используется открытое программное 
обеспечение.
Для удовлетворения требований 
владельцев авторских прав на 
программное обеспечение корпорация 
Sony обязана довести до вашего сведения 
содержимое этих лицензий.
Лицензии (на английском языке) записаны 
во внутреннюю память изделия.
Чтобы прочитать лицензии, хранящиеся 
в папке “PMHOME” - “LICENSE”, подключите 
изделие к компьютеру в режиме 
накопителя.
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Общие

Вес  Прибл. 2,3 кг (корпус, включая 

ручку)

Габариты (Единицы измерения: мм, корпус, 

включая ручку)1)

159,5

246

142,5

146

257

216

229  
1) Значения размеров являются приблизительными.

Требования к источнику питания

  19,5 В пост. тока (от 18,0 В до 20,5 В)

Энергопотребление

  Приблизительно 35,2 Вт (корпус, 

объектив, запись в формате 

XAVC-I QFHD 59.94P, 

видоискатель включен, 

внешних устройств не 

подключено)

  Приблизительно 36,8 Вт 

(корпус, объектив, запись 

в формате XAVC-I QFHD 59.94P, 

видоискатель включен, 

3G-SDI×2, HDMI, подключено 

внешнее устройство)

Рабочая температура

  От 0 °C до 40 °C

Температура хранения

  От –20 °C до +60 °C

Время непрерывной работы

  Приблизительно 54 минуты (при 

использовании BP-U35)  

(корпус, объектив, запись 

в формате XAVC-I QFHD 59.94P, 

видоискатель включен, 

внешних устройств не 

подключено)

Формат записи (видео)

 XAVC Intra

  Режим XAVC-I 4K/QFHD: VBR, 

скорость потока данных 

600 Мбит/с (макс.), MPEG-4 

AVC/H.264

  Режим XAVC-I HD: CBG, скорость 

потока данных 223 Мбит/с 

(макс.), MPEG-4 AVC/H.264

 XAVC Long

  Режим XAVC-L QFHD: VBR, скорость 

потока данных 150 Мбит/с 

(макс.), MPEG-4 H.264/AVC

  Режим XAVC-L HD 50: VBR, скорость 

потока данных 50 Мбит/с 

(макс.), MPEG-4 H.264/AVC

  Режим XAVC-L HD 35: VBR, скорость 

потока данных 35 Мбит/с 

(макс.), MPEG-4 H.264/AVC

  Режим XAVC-L HD 25: VBR, скорость 

потока данных 25 Мбит/с 

(макс.), MPEG-4 H.264/AVC

 MPEG-2 Long GOP

  Режим MPEG HD422: CBR, скорость 

потока данных 50 Мбит/с 

(макс.), MPEG-2 422P@HL

Формат записи (аудио)

 LPCM 24 бит, 48 кГц, 4-канальная

Частота кадров при записи

 XAVC Intra

  Режим XAVC-I 4K: 4096×2160/59.94P, 

50P, 29.97P, 25P, 24P, 23.98P

  Режим XAVC-I QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

  Режим XAVC-I HD: 1920×1080/59.94P, 

50P, 59.94i, 50i, 29.97P, 23.98P, 

25P

 XAVC Long

  Режим XAVC-L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

  Режим XAVC-L HD 50: 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

  Режим XAVC-L HD 35: 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

  Режим XAVC-L HD 25: 

1920×1080/59.94i, 50i

 MPEG-2 Long GOP

  Режим MPEG HD422: 

1920×1080/59.94i, 50i, 29.97P, 

23.98P, 25P

Время записи/воспроизведения

XAVC Intra

 Режим XAVC-I 4K/QFHD:

  59.94P

   Приблизительно 22 минуты  

(при использовании QD-G128E/

QD-G120F)

 Режим XAVC-I HD:

  59.94P

   Приблизительно 57 минут  

(при использовании QD-G128E/

QD-G120F)

XAVC Long

 Режим XAVC-L QFHD:

  59.94P

   Приблизительно 86 минут  

(при использовании QD-G128E/

G120F)

 Режим XAVC-L HD 50:

  59.94P

   Приблизительно 110 минут  

(при использовании QD-G64E)

 Режим XAVC-L HD 35:

  59.94P

   Приблизительно 150 минут  

(при использовании QD-G64E)

 Режим XAVC-L HD 25:

  59.94i

   Приблизительно 200 минут  

(при использовании QD-G64E)

MPEG-2 Long GOP

 Режим MPEG HD422:

  59.94i

   Приблизительно 105 минут  

(при использовании QD-G64E)

[Примечание]
Время записи/воспроизведения зависит от условий 
использования и характеристик памяти. Значения 
времени записи и воспроизведения приведены 
с учетом непрерывной записи одного клипа. 
Фактическое время может быть короче (это зависит 
от количества записанных клипов).

Камера

Устройство формирования изображения (тип)

 Полнокадровый датчик изображения 

CMOS, эквивалентный 35 мм, 

с одной микросхемой

Количество пикселов

 20,5млн (всего)

Технические характеристики
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Auto Focus

 Способ обнаружения: фазовое 

обнаружение/обнаружение по 

контрастности

Встроенные фильтры ND

 CLEAR: OFF

 1: 1/4ND

 2: 1/16ND

 3: 1/64ND

 Линейная переменная нейтральная 

плотность: 1/4ND – 1/128ND

Чувствительность ISO

 ISO 800/4000 (режим Cine EI, источник 

света D55)

Крепление объектива

 Байонет E (с рычагом фиксации)

Широтная характеристика

 15+ остановок

Соотношение сигнал/шум для видео

 57 дБ (Y) (номин.)

Выдержка затвора

 От 64F до 1/8000 с (23.98P)

Угол раскрытия затвора

 От 5,6° до 360°, от 2 до 64 кадров

Съемка с замедлением/ускорением движения

 XAVC QFHD: от 1 до 60P, XAVC HD: от 1 до 

120P

Баланс белого

 От 2000 K до 15000 K

Gain

 От –3 дБ до +27 дБ (с шагом 1 дБ)

Кривая гамма

 S-Cinetone, STD1, STD2, STD3, STD4, STD5, 

STD6, HG1, HG2, HG3, HG4, HG7, 

HG8, S-Log3, HLG

Аудио

Частота дискретизации

 48 кГц

Квантование

 24 бита

Частотная характеристика

 Режим MIC входа XLR: от 20 Гц до 20 кГц  

(±3 дБ или менее)

 Режим LINE входа XLR: от 20 Гц до 20 кГц  

(±3 дБ или менее)

Динамический диапазон

 Режим MIC входа XLR: 80 дБ (обычно)

 Режим LINE входа XLR: 90 дБ (обычно)

Искажение

 Режим MIC входа XLR: 0,08% или ниже 

(входной уровень –40 дБн)

 Режим LINE входа XLR: 0,08% или ниже 

(входной уровень +14 дБн)

Встроенный динамик

 Монофонический

Внутренний микрофон

 Монофонический

Беспроводная ЛВС

Поддерживаемые стандарты

 IEEE 802.11a/b/g/n/ac

Диапазон частот

 Полоса 2,4 Ггц

 Диапазон 5,2/5,3/5,6/5,8 ГГц (только  

PXW-FX9V/VK)

Поддерживаемые протоколы безопасности

 WEP/WPA-PSK/WPA2-PSK

 Соответствует требованиям NFC Forum 

Type 3 Tag

Вход/выход

Входы
INPUT 1/2:

 Тип XLR, 3-контактный, гнездо

 Возможность переключения LINE / MIC / 

MIC+48V

 MIC: опорный от –30 дБн до –80 дБн

GENLOCK IN:

 Тип BNC

TC IN:

 Тип BNC

Выходы
SDI OUT1:

 Тип BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

SDI OUT2:

 Тип BNC, 3G-SDI (Level A/B), HD-SDI

Наушники (стерео миниразъем):

 –16 дБн (выход опорного уровня, 

максимальная громкость 

монитора, нагрузка 16 Ом)

HDMI:

 Тип A, 19-контактный

REF OUT:

 Тип BNC

TC OUT:

 Тип BNC

Другие
DC IN:

 Совместимый с EIAJ, от 18 В до 20,5 В пост. 

тока

Коннектор модуля расширения:

 Специальный (144-контактный)

Многоцелевой разъем:

 Специальный (21-контактный)

REMOTE:

 3-контактный, суб-мини, диаметром 2,5 мм

USB/многоцелевой:

 Совместимый со стандартом USB 2.0, тип 

micro B для хранения данных (1)

VF:

 Специальный (40-контактный)

Дисплей

Видоискатель (ЖК-дисплей)
Размер экрана

 8,8 см (3,5 дюйма) по диагонали

Формат изображения

 16:9

Количество пикселов

 1280 (Г) × 720 (В)

Гнездо для носителя

Гнезда для XQD-карт для записи видео (2)

Гнездо для карты памяти UTILITY SD/MS (1)

Поставляемые принадлежности

Адаптер переменного тока (1)

Шнур питания (1)

Зарядное устройство (1)

Аккумуляторный блок (1)

ЖК-монитор (включая штангу и зажим)

Окуляр (1)

USB-кабель (1)

Пульт управления на рукоятке (1)
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Крышка крепления объектива (1)

Защитная крышка разъема для рукоятки (1)

Комплект разъема для крепления 

принадлежностей (разъем для крепления 

принадлежностей (1), площадка разъема (1), 

винты (4))

Крючок для измерения расстояния (1)

Круглая втулка зажима (2)

Винты (5)

Перед использованием данного устройства (1)

Гарантийный талон (1)

Конструкция и технические 
характеристики могут быть изменены без 
предварительного уведомления.

Примечания
ˎˎ Всегда делайте пробную запись, а 
также удостоверьтесь в надлежащем 
качестве этой записи. КОМПАНИЯ SONY 
НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ 
БЫ ТО НИ БЫЛО УЩЕРБ, ВКЛЮЧАЯ, 
В ЧИСЛЕ ПРОЧЕГО, КОМПЕНСАЦИЮ 
ИЛИ ВОЗМЕЩЕНИЕ УБЫТКОВ В СВЯЗИ 
С ОТКАЗОМ ДАННОГО УСТРОЙСТВА 
ИЛИ НОСИТЕЛЯ ИНФОРМАЦИИ, 
ВНЕШНИХ ЗАПОМИНАЮЩИХ СИСТЕМ 
ИЛИ ЛЮБЫХ ДРУГИХ СИСТЕМ 
НОСИТЕЛЕЙ ИЛИ ХРАНЕНИЯ ДАННЫХ И 
НЕОСУЩЕСТВЛЕНИЕМ ЗАПИСИ ЛЮБОГО 
СОДЕРЖАНИЯ И ТИПА.

ˎˎ Перед эксплуатацией данного 
устройства обязательно проверьте 
правильность его работы. КОМПАНИЯ 
SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ 
ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, 
ВКЛЮЧАЯ, В ЧИСЛЕ ПРОЧЕГО, 
КОМПЕНСАЦИЮ ИЛИ ВОЗМЕЩЕНИЕ 
УБЫТКОВ В СВЯЗИ С УТРАТОЙ ИЛИ 
НЕДОПОЛУЧЕНИЕМ ПРИБЫЛЕЙ ИЗ-
ЗА НЕРАБОТОСПОСОБНОСТИ ЭТОГО 
УСТРОЙСТВА, КАК НА ПРОТЯЖЕНИИ 
ГАРАНТИЙНОГО ПЕРИОДА, ТАК И 
ПОСЛЕ ИСТЕЧЕНИЯ СРОКА ГАРАНТИИ, 
А ТАКЖЕ ВСЛЕДСТВИЕ ЛЮБЫХ ИНЫХ 
ВОЗМОЖНЫХ ПРИЧИН.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПРЕТЕНЗИИ 
ЛЮБОГО РОДА, ПРЕДЪЯВЛЕННЫЕ 
ПОЛЬЗОВАТЕЛЯМИ ЭТОГО УСТРОЙСТВА 
ИЛИ ТРЕТЬИМИ ЛИЦАМИ.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПОТЕРЮ, 
ИСПРАВЛЕНИЕ ИЛИ ВОСПРОИЗВЕДЕНИЕ 
ЛЮБЫХ ДАННЫХ, ЗАПИСАННЫХ В 
СИСТЕМЕ ВНУТРЕННЕЙ ПАМЯТИ, НА 
НОСИТЕЛЕ ИНФОРМАЦИИ, ВНЕШНИХ 
ЗАПОМИНАЮЩИХ СИСТЕМАХ ИЛИ НА 
ЛЮБЫХ ДРУГИХ СИСТЕМАХ НОСИТЕЛЕЙ 
ИЛИ ХРАНЕНИЯ ДАННЫХ.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПРЕКРАЩЕНИЕ 
ИЛИ ПРИОСТАНОВКУ ПРЕДОСТАВЛЕНИЯ 
ЛЮБЫХ УСЛУГ, СВЯЗАННЫХ С ЭТИМ 
УСТРОЙСТВОМ, ВНЕ ЗАВИСИМОСТИ ОТ 
ОБСТОЯТЕЛЬСТВ.

Загрузка программного 
обеспечения

Если устройство используется 
вместе с компьютером, загрузите 
драйверы устройства, подключаемые 
модули и прикладное программное 
обеспечение (если требуется) с веб-сайта 
профессиональных продуктов Sony.

Домашняя страница веб-сайта 
профессиональных продуктов Sony:

США http://pro.sony.com
Канада http://www.sonybiz.ca
Латинская Америка
 http://sonypro-latin.com
Европа http://www.pro.sony.eu/pro
Ближний Восток и Африка
 http://sony-psmea.com
Россия http://sony.ru/pro/
Бразилия http://sonypro.com.br
Австралия http://pro.sony.com.au
Новая Зеландия http://pro.sony.co.nz
Япония http://www.sonybsc.com
Азиатско-Тихоокеанский регион
 http://pro.sony-asia.com
Корея http://bp.sony.co.kr
Китай http://pro.sony.com.cn
Индия http://pro.sony.co.in

Sony Creative Software, страница загрузки 
программного обеспечения
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

Товарные знаки

ˎˎ XDCAM является товарным знаком Sony 
Corporation.
ˎˎ XAVC и  являются 
зарегистрированными товарными 
знаками Sony Corporation.
ˎˎ XQD и  являются товарными 
знаками Sony Corporation.
ˎˎ Термины HDMI и HDMI High-Definition 
Multimedia Interface и Логотип HDMI 
являются товарными знаками или 
зарегистрированными товарными 
знаками HDMI Licensing Administrator, Inc. 
в Соединенных Штатах и других странах.
ˎˎ Microsoft и Windows являются товарными 
знаками или зарегистрированными 
товарными знаками корпорации Microsoft 
Corporation в США и/или других странах.
ˎˎ Mac и Mac OS являются 
зарегистрированными товарными 
знаками корпорации Apple Inc. в США и/
или других странах.
ˎˎ “Memory Stick”, “Memory Stick Duo,” 
“Memory Stick PRO Duo,” “Catalyst 
Browse,” “Content Browser Mobile” 
и логотип “Content Browser Mobile” 
являются товарными знаками или 
зарегистрированными товарными 
знаками Sony Corporation.
ˎˎ iOS является товарным знаком или 
зарегистрированным товарным знаком 
корпорации Cisco Systems, Inc. и/или ее 
дочерних компаний в США и некоторых 
других странах.
ˎˎ Android и Google Play являются 
товарными знаками корпорации Google 
Inc.
ˎˎ Wi-Fi, логотип Wi-Fi и Wi-Fi PROTECTED 
SETUP являются товарными знаками 
или зарегистрированными товарными 
знаками альянса Wi-Fi Alliance.

http://pro.sony.com
http://www.sonybiz.ca
http://sonypro-latin.com
http://www.pro.sony.eu/pro%20
http://sony-psmea.com
http://sony.ru/pro/
http://sonypro.com.br
http://pro.sony.com.au
http://pro.sony.co.nz
http://www.sonybsc.com
http://pro.sony-asia.com
http://bp.sony.co.kr
http://pro.sony.com.cn
http://pro.sony.co.in
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment


8. Приложение: Технические характеристики156

ˎˎ N Mark является товарным знаком или 
зарегистрированным товарным знаком 
корпорации NFC Forum, Inc. в США и 
других странах.

Все прочие названия компаний и продуктов 
являются зарегистрированными товарными 
знаками или товарными знаками 
соответствующих владельцев. В настоящем 
документе элементы, являющиеся 
товарными знаками, не обозначаются 
символами ™ или ®.
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